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Chapter 1
|nstallation

Welcome to the wonderful world of SoundScope. We are extremely excited about
this product and hope you can share in our enthusiasm. SoundScope is more than
just 1 product, it is a core technology on which the following products are based:

SoundScope/16 Base Package #GWI-S0S16
SoundScope/LC Novice Level System #GWI-SogLC
SoundScope/8 Entry Level System #GWI-S0S8

SoundScope/16 Open  C Programmer's Dream #GWI-Sos-C

SoundScope software fully supports the MacSpeech Lab | and Il hardware for
record, play and analysis. GWI is committed to the SoundScope platform and will
continue to develop it throughout this decade and into the 21st Century.

To GET STARTED

To get started, we recommend that you first Install the software and take a tour with
Chapter 2, Tutorial. To learn about advanced features, please see Chapter 3,
Advanced Tutorial, and Chapter 4, Instrument Design.

If you are working with a demonstration version of the software and want more
information, please contact GW Instruments and order a copy of the SoundScope &
SuperScope Il Reference Manual, order #GWI-Demo-SS2-Ref. If you are interested
in adding your own C source code to SoundScope and want more information, please
order the SoundScope Open Programmer's Guide and ThinkC Interface Source
Code, order #GWI-Demo-SS2-C.
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COMPUTER REQUIREMENTS

SoundScope must be run on a machine with the following minimum requirements:

COMPUTER

SoundScope/16 and SoundScope/16 Open requires one Nubus slot and is therefore
compatible with Macintosh |1 series and Quadra series computers. Note that the
Macintosh Ilsi requires a NuBus adapter card, available from Apple Computer.

SoundScope LC installs into a Macintosh LC, LCII or LCIII Processor Direct Slot.

SoundScope/8 attaches to the Modem port and is therefore compatible with
Macintosh SE or later computers.

OPERATING SYSTEM
Apple System 7.x or System =6.0.7 is required.

MONITOR
Although it is not required, a color or grayscale monitor and graphics board capable
of displaying 256 shades produces the best spectrograms.

HARD DISK
SoundScope requires a hard disk with at least 6 MB free.

RANDOM ACCESS MEMORY (RAM)

At least AMB of RAM is required when running under System 6 Finder. At least
5MB is required when running under System 6 MultiFinder or System 7.0. More
RAM is needed if your System Folder contains many extensions ("INITS"), or if you
wish to record long utterances. In summary, 8MB of RAM is recommended. If you
incur a memory error upon application launch, try setting the Memory Allocation
field to 2.5MB or so (i.e. select the SoundScope application from the Finder and
choose Get Info under File).

If you are running the SoundScope/16 Open system (used by C programmers) under
Think C, 8MB of RAM isrequired, and 16MB is recommended.
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SYSTEM COMPONENTS
The SoundScope product family includes the following systems:

SOUNDSCOPE/16 BASIC PACKAGE #GWI-S0S16

¢ SoundScope/16 Software on floppy disk

¢ SoundScope User's Manual and SoundScope & SuperScope |1 Ref. Manual

¢ AudioMedia™ |l 16-bit digitizer board, cables, AudioMedia software, and
AudioMediamanuals. Technical support on AudioMedia productsis available
directly from Digidesign.

RANE Microphone Amplifier and cables

BOSE™ powered speakers and cables

Microphone, cable and stand

Eve™ security key

SO

SOUNDSCOPE/LC Novice Level System #GWI-S0YLC
SoundScope/16 Software on floppy disk

SoundScope User's Manual and SoundScope & SuperScope I Ref. Manual
AudioMedia™ Il 16-bit digitizer board for Macintosh LC, cables, AudioMedia
software, and AudioMedia manuals. Technical support on AudioMedia products
Is available directly from Digidesign.

RANE Microphone Amplifier and cables

BOSE™ powered speakers and cables

Microphone, cable and stand

Eve™ security key

SO

OUNDSCOPE/8 Entry Level System #GWI-S08
SoundScope/8 Software on floppy disk. SoundScope/8 software is identical to
SoundScope/16 software, except: it does not play/record to/from the 16bit
digitizer board, it loads 16bit sound files with a maximum resolution of 12bits, it
digitizes viathe Sound Control Panel with a maximum resolution of 8bits, and it
does not run Tasks.

¢ SoundScope User's Manual and SoundScope & SuperScope |1 Ref. Manual

MacRecorder™ 8-bit digitizing microphone, MacRecorder software, and

MacRecorder Manuals. Technical support on MacRecorder productsis available

directly from MacroMedia.

Sy oo

SOUNDSCOPE/16 OPEN C Programmer's Dream #GWI-S0S-C
¢ SoundScope/16, described above

¢ >40MB External Hard Disk

¢ SoundScope ThinkC Object Code & ThinkC Interface Source Code

¢ SoundScope Open Programmer's Documentation
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SOUNDSCOPE/8 FIVE-PACK Multiple Systems #GWI-S0S8-5x

¢ Five additional copies of SoundScope/8 for a multi-station installation. At least
one base system (e.g. Part #GWI-So0S8) must be purchased in order to qualify for
the Five-Pack purchase. Five-Packs cannot be broken (e.g. you cannot buy 3 for
60% of the Five-Pack price).

SOUNDSCOPE/16 FIVE-PACK Multiple Systems #GWI-S0S16-5x

¢ SoundScope/16, described above

¢ Four additional SoundScope/16 security keys for a multi-station installation. At
least one base system (e.g. Part #GWI-S0S16) must be purchased in order to
qualify for the Five-Pack purchase. Five-Packs cannot be broken (e.g. you
cannot buy 3 for 60% of the Five-Pack price).
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SOFTWARE INSTALLATION

SoundScope is shipped to you in a compressed "archive" form. The following
installation procedure will create a new folder with the enclosed software.

#1 Insert the GREEN Application Disk and double-click on its .sea file.

#2 Press Continue when the Introduction dialog
appears, as shown to the right. GW Instruments
#3  When the File Save dialog appears, SPECify a | el assscpi uccod oo
location for the new software (e.g. the top Copuright 139052, Aladdin Systems, n.and Raymond La
level of your hard disk). Pressthe Save
button to commence with the installation
procedure.

#4 \When it's done with the first installment, a | taliation was succoserult
dialog will appear, as illustrated to the right. '

Press Quit to continue.
#5 Drag the GREEN Application Disk into the trash (to gect it).

#6 Insert the GWI Application Disk #1 and double-click on it's "GWI Installer"
file.

#7  When the Introduction dialog appears, as
shown to the right, click a key to continue.

GW Instruments

35 Medford Street o Somerville, MA 02143
617/625-4096 (tele) # 617/625-1322 {fax)
Fz65 (Applelink) ® DEZ6S@Applelink Apple COM {Internet)

#8 When the File Save dialog appears and asks
you for the destination of the next
installment; locate the folder that was just
created, enter it, and then Press Save.

Click Any Key to Continue...

#9 A progress dialog will appear, as illustrated [, 7 T - T0 T
to the right. As the decompression I"HI"" T e
commences, it will ask you to insert GWI | wie’

Application Disk #2, Disk #3, etc. When it's: = puimm™——
done, it will say "Install Successful”.

Ly

Mg

bz gt g

#10 The computer will then ask youtoinsert s & &
GWI Application Disk #1. After doing this,
drag its icon into the trash.

au
100 110 msec
i 10 =
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#11 LARGE-SCREEN M ONITORS
If you are using a monitor that is 16" or greater (measured along the diagonal),
SoundScope may run out of memory when computing large spectrogram or
LPC history plots. You can prevent this problem by allocating additional
memory for SoundScope, as explained below.

 Locate the "SoundScope/xx" or "GWI Application” file in the " SoundScope
Application” folder (where xx is 8, 16, or Demo). Click the icon once to
select it, and then choose Get Info under the File menu.

* In the lower right corner, type in the number “4000” (or larger). This
number is the maximum amount of memory (in bytes) that the application
will be able to use while it is running.

 Click the close box in the upper left corner.

#12 SYSTEM EXTENSIONS AND CONTROL PANELS
Several system Extension and Control Panel files are included with SoundScope
as shown in the following table. These files can be found within the " System
Extensions" and "Control Panels’ folders, inside the "Goodies" folder at the
same level as the SoundScope application.

Extension M anufacturer Pur pose
SSProtect INIT GWI SoundScope/16 copy protection
Digidesign Sound Input  DigiDesign  16bit AudioMedia board driver
DigiSystem INIT DigiDesign 16bit AudioMedia board driver
MacRecorder® Driver  MacroMedia 8bit MacRecorder driver
XLink Extensions CEL HyperCard XCMD Interface
XLink Manager CEL HyperCard XCMD Interface
Control Panel M anufacturer Pur pose

XLink Setup CEL HyperCard XCMD Interface
Serial Switch Apple Fast Computer serial switch

These files add features to your computer's operating system, and are necessary
in some applications. For example, in order to run SoundScope/16 software,
the SSProtect INIT Extension must be installed. Each Extension consumes some
memory; therefore you should only install those that are needed. To install an
Extension, place its file into your System folder (and inside the "Extensions"
folder, if running under System 7). To install a Control Panel, place itsfile
into your System folder (and inside the "Control Panels’ folder, if running
under System 7). To activate an Extension or Control Panel, Restart the
computer.
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« If you have SoundScope/L C, SoundScope/16, or SoundScope/16 Open, install
the SSProtect INIT Extension.

* If you have a 16bit SoundScope/16 or SoundScope/L C digitizer board, install
the Digidesign Sound Input and DigiSystem INIT Extensions.

* |f you working with the demonstration version of SoundScope, please install
the following Extensions. XLink Extensions, XLink Manager. Also install
the XLink Setup Control Panel.

* |f you have a SoundScope/8 8hit digitizer, install the MacRecorder® Driver
Extension.

* |f you want to run HyperCard XCMDs (e.g. in the TriVowelgram
instrument), install the XLink Extensions and XLink Manager Extensions;
and then install the XLink Setup Control Panel.

 |f you want to run an 8bit digitizer, or a MacSpeech Lab | digitizer with a
Macintosh I1fx or Quadra computer, install the Serial Switch Control Panel,
double-click on it, and then choose Compatible.

#13 SECURITY KEY
In order to run SoundScope/L C, SoundScope/16 or }

SoundScope/16 Open, the Eve security hardware
key must be attached to your Macintosh. Locate
the key (a small gray box with a short cable) and
plug the key into any available Apple Desktop Bus (ADB) port. Most
Macintosh computers have 2 ADB ports on the back of the computer, and two
on the keyboard. ADB devices can be "daisy-chained", such as plugging the
mouse into the Eve security key, which isin turn plugged into the keyboard.
SoundScope/8 does not require this key.

#14 Restart your computer to activate the Extensions and Control Panels, if you
have not already done so.

#15 Double-click on the "GWI Application” file (in the recently installed folder).
Please insert the GREEN Application Disk when requested. After the
application appears with an empty front panel, it will ask you to exit (to reset
the desktop) and re-enter by double-clicking on the application file.

#16 Create a new folder outside the SuperScope Il application folder and label it
"SS2 Instruments & Data'. Please keep your personal instrument and data files
in this folder, separate from the SuperScope 11 files, to reduce the chance of
deleting an important file during a software update.

Y ou have now completed the installation procedure -- congratulations! If you
want atour of the software, please proceed to Chapter 2, Tutorial.
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SOUNDSCcOPE/16 AND SOUNDScoOPE/LC

HARDWARE INSTALLATION

This section describes how to install the SoundScope/16 and SoundScope/LC
hardware, as illustrated in the following figure. The recommended wiring is not
mandatory since the AudioMedia |l board can attach to any standard audio source or
input with "line-level" signals and RCA phono connectors (e.g. tape deck, CD
player, stereo amplifier, DAT tape recorder).

4 )

DAT
Recorder

AudioMediall

LI LI
Mic :

- " DIGITAL AUDIO TAPE - M acintosh
"—R__IANALOG INPUT

|—D “LRIANALOG OUTPUT - Computer

| |
) )
Red Red

ALl ‘J—l' i
= = g Black | T lelack
s o 2 — o Powered
=] ack
Amplifier | 0 Speakers
l;-' Power In \ ), \ ),

#1 Before beginning, select Shutdown from the Finder's Special menu, and then
turn off the power switches for your Macintosh and all peripherals. It may be
wise to unplug the power cord as well.

#2 Locate the 16-bit digitizer board, in the AudioMedia box.

If you are installing the board into a Macintosh I1si: make sure that you have a
Nubus Adapter Card (available from Apple Computer). Follow the instructions
in the “Installing an expansion card” section of the Getting Started With Y our
Macintosh I1si manual, then skip ahead to Step #10 Bose™ Powered speakers.
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#3

#5

#6

#I

#3

If you are installing a SoundScope/LC board into a Macintosh LC, follow the
board installation instructions in your Macintosh LC manual, and then skip
ahead to Step #10 Bose™ Powered speakers.

Remove the top cover. There are several NuBus connectors (often called
"dlots") on the circuit board, aligned with removable panels (or empty holes)
aong the back side. The slots are numbered according to the following scheme,
proceeding from left to right:

1 through 6 Macintosh I, 11X, 11fx
1 through 3 Macintosh l1cx
4 through 6 Macintosh llci

Choose an empty slot for your digitizer and remove the plastic or metal panel
(if any). For easy reference, write the slot number here: .

Touch the Macintosh power supply box (the shiny metal object in the corner) to
discharge any static electricity that your body might have accumulated.

Unwrap the digitizer board, carefully handling it by the edges only.

Orient the board so that the RCA phono jacks are facing the rear of the
computer and the NuBus connector on the board is aligned with the connector
on the computer.

Carefully press down on the top edge of the digitizer, slowly dliding it into the
NuBus slot. If it does not insert fairly easily, take it out and try again. Asyou
insert the board, make sure its rear 1/0O panel sits well into the bracket at the
rear of the computer, and snaps into the small receptacle at the base of this
bracket. The RCA phono jacks should protrude slightly through the slot’s I/O
window at the rear of the computer.

Replace the Macintosh cover. Do not power on the computer system yet.
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#10 BOSE™ POWERED SPEAKERS

Unpack both speakers. The back of each speaker identifies whether it is for
the left or right channel.

L ocate the 8-foot black speaker wire (this wire is composed of two insulated
wires glued together, with exposed wire leads at each end). Notice that one
of the insulated wires bears a red stripe.

Connect the two speakers together with the speaker wire. For both speakers,
the wire with the red stripe connects to the red receptacle, the other wire to
the black receptacle.

Any time you plug anything into or out of these audio jacks, make sure the
computer and your audio equipment are powered off. Connect the gray
Audio Input wire from the left speaker to the two stereo outputs at the base
of the digitizer 1/O panel, with the red (Right channel) plug on the bottom.
Finally, connect the power cord from the left speaker to a power outlet.

#11 MICROPHONE AND AMPLIFIER

Make sure the computer and your audio equipment are powered off.

Unpack the microphone and microphone cable.

Insert the microphone cable's three-prong XLR plug into the base of the
microphone, and insert the other end of the cable into the Amplifier's "Mic
Input”.

Insert the amplifier cable’'s three-prong XLR plug into the Amplifier's "Line
Out" jack, and insert the other end of the cable into the Left Audio Input
connector at the digitizer's 1/0O panel (3rd RCA connector from top).
Unpack the microphone stand and slide the microphone into the receptacle at
the top of the stand.

1-10
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SOUNDSCOPE/8 HARDWARE INSTALLATION

This section describes how to install the SoundScope/8 hardware, asillustrated in the
figure below. You may skip this section if you purchased SoundScope/8 without the
8-bit digitizer. SoundScope/8 software records from the internal microphone
included with many Macintosh computers, and from MacSpeech Lab | & 1
hardware.

4 )

M acRecorder Macintosh
MODEM or (E acinto
PRINTER port Computer

#1 Locate the 8-bit digitizer, in the MacRecorder box. It isasmall gray box,
dlightly larger than a mouse, with a six-foot cord affixed to one end.

#2 Plug the 8-bit digitizer's connector into the MODEM or PRINTER port on the
back of your computer. The arrow imprinted on the plug should be facing up
asitisinserted.

SOUNDSCOPE/8 LIMITATIONS
SoundScope/8 software is identical to SoundScope/16 software except for the
following:

» SoundScope/8 does not play/record to/from the 16bit digitizer board.

»  SoundScope/8 loads 16bit sound files with a maximum resolution of 12bits.

e SoundScope/8 digitizes via the Sound Control Panel with a maximum resolution
of 8hits.

»  SoundScope/8 does not run Tasks.
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OUR MIssiON FoOrR THE 90's

The world of computing is currently evolving at lightning speed with computers the
size of notebooks doing what mainframes did only 10 years ago. And we believe
this spectacular growth will continue at a 5%/month increase in price-to-
performance-ratio well into the 21st Century (it's exciting). This, coupled with the
fact that the manufacturing cost of software is negligible, has led us to believe that
companies who invest heavily in developing ultra advanced software will be the
winners at the turn of the century.

In 1989, we undertook the challenge of developing a highly advanced software
product family. Thisinvolved over 30 developers and three years of painstaking
effort before it produced it's first fruit. SoundScope is more than one computer
instrument -- it is an environment in which the end user can design their own
instruments. We believe that the next revolution in computing will involve the end
user taking on the role of the developer; designing, prototyping, learning, and
implementing new and unique methods in the field. Subsequently the SoundScope
product family allows the end user to "program” with an easy to use mouse/dialog
box user interface.

Our Company Mission is to change the way scientists, engineers and medical
researchers work in the laboratory by developing computer based instrumentation
which is faster, stronger, more accurate, more capable, more flexible, less expensive
and easier to use than the traditional benchtop counterparts. We hope this product
made a dent in this quest and wish to hear from you if you have ideas concerning
future releases.
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| DEAS FOR NEW FEATURES

If you have any suggestions for improvements, please phone or write us Attention:
New Products. We develop products for you, the user, and want your feedback.

APPLICATION NOTES

GW Instruments collects 2 page summaries of common instruments. If you would
like to write about your instrument, or would like to read about someone else's,
please call or phone GW Instruments, attention Application Note Program
Coordinator.

Bic BAD BuGs

To learn about dead bugs, known bugs and areas under development please open file
(choose Open under Journal) "!Development Status.c” in the "Programmer's Notes"
folder inside the "Goodies' folder. This file expects tabs every 4 characters (i.e.
choose Options under Journal and then set the Tabs to "4" characters). To report a
bug, please:

#1 If the bug causes an Error Alert Bug Report Bureau
appear (i.e. one with a Bug Repoft pereamer
bUtton)l pre$ the magl C bUtton tC IT you found a bug and would Tike to inform the manufacturer, please
Open the Bug Report d|a| og’ proceed with the following steps:
pl Ctured to the r| ght #1 Press OK to exit this dialog.

#2 Press 0K to COPY this message to the clipboard.

Alternativel Y, if the bug does NOot|[ |# exit this spprication and PASTE the cliphoard contents (which

cause an Error Alert to appear, || [i et v s 1o do i, you cat raciars gour sommutar, ounen

pl’eSS Optl On |y|’ at any t| me’ tO ?rgéiqafhp;i:ation, and press OPTION 'y’ to get to this point, and proceed
InVOke the Bug Report dl al Og :g EZl]eiztt;?: r;{{grbae;il\’:rint your repart in a small fixed character g,

#2 Read the displayed instructions.

#3 Press OK to exit the dialog.

#4 Press OK to copy the bug report information to the clipboard.

#5 Paste the clipboard text into a new word processor window.

#6 Describe the sequence of steps required to reproduce the bug (thisis crucial). If
we cannot see the problem at GW Instruments, we probably cannot fix it.

#7 Delete the Dear End User letter at the top of the file, to save trees.

#8 Print in asmall font and send to GW Instruments via fax, mail, or electronic
mail. If you phone us, please do so while in front of your computer, if possible.

#9 If your bug is real mean, please refer to Tip #413 in Appendix E of the
SoundScope & SuperScope || Reference Manual.
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IF YOU ARENEW TO THE M ACINTOSH

If you are new to the Macintosh, we recommend that you keep a good reference at
your side. An outstanding one is The Macintosh Bible, 3rd Edition, by Sharon
Zardetto (Goldstein & Blair, ISBN 0-940235-11-0). Another wonderful reference is
Everything You Wanted To Know About the Mac, by Larry Hanson (Hayden, ISBN
0-672-30142-3).

SOFTWARE UPDATES

To receive the latest version of the SoundScope software, please contact GW
Instruments. Updates are free during the first 122months, and are then a small fee to
cover shipping and handling costs. To be fair, the update fee is waived if triggered
by a software bug (i.e. it's our fault). Problems due to new computers and new
system software do not qualify as "bugs".

Part #GWI-S0S8-Upd
Part #GWI-S0S16-Upd
Part #GWI-S0S-C-Upd

CUSTOMER SERVICE

GW Instruments is committed to providing high-quality service to its customers.
For technical support, please contact GW Instruments by phone, fax, AppleLink,
Internet or in writing. If you phone us, please do so while in front of your
computer, if possible. Technical Support is open between 9 and 5 Eastern Standard
Time.

GW Instruments, Inc. Phone: 617/625-4096

35 Medford Street Fax: 617/625-1322

Somerville, MA 02143 AppleLink: D2268

United States Internet: DJ268@A ppleLink.Apple.COM

PLEASE RETURN THE

OwNER REGIsTRATION FORM

TO RECEIVE NEWS AND UPDATES.
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Chapter 2
Tutorial

This chapter describes the main features of SoundScope in tutorial fashion. From
here, you can take advantage of the familiar Macintosh interface to explore
additional SoundScope capabilities.

SoundScope was created to help you record, analyze, manipulate, and play speech
and other sounds. Both recorded sounds and the result of sound calculations are
stored in the computer as waves. Specific time values in a wave may be indicated
by markers that can be moved with the mouse. The waves and markers are shown
on the screen in rectangular areas called displays. The number, size, type and
layout of displays is completely controlled by the user. There are four types of
displays, listed below.

» Wave Plot shows the timewave (voltage as a function of time).

» Analysis shows a Spectrogram, LPC History, Horizontal Spectral Slice, Long-
term Average Spectrum, Fo (fundamental frequency), Jitter, Shimmer, HNR
(Harmonic-to-noise ratio), Envelope, Energy, Zero Crossing rate, Spline, or LPC
Residual.

» Snhapshot shows a close-up of the timewave at a specific point in time, showing
either a 10, 20, 50 or 100 msec window, or an "instantaneous' FFT (Fast Fourier
Transform), LPC (Linear Predictive Coding) or Cepstrum.

* XY Plot shows a wave plotted against another wave (e.g. F1 vs. F2), rather than
as afunction of time.

SoundScope also features integrated text editors called journals. You can type
notes directly into a journal, using it like a simple word processor. To record
numerical values, ssmply select the appropriate menu command and click the mouse
on specific points of interest in any wave. SoundScope can automatically pick out
peaks or other key parameters, and log them to the journal at the click of a button.

Waves, markers, displays, and journals can be combined like building blocks to
create software instruments. A few pre-defined instruments have been included
with SoundScope. Y ou can use these as is, customize them to suit your specific
needs, or build new instruments from scratch.

In fact, SoundScope is aimed at two different audiences, instrument users and
instrument designers. Instrument users can begin work right away, using software
instruments that were created by GWI or by colleagues. Instrument designers will
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invest more time learning how to customize SoundScope, to create new instruments
for their own use and for use by others.

This chapter guides you through a "hands-on" interaction with SoundScope. The
Tour is divided into two chapters, each of which can be reviewed separately. In the
following instructions, each step is preceded by a bullet symbol (¢). It isimportant
to not miss a step, since many depend on previous steps. SoundScope makes
extensive use of hierarchical menus (i.e. submenus) to provide direct access to
waves, displays, journals and other objects. This manual usesthe? character to
indicate a submenu. For example, "Select Load Data* A from the Wave menu” is
shorthand for "Pull down the Wave menu, drag down to the Load Data submenu,
drag across to 'A’, and then release the mouse button to select it."

PART 1:. GETTING STARTED

SoundScope was designed to handle two channels of sound, labelled A and B. With
the appropriate hardware, SoundScope can record and play these channels
simultaneously (in stereo). For many applications, one channel of datais sufficient.
In the first part of this tutorial, we will look at an instrument designed for a single
channel. To begin, make sure your computer is on and that you have installed the
SoundScope software, as described in Chapter 1, Installation.

* Inside the “ SoundScope Application”, folder on your hard disk, locate the
instrument file called "1 Channel Analyzer". Double-click on the file'sicon to
launch SoundScope with this instrument. (Or, click once on the icon and select
Open from the Finder's File menu.)

Note: You will get an error message if there is not enough memory (RAM) to
launch SoundScope. As shown in it's Get Info box (select from the Finder's File
menu), SoundScope prefers 3 MB (3000 K) or more, but will run with as little as
2000 allocated. To determine if your machine has enough memory, select About
this Macintosh (or About the Finder) from the Finder's Apple (0) menu. If you
are running MultiFinder or System 7, quit out of other applications to increase the
memory available. Please see Chapter 1, Installation for a detailed discussion of
memory iSsues.
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After afew seconds, SoundScope's menubar will appear at the top of the screen, and
the instrument will then be loaded. The screen will look something like this:

Marker "A1" Marker "A2"

1 Channel Anajyzer

o153 A1ND =0 Az 0.3 [ [[{000.000¢ [NaN1y
" N F4a -
o 0 ® 2] Snapshot
TZDD =l |- L 32 D|splay
I Y DA s Snap_D"
3500 B _
. i
AnaIyS|s 2000 zlo.n 14 28  KHr
. Mot
Display =~ e
"Calc D 2500 [C3) —
. Journal
2000 " "
Notes
1500 {Log
1000
500 |Set
WwavePlot { | e =
B I I
"Time_D" S O T S e & e S S N e o o

Marker "Al" Marker "A2" Wave "A" will appear here

This instrument uses SoundScope's " Short" menubar, which provides every
command required by the typical instrument user. Additional commands for
instrument designers are available in the "Full" menubar, available from Choose
Menubar in the Edit menu. Let's begin with something tangible, recording and
playing sounds. For this tutorial, we will take them in reverse order.

L OADING SOUND DATA FROM DISK

To get quick results, we will start with a pre-recorded sound that was
saved to disk.

» Load asound into channel A by selecting Load Dat @Ikl

» A from the Wave menu. save RAs... »
Load Data...

* Inthe standard open file dialog that appears, select
the "were away yr ago (22.2)" file in the "Waves' folder.

This soundwave will appear in the Wave Plot display nhamed Time D, which runs
along the bottom of the screen. To provide unique but related names for displays and
the wavesinside, display names have" D" at the end.
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Wave Plot
Display —
"Time_D"

0 200 400 500 800 1000 1200 1400 1600 1300 2000  msec
E_. EI)lU-lZDDmsec.-"Diu |ﬂ

HARDWARE SETUP

In order to use the play and record commands, SoundScope must know which sound
hardware is connected to the Macintosh. SoundScope does its best to determine this
information each time it is launched; however, we will double-check to make sure
that it is correct. If you are using the demo version of SoundScope, you can play
pre-recorded sound through the speaker in your Macintosh.

Select Setup from the Sound
menu. A dialog will appear
as shown to the right.

Hardware Setup

Wave Hardware Option Sample Rate
Rec A:[_A || 16-Bit Digitizer || Left+Mic || <44.1 kHz |

Rec B:| A || 16-Bit Digitizer ][ Right+Mic] [ 44.1 kHz ]

Under the title Hardware,
make sure the pop-up menus
(Rec A, Rec B, Play A, Play,
B) show the name of your [ RecA ] [ RecB | [secans] [ Test.. |
hardware: 16-Bit Digitizer, [ Playn ]| [ PlayB | [Fisyu# 3 [ Help.. | Cancel
Apple (Modem, Printer, or
Internal), MacSpeech Lab I, or MacSpeech Lab | (SoundScope/12). If you want
to play through the internal speaker, select the Internal Speaker Hardware (thisis
handy if you are working with the demonstration version of the software). If
you want to record from the microphone selected in the Sound Control Panel,
select Apple with the Internal Option. If you want to record from an 8bit
MacRecorder, select Apple with the Modem or Printer Option (depending on
which port the MacRecorder is connected to).

Play A:[ A || 16-Bit Digitizer |

Play B:[ A || 16-Bit Digitizer |

The 16-Bit Digitizer Hardware option pertains to an AudioMedia | board, an
AudioMedia |l board, or a MediaTime board. The MediaTime board (available
from RasterOps Corporation for ~$2000) includes a 24bit video circuit, a real
time frame grabber, two 16bit record channels, and two 16bit play channels -- it
Is truly amazing.

Please set the Sample Rate and Option Pop-up menus as desired. For more
information on these settings, see Chapter 6, Front Panel.

Since you have aready loaded sound data into channel A, test the hardware by
clicking on the Play A button in the lower left corner.
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* If you could clearly hear the words "We were away a year ago", then everything
isfine. If not, verify that the hardware is correctly installed, and that the
external volume control (if any) is set loud enough. If you hit "This sample rate
Is not supported by your Hardware", then you can either play a sound that you
record with your hardware, or choose a wave in the "Wave" folder that is more
compatible.

» Simply click the OK button to exit the dialog box.

PLAYING A SOUND
Although sounds can be played from the Hardware Setup dialog, menu commands
(and their command-key equivalents) are usually easier.

» Select Play A from the Sound menu. You should again hear "We were away a
year ago".

Y ou can also play just a portion of the sound.
* Click onceinside Time D (at the bottom of the screen) to make it active.

» Drag with the mouse over any portion of the wave. The selected portion will be
highlighted.

» Select Play Selected from the Sound menu.

RECORDING A SOUND

Having chosen the appropriate hardware, you can now record a sound
to replace the current contents of the timewave. If you are using the
demo version of SoundScope, you cannot record new sounds, and
subsequently should skip ahead to Saving Sound Data on the next Page.

» Select Record A from the Sound menu. Begin speaking into the microphone
immediately after the mouse button is released. (The cursor will change into the
standard wristwatch icon when SoundScope begins to record data.) SoundScope
will record for two seconds, and then update Time D with the new wave.

» Select Play A from the Sound menu. If the sound is too soft, try holding the
microphone closer to your mouth and recording again. (If you have
SoundScope/8, SoundScope/12, or the MacSpeech Lab | or Il hardware, adjust the
hardware volume control and record again.)

I nstruments 2-5



» Select Controls from the
Sound menu. Change the
length of recording to one
second by typing "1" into th¢
Duration text box.

» Exit the dialog and record &
new sound 1 second in
duration.

SAVING SOUND DATA
Before proceeding, save this
sound to a new file.

Record/Play Control

~Record

Duration: Dsecs

brpad dpped |0

[J Auto normalize

iié}izszm}:é """" % Hepetitiuns:lzl

 Sedlect Save Ast A from the
Wave menu.

» Type "first wave" into the standard file dialog, and click on the Save button. You
may have noticed that the files names of the supplied waves are suffixed with the
sample rate (e.g. "(22.1)" means 22.1Ksamples/sec). This helps distinguish wave
files from instrument files and is useful when working with different sample

rates.

SAVING THE HARDWARE SETUP

To preserve changes in the hardware setup, save the instrument to disk.

o Sdect Save Asfrom the File menu.

 Type"my 1 Ch Anayzer" into the standard file dialog, and click on the Save

button.

That concludes Part 1 of the tour. Stay tuned for areview of all displays that are on

the screen.
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PART 2: EXPLORING THE FRONT PANEL

This section of the tour describes each of the displays that you see on the screen. In
SoundScope, a screen is like an instrument front panel. Before starting, reload the
wave used in Part 1.

» Select Load Data* A from the Wave menu, and choose "were away yr ago
(22.2)" in the "Waves' folder.

The Wave Plot display, _ o
named Time D, shows a ' ....... ....... ...... M
plot of the wave amplitude; R o A R
(in volts) as a function of 0 __an 010001200 1400 1600 1
time (in milliseconds).
Soun_d datavariesin Scroll  Wave Plot  gcroll
amplitude from -10 voltstg®"  ‘Box  Dispay  par
+10 volts. Depending on arow "Time_D" Arrow

the size of your screen and

the software instrument that you select, the Wave Plot display may not show the

entire range.

ZD::II:I ;nsec
]3] 200 meecniv i

Right/ N\ Timescale /

Scroll Arrows

eft

SCROLLING AND CHANGING SCALE
If only a portion of the timewave is visible in the display, use the scroll bar to move
around:

» Click or press on the right and left arrows for precise movement, drag the scroll
box to move to a specific location, or click on either side of the scroll box to
move by about 75% of a screenful.

To change the amount of time that is displayed, change the horizontal scale
(milliseconds per division):

* Click the down timescale arrow several times to zoom in on the timewave.
Notice that the msec/Div number decreases each time the left time scale arrow is
clicked. Then click the up timescale arrow until you can see the entire
waveform.

» Asashortcut, click on the H button in the upper right hand corner of this display.
SoundScope will automatically set the horizontal scale so that the entire waveform
fits exactly in the display.
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MOVING MARKERS

Specific time values in awave may be indicated by marker s that can be moved with
the mouse. Two markers, A1 and A2, are currently visible in both Time D and
Calc_D aboveit. Each marker can be moved independently of the other, and will
stay put until it is moved again.

» Click onceinside Time D (at the bottom of the screen) to make it active.

* Move the mouse pointer to the left-most marker, A1. When the mouse pointer
lies directly on the marker, hold down the Option key (which changes the cursor

to “|"), press the mouse button and drag the marker about half an inch in either
direction. Release the Option key and the mouse button. If you have trouble
moving the marker, make sure you are placing the cursor exactly on top of the
marker in Time_D. Then press the mouse button and hold it down as you move
the mouse to the right or left.

THE MARKER LABEL AREA

The row of text and numbers at the top of Calc D is called the marker label area,
and shows information pertaining to marker positions. In this instrument, the
marker names and time positions within the wave (in seconds) are shown directly
above each marker. The time difference is also shown, on the far left side of the
marker label area.

* InTime D, move markers A1 and A2 in turn and notice how the numbers in the
marker label area reflect the positions of the markers.

Because the SoundScope front panel is completely customizable, an instrument
designer could show a marker label line directly above Time D instead of or in
addition to the one above Calc_D.
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Our Analysis Display, named Calc_D,~spectrogram

. LPC Hist
shows the result of a calculation S Slice

. Avg Spectrum
performed on an entire wave, a segment| 9>k

of awave (the portion of a wave between vitter

Shimmer

two markers), or the currently selected |

portion of awave (selected by the mouse; E::?Q.‘:."“

will be highlighted). SoundScope puts a| zero crossing

Analysis Options

Source Wave

" Calc Button
complete set of analysis routines at your| bite
fingertips, with convenient controls on /i
the right-hand side of the display, the vA " Log Button

analysis option pop-up menu, source o ed
wave pop-up menu, Calc button, Log

button, and Setup button. This display

takes the source wave (or segment of a

wave) as input, computes the specified analysis option, produces a result wave and
displays that wave. The Calc button recal culates the specified analysis. The Log
button performs actions such as logging data to a journal, or executing atask. The
Setup button lets you alter the parameters of each analysis option, and select the
events invoked by the Log button.

Setup Button

PRODUCING A SPECTROGRAM
As shown in the analysis pop-up in the upper right corner, Calc_D is currently set to
compute a spectrogram (" Spe").

° ClICk the Calc bUttOﬂ (the mldd|e EES .1201 Az:0. 2?3“ I-i = _
control on theright side). A I | e

spectrogram will be drawn from left
to right, as illustrated to the right. A

L e I
i =

The spectrogram shows time along the
horizontal axis and frequency along the ol
vertical axis. The relative magnitude of oL Hile H :
the frequency components at each timeis j 1", s Log
indicated by the darkness of the / .,

spectrogram. In this instrument, the time " ' it . Wi
axis of Calc_D islinked to the time ams"'J]j C. ool . *
in Time D below it. Scrolling or
changing the scale of Time D will aso change Calc_D.
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» To see aportion of the spectrogram in greater detail, click the time scale down
arrow afew times. Scroll the display to an interesting part of the sound, and
click the Calc button.

» Change the scale to 10 msec per division and click the Calc button again. Notice
that the spectrogram is very rough, computed in discrete "blocks" or frames.
This parameter can be adjusted, as described below.

CHANGING SPECTROGRAM SETUP

SoundScope gives you direct access to the key parameters behind each calculation. A
spectrogram is computed one frame at atime. The amount the frame is advanced
can be reduced to create a smoother plot.

» Click the Setup button on the right

Spectrogram Setup

side of the analysis display. A Analysis
dialog will appear as shown to the|[ = ferpoints:
right. Filter: [ 300 Hz (5ms) |

Darkness:[ Medium |Mau: 47 dB  Min: 20 dB

e Enter "0.5" in the Frame advance Display range: [N to [5.000 |kHz
textbox. Click the OK button in thy =~ Frame advance: [2.000 | ms (0.1...50)
lower right corner to confirm thig| =V @8 pre-emphasis
g (] After calculating, run task: |I|

Setting.

~Liog

. [J] Run task: |II
» Click the Calc button to plot a new
Spectrograrn_ NOtl ce that the [ Help... ] [ Color... ] [l]ptiuns...] [ Cancel ]

display is much smoother.

The Spectrogram Setup dialog contains many pop-up menus, radio buttons and edit
fields. One especially important control that you may have noticed is the Display
range pop-up, which specifies the lower and upper frequency bounds of the
spectrogram display.
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CHANGING THE ANALYSIS OPTION
Calc_D contains many analysis options, of which the spectrogram is merely one
example.

» Select Fo Plot from the analysis pop-up menu and then Click the «fggcﬁir;%rrzm

Calc button. After several moments, you will see a plot of the HS Slice
fundamental frequency (in Hz). Remember that the analysis display fvd spectrum
IS setup to analyze the portion of soundwave A that isvisible in the uitter

time display. Shimmer
Envelope

» Reset the horizontal scale by clicking the H button in the time vero trossing
display, then change the analysis option back to Spectrogram. Cligkstine
Calc to see the spectrogram again. LPC Residual

As you may have noticed while changing back and forth between Spectrogram and
Fo Plot, many other options are available in the analysis pop-up. Each is described
in detail in Chapter 6, Front Panel.

A Snapshot display | 10ms
shows information 20ms
. . S0ms
pertalr;;n(g tof asm;:tllf 100ms 298203 — ﬂ Analysis Options
interval (or frame) Of |- e Rl
i Wideband FFT N = |~
time, centered about a Narrowband FFT |- & - -« -« - . - .. Les 5 | & )| Source Wave
marker. For example,| pc : -
Snap D currently shows cepstrum Al

T S - Source Marker

awideband FFT, whic
showsthe relative |77 ,
strength (in dB) of the | selected
frequency components P
present in the timewave” oy

near marker A1. A Snap M1
snapshot display

contains controls similar to an analysis display, with the addition of a marker pop-up
menu. Because the computations involve only a small portion of the soundwave,

they are performed immediately and no Calc button is required. The snapshot
display takes the source wave as input, computes the specified snapshot option for the
frame centered about the source marker, produces a result wave and displays that
wave. Each time one of these items changes, the display automatically recalculates
and displays the new result. The Log button performs actions such as logging data
to ajournal, or executing atask. The Setup button lets you alter the parameters of

each analysis option, and select the events invoked by the Log button.

Log Button

Setup Button
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CHANGING THE SNAPSHOT OPTION
Wideband FFT is one of several options available. For information on all options,
please see Chapter 6.

* In Snap D, select Narrowband FFT from the options pop-up menu. The plot will
resemble the wideband FFT, but with rougher, more jagged features.

* Click onceinside Time D to make it active.

* Move marker Al afew timesin the time display to get a feel for the narrowband
FFT plot. Then go to the options pop-up menu again and select Wideband FFT to
return to initial option.

SNAPSHOT MARKER LABEL AREA

The snapshot display has its own marker and label areato identify specific values
within the snapshot result wave. In contrast, markers A1 and A2 point to values
within the original soundwave.

» Click onceinside Snap_D to make it active.

* Move the marker a few times, by holding down the Option key and dragging the
mouse (press and hold the mouse button, move mouse, release button). There are
two numbers displayed at the top of the marker. The first indicates the frequency
in Hz (X axis value), the second (in parentheses) shows the magnitude in dB (Y
axisvalue) at that frequency.
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JOURNALS

SoundScope journals are simple text editors for storing key values and typing notes.

* Click onceinside Time D to make it active.

» Holding down the Option key, move marker A1 to 0.120 seconds.

* In Snap D, click on the Setup button (the bottom of five
controls). In the dialog that appears, make sure that the
Send up to 5 peaks to journal option is checked. Click
OK to exit the dialog.

* Now click the Log button, which will send information t
the journal, as shown in the figure to the right.

Hotes

FFT of A

Time: 0.1200 sec

Feaks:
Freq
[Hz 1]
519
551
521
2912
Fg??

Band
[Hz 1]
247
204
204
43

130

Amp | i tude
[dE]

41

29

25

15

15

Because journals are text editors, it is easy to reformat the

Hotes

data, as shown in the illustration to the right. After selectin
ajourna with the mouse, the user can easily delete, add and
rearrange text using standard Macintosh editing techniques.
Y ou can also save journal datafor use in a spreadsheet or
word processor.

* Sdect Save As* Notes from the Journal menu.

Fegks from a Wideband FFT ({}
f "SoundScope 16"

t 0. 120

Freq
[Hz1

0 sec

Band
[Hz1

Amp | i tude
[dE]

513

1651
2321
2912
2977

347
304
304
43

130

41
29
33
13
13

That concludes Part 2 of the tour. The next section will cover waves, and introduce

two different software instruments.
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PART 3: WORKING WITH WAVES

Both soundwaves and the result of sound calculations are stored in objects known as
waves. This section will demonstrate how to edit waves, compute statistics, and
filter data. Before starting, we will open a different instrument and then load a new
wave.

This instrument is similar to thgE— crame! w1 time) === i T

1 Channel Analyzer, but adds & - e

second timedisplay at thetop | ™= fwwnt o e

that automatically rescales to the j T ] }

size of the soundwave. The firgt X =

time display (at the bottom of e

the screen) can be used to view s o]

any part of the time wave at any oo [

scale. -

N S

e To hear the soundwave, — N NS
select Play A fromthe Sounfl—————ahsbRINE 1 |, |
menu. If you have I ¥ ELER
SoundScope/16, you may L Ohote 55t

Select Open from the File menu, open the "Instruments’ folder (double-click or
with the Open button), and choose "1 Channel (dual time)".

Select Load Data* A from the Wave menu, switch folders up to " SoundScope”
and then down to "Waves', and select "phonetic I-A-U (10.4)".

need to first select Setup (due to incompatible sample rates) from the Sound
menu, and change Play A and Play B hardware to Internal Speaker, as described
in the Hardware Setup discussion earlier.

SELECTING A PORTION OF A WAVE
It is often useful to work with a small portion of a soundwave. The standard
Macintosh technique is to use the mouse.

Click once inside Time2_D (at the top of the screen) to make it active.

Drag Wlth the - i R o
mouse over thef— - -
f”rst Vowel T N : s d AT R N : A
selected portion will be hlghllghted

To hear the vowel, select Play Selected from the Sound menu.
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WAVEFORM EDITING
The standard Macintosh Cut, Copy & Paste commands make editing a breeze.

e Salect Cut from
the Edit menu. }——1—
Noticethat the L— 1 L - : .
top display changes scale to accommodate the shorter wave.

» Click the mouse between the two remaining vowels, as shown above. Select
Paste from the Edit menu. Again, the display will rescale.

Next we will bring the vowels closer together by removing the silence at the
beginning and in between.

» Select theflat
portion of the [N : L b :
utterancebefo
the first vowel.

o Select Cut or Clear from the Edit menu. Note that Clear will prompt you with a
dialog, to prevent you from accidently erasing valuable data.

o Sdlecttheflat |
portion betweer|
the second &
third vowels.

° %Iect Cut OI’ 1. g ....... .... .... ....... [ .... .... ....... T .... ....
Clear from the P
Edit menu.

* To hear the result, select Play from the Sound menu. If you like, you can save
this new sound.
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AMPLIFY AND NORMALIZE
SoundScope lets you easily change the volume (loudness) of an entire wave, or of
any portion.

o Select Amplify » A from the Wave menu. Type "50%" to reduce the volume to
half its current level. Click OK. Note that the wave amplitude dropsin half in
Time_D (on the bottom). The amplitude does not appear to change in Time2_D
(on the top) because the display is set to automatically rescale in the vertical as
well as horizontal direction.

* Now select an interesting portion of the wave with the mouse, perhaps the third
vowel. Choose Normalize » Selected from the Wave menu. Click OK. Note that
the wave amplitude for the selected portion increases to fill the available + 10
volt range.

» To hear the result, select Play A from the Sound menu.
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WAVEFORM SEGMENTS
SoundScope offers a second technique for defining a portion of the wave: any two
markers can define a segment.

* Click onceinside Time D (on the bottom) to make it active.

R H
Lol t

 Changethescaletoabout 5G: . & & ¢ 0 e
msec per division (depending-—
onyour screen size), and |
scroll until you can seethe g
second vowel. Note that the
markers are not visible in this display. Fortunately, the top display always shows
both markers, since it shows the entire soundwave.

QEIIEI I mser_:

ED’IG'SD msec/Div |ﬁ

* Clickonceinside Time2 D =
(on the top) to make it active.

1 Channel {dual time)

0.421 A1:0

* Holding down the Option ke

aswell. _ _ _ o

« Toincrease the volume of tHe
segment between the two
markers, choose Normalize » A_S1 from the Wave menu. Click OK.

N
(which will change the - =
cursor), move one of the 1
markers to the left of the e o
middle vowel, and one to the oo (7
right. Note that the markers o [
appear in the bottom display w [0S

014 28 KMz

Segments are particularly useful for tasks, as you will see in the next chapter. In
many cases, however, the choice between a segment and the Selected portion is
simply a matter of preference.
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EDITING WAVEFORM VALUES

On the computer, a sound is represented as a series of numbers or data points, often
called samples. Each sample represents the digitized voltage (typically in the range
of 10 V) at a particular point in time. It is sometimes useful to examine and edit
the actual data values. For example, it appears that the sound volume is zero at the
beginning of segment A_S1, i.e. immediately following the left marker.

e Choose Edit Values* A_S1 _
from the Wave menu. The Edit Values:[_A_ST__ |
time valueis shown in the n?fzcn 0,219 0,684 1,238 1,770
left column. Note that the o.1z0)2A0a 2628 3,047. 3,539
0.120( 4,185  4.366.  4.419. 4,362
segment startsat_about 0.5 0,121 4,207  4.093  3.918 3,600
seconds (depending on 012l 2. 060 2 630 3 536 | AY0
exactly hOW mUCh WaSCUt 0.121 1.400 1.218 0.865 0,438
. 0.121 =0.200 -0.406 -0.634 -0.840
out earlier). The samples of 0122 ~0.887. . 0,945 1,025 1,044
0.122 -0.716 -0.541 =0.374 -0.085
t.hewaveare read |eft t.o D.122] 0406 0.501;  0.605 0,859
right, top to bottom, with || =
five samples on each row. |®nueu grmat u@mts T@gping
i Time Dec lrolt Overwrite :
NOtI%Ie that the Val ues are naf 1 Point (O Hak 3 Internal ) Insert i
exactly zero. :

The value of any sample may be changed by typing a new number into its cell.
Ranges of cells can also be cut, copied and pasted within the table editor, and to and
from SoundScope journals and displays, or third-party spreadsheets, word
processors or other Macintosh software.
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STATISTICS & SOUND STATISTICS

Two sets of statistics are available in SoundScope: sound statistics that are useful to
speech scientists and speech pathol ogists, and general waveform statistics which are
primarily intended for engineering applications.

» Click onceinside Time D (on the bottom) to make it active.

 Select asmall portion (abouf e
50 msec) of soundwave A, paa— v

from the middle of the S N N R S T S I

FO0D 450 S00 550 600 GBS0 P00 PS0 300 850 900 msec

VOWGI . E:)IB' 50 mzec/Oiuv |ﬁ

* Choose Sound Statistics !

Selected from the Wave sound Statistics:

" " Voiced: 100.000 % Jitter (RAP): 0.074 % (-62.61 dB)
m_enu' The NAN Val_ue for Unvoiced: 0.000 % Fo Average: 123.274 Hz
shimmer indicates that it Silent: 0.000 % Fo Kurtosis: -0.714
could not be Computed_ AS || shimmer (APD): NAN(DZ1) % Fo Skewness: -1.124

. . HNR: NAN(D21) dB Fo Range: 0.407 ST (2.884 Hz)
nOtaj In Appendlx A’ Breathiness: -8.110 dB Fo §td Dew: 1.249 Hz

shimmer requires a longer
time interval for a good
calculation.

[options... | ok |

e From the Sound Statistics

pop-up menu at the tOp of the sound Statistics:

H Uoiced: 85.714 % Jitter (RAP): 0.432 % (-47.29 dB)
dlalog’ Choose A—Sl After Unvoiced: 0.000 % Fo Average: 111.489 Hz
Se\/eral SecondS, yOU W||| Seql  silent: 14.286 % Fo Kurtosis: -1.300
the result for the entire shimmer (APQ): 2.506 % (-32.02 dB) Fo Skewness: -0.113

HNR: NAN(D21) dB Fo Range: 8.489 ST (51.107 Hz)
Segment Breathiness: -7.496 dB Fo §id Dew: 14.583 Hz

[options... | ok |

Note that, given the larger

amount of time as input, shimmer was successfully computed. For more
information on these statistics, see Chapter 7, Short Menubar and Appendix A,
Sound Analysis Computations. Y ou can also compute individual statistics and save
the result to ajournal or a wave, via task instructions.
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FILTERING
Filters attenuate certain frequency components in a sound. This section will explore
filtering, and introduce a new software instrument.

» Select Open from the File menu, switch up to the SoundScope folder, and into the
Instruments folder, and choose "2 Channel Analyzer".

This instrument is designed to compare two soundwaves. We will synthesize atone,
add noise, analyze the result, and then filter out the noise.

Choose Synthesize* A from the Wave menu. Enter 5000 into the Length
textbox. The default tone (periodic, sine) isfine, so click OK.

» Choose Synthesize* B from the Wave menu. Enter 5000 into the Length textbox.
Select Uniform noise, type 1 into the adjacent volts box, and click OK.

* Inorder to get agood look at the data, change the scales for both time displays to
2 msec/Div.

* Choose Play A and then Play B to hear the data.

» To create anoisy tone, we will add thef Catcutate Wave
two sounds (B=A+B). Choose
Calculate from the Wave menu. Presg ©L8 _ 1-[8 |
on a few pop-ups to familiarize oLE |- [ |+ [o-000
yourself with this dialog. When you'le e[ & 1 -[a s |
done exploring, select B = A + B from = | = ans |
the appropriate pop-ups, as illustrated Source: [ A |
to the right.
[J use Variables
[ Help ] (viewData)[ Doit ][ cancel J|[ o0k |

* Click on Do It, and then OKL#e, = 0 s, I
The noise isvery visible - | Nl e
and audible (slect Play B). Er Y e T
With SoundScope, the noise
can also be analyzed.

el t

» For an overall picture, click the Calc buttons on both analysis displays. Where
the original tone isin a single frequency band, the noisy tone has components all
over.
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» For an instantaneous picture at a
certain point in time, use markersif

. . - MoLUe:

and the snapshot displays. First, [ Display:

move one marker into position by RMarker: [ AT ]
selecting Move? Time D from the i

Move Display

g

~Position:

Display menu, unchecking the
Display checkbox, checking © sece oM .
Marker, selecting To the X secs ®To the secs position

position and typing .010 (10 msec). | @ Te marker:
Confirm that the settings match

those in the figure below, then
click OK.

» The procedure for marker B1 is easier, since the dialog uses your last choices as
the defaults: select Move?» Time2 D from the Display menu, choose B1 from the
Marker pop-up, and click OK.

7o, 000¢36. 3750

¢ Make sure that both snapshot 1057 . 500¢20. 0003
displays show Wideband FFT. Iff |- =~ = = =~ SCH— [ I s

not, use the top control to changen _ |- [
from another option. In Snap D ( .......
move the marker to the peak of | ifly 1 = W™ Rk §{1 = - - 16
the data, yielding the frequency gf 1| "~ = oo 11/ R TR
thetone. In Snapz_D’ movethe k.o i.4 2.8 KHz D01.4 2.8 KHz
marker to the second peak, to get an idea of what frequencies we should try to
filter out.

OEEE

L]
S
i+

» Click onceinside Time2 D (on the bottom) to make it active.

» Using the mouse, select a
small portion of the noisy
tone that includes the
marker, say from 5 to 15
MSeC.

....... AT T SIS RS I B

Al t

2IEI 2I2 mselc
E:}"IJ}|2 msec/Oiw |ﬁ
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e Choose Filter » Selected fror

the Wave menu, and change Filter:
the Frequency Cutoff for the _
filter to 10% - yieIding a Type: | smoother (ham) | [Eustum...]

number close to the target Freq Cutoff: (% of sample rate)
determined above. Click Boundaries:
OK.

Freq Cutoff: 100.0 Hz Phase: linear
Stopband: -42 dB Taps: 20

Clearly, the filter worked!
Visually, the noiseis gone. Th¢

snepshot display confirmsit, a
will a spectrogram. Because we

only filtered a small portion, you will not be able to hear the difference. If you like,
filter the entire soundwave B, and play the result.

EXPLORING SOUNDSCOPE

Using the techniques that you have learned, please explore SoundScope on your own.
Try loading other instruments and waves. Test out any menu item or front panel
control. If you get stuck and need some help, please feel free to give us a call.

QUITTING SOUNDSCOPE
The next section covers advanced features of SoundScope. If you do not want to
tackle that quite yet, you can quit and explore more at another time.

* |f you do not wish to continue, select Quit from the File menu.
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PART 4: DESIGNING INSTRUMENTS

Waves, markers, displays, journals, and tasks can be combined like building blocks
to create software instruments. A few pre-defined instruments have been included
with SoundScope. This section describes how to customize SoundScope by
modifying an existing software instrument, or creating a new one from scratch.
This information is not required for everyday user of SoundScope. Y ou may want
to gain experience as an instrument user before learning the advanced features aimed
at the instrument designer.

The following pages demonstrate how to change the front panel layout and add a
new display. Before starting, reload the instrument used in Part 1.

» Select Open from the File menu, and choose "1 Channel Analyzer".

THE FRONT PANEL

The main SoundScope window is referred to as the front panel. It includes all
displays and front panel journals. Y ou can change the size and position of each front
panel object with Panel Edit Mode. For example, you may want a wider journal to
enter more substantial comments. The following steps show you how to modify the
standard "1 Channel Analyzer" instrument to achieve this end.

I

[ owi E=== ' cn, wido journal
HHHHH

3|3 4

AN
N

1

|.A

Before After

In Panel Edit Mode, all displays, journals, controls, indicators and pictures can be
moved, resized, and deleted. When Panel Edit is turned on, a rectangular outline of
each front panel object appears, with the object name in the upper left corner. If an
object is selected, its name appears bold. To resize, one simply drags the resize box
(i.e. little black square at lower right). To reposition, one drags the actual object.
To reposition an object one pixel at atime, one selects with the mouse, and then taps
on the < 4 T— keys. To resize one pixel at atime, one selects with the mouse,
holds down the Option key, and then taps on the < | T— keys. Thisis very similar
to working with rectangles in MacDraw.

SoundScope prohibits shrinking displays below a practical minimum size to ensure
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readable content. Individual items within a objects cannot be resized independent of
the object. Should displays or journals overlap, awarning isissued (i.e. "Invalid
Panel" in status bar) and the user is prohibited from leaving design mode until the
overlapping is eliminated.

A PICT file (72 dpi picture file) can be placed
onto the front panel by first transferring it to
the clipboard (with Cut or Copy) and then

moving it to the display with the Paste

command, as illustrated to the right. Also,

Gwl

L

Beoprisibion, & nalpsts,
Contrd & Data Export

PICTs can be Cut or Copied from the SoundScope front panel to the clipboard.
Since front panel displays, journals, and so forth are not PICTSs, they cannot be
moved to or from the clipboard.

Select Panel Edit On from the Display menu.

Resizethe Calc_ D
analysisdisplay an
move it down, to
make room for
rearranging other
items.

the left corner.
Then resize the
Notes journal, in
preparation for
moving it.

—

d

nnnnn

NNNNN

E——— | Chonne! Anaiyzer B ] swi
Snap D ]

NNNNN

nnnnn

Before

nnnnnnnnnnnnnnnn

I

N

After

I

E=—— | Channe! Analyzer
Snap 0 ]

nnnnn

Before

After
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I

° M OVe the N Ot% [ chemet Ans:f:::%l [ _ow % nnnnnnnnnnnnnnnn

journal soitis

adjacent to Snap D.
Then movethe | —
Calc D analysis '
display up until it
touches Snap D.

zzzzzz

nnnnnn

Before After

==——= 1 Channel Analyzer
N Hot e
Snap 0

Py
B
(9]
0
o
(@]
W
U
I

NNNNN
nnnnn

make it taller and
occupy the full
screen width. Thert”
carefully resize the
Time_D wave plot
display so that the [
dotted vertical lines i g
meet. (Tip: hold Before After

down the Option

key and use the right and left arrow keys to resize one pixel at atime.)

H

Finally, resize the Notes journal to fill the entire = -
corner.

Select Panel Edit Off from the Display menu. You™
can now use the new layout.

To save this instrument for future use, select Save *
As from the File menu, type "1 Ch, wide journa”
into the standard file dialog, and click the Save button.

Y ou have now added a new instrument to your portfolio.

ADDING A DISPLAY

In addition to simply rearranging a front panel layout, you may want to create new
displays or journals. The following steps show you how to add a second snapshot
display to the above instrument.

» Select Choose Menubar » Full from the Edit menu. New items will appear in
most of the menus (although you will not notice until you pull them down).
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Snapshot (and analysis) displays _
require waves to hold the result of wave:_Snop2 |

their calculations. To create one, Name: [snapZ] (Format... ) [ Fdit... )
SeleCt NQN from the Wa\/e menu. Units: [ Points... ] [Sgnthesize]
Place wave into display: : |

Type in the name "Snap2" and click|| ' o wave changes, run: [ < |

OK.

(Comments] [ Help.. ][ Revert ]

o

|
m

Select Panel Edit On from the Display menu. SR

nnnnn

Resize the Notes journal to make room for a new
display.

Select New from

the Display menu. Display:[_Snap2 D |

Type in the name Name: [snap20f | Waves o Display
"Snap2_D",and | "*¢ i Snaz .
salect Snapshot 1 —
from the pop-up Features=)  |sn =
immediately below setected || |

In the scrollable list I R
towards the right’ L I [ —
click in the gray

area (or down (o) (eonee ) ()
arrow) of the scrol

bar to scroll down. Drag the Snap2 wave into the top slot on the right, as shown
in the diagram.

Click OK to accept the changes and exit the dialog.
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W

 Moveandresize =—===f=
Snap2 Duntilit | | |7 y
fills the upper right ,
corner.

nnnnnn

» Select Panel Edit
Off from the -
Display menu. Yau
can now use the Before After
new layout.

» To savethisinstrument for future use, select Save As from the File menu, type "1
Ch, 2 snapshot” into the standard file dialog, and click on the Save button.

This new instrument is very similar to the "1 Ch (dual snap)”, although it lacks a
fourth marker, marker label line and various custom display settings. For more
information about these settings, please see the following section, and the
SoundScope & SuperScope || Reference Manual.

CREATING A NEW INSTRUMENT

This section showsyou how to createa =
simple instrument with a time display, - [
analysis display, journal, waves, markers
and a segment. The result will look like |
the illustration to the right.

| owi

» Select New Instrument from the File =
menu and click OK in the confirmation s
dialog. This command deletes all e
waves, displays, journals, etc., allowing
you to proceed with a“clean date.” ¢

WAVES
This instrument will require two waves, an integer wave for holding the sound, and
a floating-point wave to hold the calculation result shown in the analysis display.

» Select New from the Wave menu. The wave options dialog will appear. Type
“A” in the Name edit box.
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» Sound datais stored as a series of
integers. Click the Format button and

Data Format: A

select the 16-bit |nteger Option_ {_»32-bit Floating Point (Volt)

@ 16-bit Integer
Waveforms recorded with 8bit, 12bit and Internal Volt
16bit digitizers are all stored in 16bit Man: (32767 |a—= [9.99969482 |
integers with values rangl ng from -32K Min: |_327f,3 |<§=,§> |_]|]_|]|]|]|]|]|] |
to +32K (i.e. the data is packed into the

most significant bits in the case of the 8 '
and 12 bit digitizers). (cancer ) ((_ox_)

» Click OK to exit the Format dialog.

« From the Wave pop-up menu at the Wave:{#MgH
top of the wave options dialog, :
select New Wave. Typethe name, Name:|d ) (e )
“Calc’. By default, wavesare  Units: (Points... | [Synthesize]
stored as 32-hit floating point data,
as desired for calculation results.

» Click OK to exit the Wave dialog.

DISPLAYS
Next we will create the displays and arrange them on the screen.

» Select New from the Display Display: Times ]
menu. Type“Time D" in the Contents
Name ed|t bOX_ Name: M Waves Display

Type: - = n

« Noticethetwo listsin the
Contents area of the dialog. The
Waves list on the |eft shows all
available waves and segments; the ]
Display list on the right shows Chep ] (concet ) [ %)

which waves and segments are te
be shown in our display. Drag wave A from the Waves list to any slot in the

Display list.

* From the Display Display:[v Time_D
pop-up menu at the : :
top of the dlalog Name: I%I d e |]IS|]|EII_.| = Display

select New Display. Type“Calc_D” in the Name edit box, and selectAnaIyss.
from the Type pop-up menu.
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Drag the result wave Calc from the Waves list to the top slot in the Display list.
In analysis and snapshot displays, the calculation result is stored in the wave that
isin thetop slot. (With the Spectrogram and LPC History analysis options, the

next 5 slots indicate the result waves for formant-tracking.).

Click OK to accept your changes and exit the Display dialog.

The next step is to arrange the displays on the front panel.

Select Panel Edit On from the Display menu.

=

nnnnnnnnnnnnn

|

T owi

Drag Time D
bottom left corner

and resize it so that«
It occupies about

3/4 of the width of
the front panel.

Tine D

Drag Calc_D to the
upper left corner

Before After

and resize it to fill the space above Time D.

JOURNALS
Next, we will create ajournal for storing notes and key values extracted from
waves.

Select New from the
Journal menu. Type
“Notes’ in the Name
edit box.

Click OK to create the
journal and exit the
dialog.

Move and resize the
journal so that it fillsif
the gap remaining on
the front panel.

Journal: | Notes |

Mode: | Spread Sheet |

MName: |Nutes |

Position: | Front Panel |

(<] Show name
(4 Show scroll bar
(d Show rectangular border

Options: []Save contents with config file

liew:

RN

(=] TR TT

Tab:
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e Sedlect Panedl Edit Off from

SoundScope/f16

the Display menu. You
should see something simil

to the front panel pictured t

-

the right.

= JF % |

MARKERS & SEGMENTS

Now we will create two markers and a segment.

» Select Markers? Time D
from the Display menu.

Take a moment to survey this
powerful dialog. Itisdivided
into three areas. The Display
area determines which markers
are shown in each display. The
Segment area is used to create,
modify and delete segments; anfl
the Marker area is used to
create, modify, and delete
markers.

Markers & Segments

Disp'au: ..... --"SEngHt: : .............
Show markers: .
5 Neme [

Wave: | |
—~Marker: |—| .....

[ New | [ Delete |
Dminduw:ms
0 hun osk (]
[ New ][ DEIEtE] [ Help... ] [ Cancel ]

We will use all three partsin
this dialog.

* Inthe marker area of the dialog, click the New button. Type “A1” into the Name

edit field.

* Inthe same way, create a second marker named “A2”.
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 Both marker names will appear in the Show markers ligtisplay: [ Time_D |-
in the Display region. Click Al and then A2 to show

both markersin Time D.

* Inthe Display pop-up menu, select Calc_D. Again clic
A1 and then A2 to show both markersin this display.

Show markers:
Al
A2

A\

i

* Inthe segment area of the dialog, click the New button. Type“A_S1” into the
Name edit field. Note that wave A and the marker boundaries A1 and A2 are
automatically selected in the corresponding pop-up menus.

» Click OK to exit the Markers & Segments dialog.

Now markers A1 and A2 are visible in the time and analysis displays.

REFINING THE DISPLAYS

The next step is to improve the appearance of the time and analysis displays.

» Select Controls? Time D
from the Display menu. In
Macintosh terminology,
buttons and scroll bars are
called controls.

Thisdialog is divided into two
main areas that specify controls
and default values for horizontal
and vertical scale and position.

* Inthe Horizontal region of thg
dialog, notice that Position is
set to Scrollable and the Scale
to Adjustable. These settings

Controls:

~Horizontal

Position: | Scrollable |

| Adjustable |
(] Add "H" auto adjust button

Scale:

-lertical

Position: | Scrollable |
[ Adjustable |
[JAdd "U'" auto adjust button

Scale:

[JFix sample period to |I].I]I]II]I]I] sec/pt

put a scroll bar control and a

scale control in Time_D. Click on the Add "H" auto adjust button checkbox to
add an additional control that will automatically change the scale so that the entire

sound fits into the display.

Since the amplitude of digitized soundwaves is fairly constant, there is usually no
need to be able to change the vertical position or scale directly from the front panel.
We will remove these controls to simplify the instrument.

I nstruments



In the Vertical region of the dialog, ;-Vertical

select Fixed from the Position menu -~ Position: |_Fixed | at 0000000
accepting the default value of Othat |  Seale:  [_Fied | at [10
appearstoitsright. Select Fixed | [IAdd "D" auto adjust button

from the Scale menu and type “10” in
the edit box that appears, to set the scale to 10 Volts per division. (One division
on the screen is 32 pixels, about 1/2".)

For Calc_D, we would like the horizontal axis to be “linked” to Time D so that they
will both scroll and change scale in unison.

Select Calc_D from the Controls menu at the top of the dialog. Note that an
additional pop-up menu appears at the top, so that each analysis option can have
different controls.

In the Horizontal region of the dialog, select Previous from the Position menu
and Previous from the Scale menu. Note that Time D isthe previous one in the
list of displays.

Notice that the vertical Position and Scale are set to Fixed base and Fixed, with
values in the edit boxes appropriate for the analysis option indicated at the top of
the dialog.

Select LPC History from the analysis menu in the top right of the dialog, and
change the horizontal Position and Scale to Previous. Repeat for HS Slice, skip
Avg Spectrum, and repeat for the remaining analysis options. The horizontal
axis of Average Spectrum is frequency rather than time, so it does not make sense
to link the position and scale to the soundwave.

Click OK to exit the Controls dialog.

Next we will modify some display features.
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We will also add a marker label line to show the time positions of markers A1 and

Select Features? Time D
from the Display menu.

Under Plot Region, select
None from the Grid pop-up
menu. This setting
eliminates the grid (dotted
lines at each division) in the
time display.

In the Display Labels area,

click the Add wave labels

Features:

-Plat Hegiﬂn ..... Horizontal e
Plot: & Add axis labels
Background:

Erid: __ND“E ..... UBI’liCﬂl
[<] Add axis labels

-Display Labels
[ Add label: D1
] Add wave labels [ Help... ] [ Cancel J

checkbox to de-select it,

removing the wave label region on the left of the time display. (The wave label

region is useful when more than one wave is shown in a display.)

Click OK to exit the Features diaog.

A2.

Select Labels? Calc_D from
the Display menu.

Notethat Al isselected inth
Marker pop-up at the upper
left corner of the dialog.
Click the Show X value
checkbox below it to select
this option.

Notethat A2 issalected in thra

other Marker pop-up. Clic

e

Labels:

<] show H value
O show ¥ value of

wove:[_o_|

[]Sshow marker name

c-Delta Dalugs s
[] Show delta H '
[ shauw dalta ¥ ;
[ $hews deita ¥odalia 8

..... mMarker:

] Show X ralue
[]1show ¥ value of

wave

[ Show marker name

[ Help... ] [ Cancel ]

the Show X value checkbox

below it to select this option. The time values of markers A1 and A2 will be

shown in the marker label line.

In the Delta Values area of the dialog box, click the Show delta X checkbox to

select this option. The time difference between markers A1 and A2 will appear

on the left edge of the marker label line.

Click OK to exit the Labels dialog.
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SAVING THE INSTRUMENT
Save your new instrument to disk for later use.

» Select Save As from the File menu.
* Type "my instrument” into the standard file dialog, and click on the Save button.

Y ou may want to practice working with this instrument. Afterwards, feel free to
make additional changesto it. Also, feel free to copy and modify the instruments
included with SoundScope, or swap instruments with friends and colleagues. If you
create a special-purpose instrument, please consider sending it to us so that we can
share it with others.

WHERE TO GO FOR MORE INFORMATION

Congratulations! 'Y ou have completed the tour and are well on your way to
becoming a SoundScope expert. Chapter 3 is a detailed discussion of a sophisticated
software instrument. Chapter 4 covers the building blocks used in instrument
design. Chapter 5 describes many of the instruments that are included with
SoundScope. Chapter 6 covers the front panel, and Chapter 7 outlines all the menus
and dialogs encountered by atypical user. For background information on
computer analysis of speech, please refer to the "Manual of Clinical Applications,”
available free from GW Instruments.

SoundScope is built on top of the SuperScope 11 engine, and includes all features
available in the SuperScope |1 application program. Advanced features such as
instrument design and multi-channel data acquisition are described in the
SoundScope & SuperScope Il Reference Manual.
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Chapter 3
Advanced Tutorial

The dilemma in designing any product involves the tradeoff between the number of
features and ease-of-use. Products with a few features tend to be easy to learn and
use, and those packed tend to be more challenging. And in many cases, smple
applications do not satisfy the user's requirements. SoundScope overcomes the
dilemma with several features which include a menubar editing environment, a
dialog-oriented command language (referred to as "tasks"), and a powerful set of
database export tools. The Menubar Editor enables an instrument designer to create
amenubar, and assign tasks to each menu item. The menubar can contain any
number of menus and commands; subsequently making it possible to create avery
simple instrument, with only a few commands (e.g. Record, Analyze, Print, Save
Data, Export To Database). And hence, the user can have it both ways with
SoundScope: simple and easy, or featureful and complicated. An exampleisthe
Professor who wants a powerful environment for himself/herself, yet who wants a
very simple environment for his’her students.

This chapter provides a tour of a simple instrument that records three vowels,
analyzes them, and sends the results to a FileM aker database. The name of the
instrument is " TriVowelgram™", and it is described in detail in Chapter 5,
Instruments. The following discussion will show the reader how to create tasks and
menubars, and how to interface SoundScope to another application program. It is
not necessary to understand these features in order to use SoundScope; they are only
used by the Instrument Designer, as opposed to the Instrument User. So, if you want
to learn about instrument design, please proceed. Please note that SoundScope/8
does not run Tasks, and therefore will not support several of the instructionsin this
chapter.

» Please exit SoundScope, find the TriVowelgram™ instrument, select it, and
choose Duplicate under File. Thiswill cause the file to be duplicated and
renamed to "TriVowelgram™ copy". It is good to work with a copy of an
instrument when doing design; so you can return to the starting point, if desired.
Also, as you are designing, it is always good to save your instrument every now
and then with an different file name (e.g. fredl, fred2, fred3, etc), to protect
against the unexpected.

* Double-click on TriVowelgram™ copy; or launch SoundScope, and then choose
Open under File to load the instrument.
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The TriVowelgram will appear as shown below.

|E TriVuwe]grﬂm"' QEI I Gl
First:Bart Last: Simpson Date:6/10/92 Yowel*1:e *2:0 3 u
A 51 A 51 A 51 A 51 A 51 A 51
shimmar (AFO>  HMR breathiness jitter ¢RAF> O aug {0 range
Lo | # B dE de B Hz 5T
1 A 1.971 2,000 1.400 196 . 642 4,380
2 3.582 HAMHCOZ 1 2 -1Z2.014 1.941 195. 032 12.210
3 5.930 13.8032 -14.295 0,776 197. 831 2,992

2687 . 753057813

LP 2406 . 504 (65 . 034 3
Fizo lelf R T T T F 20

LF 2500, 629042 . 3370
T = | R i S

SR I dE dE :
....... R O P 10 Lan = :
....... 4|:| 4|:|

T " s — O e 0
o 1 2 3 EH= 2.2 3.3 .o i1 22 3.3 EH=

b.0 1.1

BEMEE) EEER-][E]

2|43 100 msec/piv |1t

The lower most display shows a timewave which contains three vowels (e, o, u).
The display above the timewave is used for pitch tracking, and the three above it
show an LPC for each vowel. The main text area shows several analysis parameters
calculated for each vowel. The front panel Sizing option has been set to Fixed;
therefore this instrument will always open into a 640 x 480 window. If your
monitor is smaller, you can either do the tutorial with a portion of the instrument in
view, or you can choose Menubar » Full under Edit, choose Panel Options under
Display, set Sizing option to Resize Proportional, press OK, choose Save under File
to save the instrument to disk, and then choose Open under Fileto load it. The
instrument should reappear with it's window the size as the computer screen. If the
front panel is too crowded on the screen (i.e. it gives you a "Front Panel is Invalid”
message), you will need to resize several front panel objects to eliminate
overlapping, and then choose Panel Edit Off under Display.

Press the Calc (Iabeled "Cal") button in the Analysis display, above the timewave,
to initiate the Fo calculation.

With the current analysis options, an Fo track may not be feasible (i.e an Fo plot
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does not appear).

» Choose Options under Calculate (or press Option 'I' {lower-case letter L}) to
open the Analysis Options dialog, and then set the acceptable pitch periods to
150Hz to 210Hz. Press Ok to exit the dialog, and then press the Calc button
again. A valid pitch track should appear, as shown below.

Pitch tracking is more of an art
than a science, and it is often
necessary to adjust the pitch
track options before proceeding

with pitch-based anaIyS|s such as HNR shlmmer and Jltter In other words dont
trust the TriVowelgram's data if a good pitch track could not be attained. In the
above example, the second vowel is alittle clipped at the £10V bound, causing it's
Fo plot to waiver. Consequently, the HNR value calculated from this vowel is
NAN(021), which means "not a number"” (i.e. it could not be determined). We
include this case intentionally to make the reader more aware of issues that appear in
the field.

* Choose Complete Analysisin the Calculate menu. Thiswill cause the Analysis
Task to run, which does the following:

a)

b)

Clear the main journal, above the 3 LPC displays.
"Voiced"

Calculate the voiced intervals of the timewave, and place . _f —

the result into awave called "Voiced". The pointsin this M
wave are set to 1.0 where the timewave is voiced, and 0.0 '
elsewhere. It is plotted above the timewave, as shown in the illustration to
the right.

Do the following three times:

A) Find thefirst pulse in the Voiced wave. Notice that a pulsein Voiced
corresponds to a voiced interval, which should be avowel. Markers Al
and A2 are moved to the beginning and end, respectively, of the voiced
interval. Segment A_S1 is defined in the Marker dialog as the part of
the timewave (referred to as "A") between markers A1 and A2, and
should therefore contain a vowel.

B) Calculate sound statistics on segment A_S1 (i.e. the vowel). Shimmer,
HNR, breathiness, jitter, Fo average, and Fo range values are sent to
journal Notes, and appear as one row in the table.
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d)

Move marker A1l to the first vowel, and then move it 0.1 seconds to the
right, to place it inside the vowel. The Snap D display shows an LPC of the

timewave about this marker (i.e. it shows a transfer function of the vocal
track during the vowel's voicing).

€)
f)
9)
h)

Change the word "Pulse"

Move marker A2 into the second vowel, to setup it's LPC.

Move marker A3 into the third vowel, to setup it's LPC.

to "Vowel" in the Notes journal.

Copy the contents of the Notes journal into the Table journal. The Table

journal is arepository for data that is later sent to a database.

1)

» Select Choose Menubar » Full in the Edit menu. The menubar will change to one

Beep, to tell the user that the task is done.

that includes the standard SoundScope commands.

» Select Edit» Analyze und(\eI\rlL
Task to view the task that
just ran. The Task Editor
dialog will appear, as showi
to the right. Analyzes
Instructions are in the uppey
window, and the Instructior
Dictionary is at the lower
left. The instructions are
executed in order, top to
bottom. The Instruction
Dictionary contains the

(LM)[s)(v)[w)  Task:[_fnalyze ]
Task Begin

4

Clear at beginning of task journal Hotes

Clear, Calculate and Redraw Display Calc D

Uoiced = Uoiced (AD

Loop 2 times
Pul=e analysis on Uoiced (pulse# to MHotes; 3 to A1; t4 to AZD
Sound Statistics on A 51 (shimmer (AP0} to Hotes; HHR to Hotes; etc)
Loop end

Howe A1 to first peak of Uoiced

Mowe A1 to relative time X of Uoiced

Howe AZ to first peak of Uoiced

Howe AZ to next peak of Uoiced

Armlysis
Calculate Have

Pulse Aralusis

Sound Statistics

Name: |Hna|gze |

[ Hep... ) o

[ Debug... ] [ Revert ]

Statistics
Datapipes
Oisk |/0

building blocks for creating

atask. For details on tasks, please see the Task discussion in The Menubar

chapter of the SoundScope &

each instruction, please see the Instructions chapter in the same reference manual.

SuperScope |1 Reference Manual. For details on
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* Double-click on the Voiced = Caeulate Wane
Voiced(A) line. A Calculate
Wave dialog will appear, as O Cale |- cale |
shown to theright. Thisdialogi$ o[ Tar | = [ caic | =] [0.000 |
used to execute one of the 80 ot - [ eae [+ [eaie——]
functions and operators. For
details on each, please see the ® [ Uoiced | - [ Uoiced |
Functions and Operators chapter source: [ B |
in the SoundScope & SuperScopd
Il Reference Manual. Pop-up []use lariables
menus and radio buttons are used (el ] (View data] (Do it J(Cancer J[__0k ]

to setup a calculation. Each pop
up contains a list of waves, alist of functions (e.g. cos(), FFT()), or alist of
operators (e.g. +, - ,*). Thedialog is currently setup to calculate the Voiced
interval of the A wave and place the results into a wave named V oiced.

» Presson afew pop-ups to view the available waves, functions and operators.
* Press Cancel to exit the instruction.

» Each instruction can be viewed and modified by double-clicking on the text that
appears in the task region. Double-click on afew to see their dialogs,
remembering to press Cancel to exit each instruction.

There are over 20 different instructions in the Instruction Dictionary, each with it's
own dialog environment. One views or edits an existing instruction by double-
clicking on it and one copies an instruction by selecting it and then choosing Copy.
To paste a copied instruction into atask, install atask insertion pointer (i.e. a
horizontal dotted line) by clicking on the instruction above your target, and then
choose Paste. The copied instruction will appear immediately after the selected
instruction (which is highlighted). One can Delete an instruction by selecting it and
pressing the Delete key, and create a new instruction by dragging it from the
Instruction Dictionary into the task region. Tasks can be created, deleted, edited,
and run with the New, Delete, Edit, and Run commands in the Task menu. And this
Is how one "programs’ SoundScope.

* Togain asense of the richness of the SoundScope programming environment,
double-click on each instruction in the Instruction Dictionary, pressing Cancel to
exit each instruction's dialog. Double-clicking is like dragging the instruction
from the Dictionary to the end of the task. Pressing OK causes the instruction to
be inserted into the task, Cancel causes the insertion to be aborted.

Recall that the Analyze task bases cal cul ations on the segment of timewave that is

I nstruments 3-5



considered voiced. Fo tendsto vary alittle at voicing onset and offset; subsequently,
it is desirable to move the two segment-defining markers, A1 and A2, inward, to
eliminate the onset-offset effects. We will do this with two Move Marker
Instructions.

The Move Marker dialog will
appear, as shown to the right. Moue Marker:

Thisinstruction is used t0 MOVE  vqpe to [ ient mamimam | of wave
markers to waveform

minimums, maximums, local ~Options

minimums (“valleys"), local Help
maximums ("peaks"), upstroked,
downstrokes, specified points,

and specified wave values,

Scroll the Instruction Dictionary until the Move Jﬁgﬂg”ﬁ;ikep
Marker Instruction is visible, as shown to the right.fes Have Internal=

Drag the Move Marker instruction fro Pulse analusis on Uoiced (pulse®
the Instruction Dictionary into the task |~ Sound Statisticsken A 51 (shimmer
area and put it under the Pulse analysis instruction, as shown to the right.

Set the Move to pop-up to
relative time X, set the X
offset edit field to +0.050, and press OK. This instruction is now setup to move
the A1 marker to the right by 50ms, before analyzing the vowsel.

Now lets move the right edge marker to the left.

Click once on your new Move Marker instruction to select it, choose Copy under
Edit to copy it to the clipboard, and then choose Paste under Edit to paste it into

the task, at the position of the dotted line, which is conveniently right before the

Sound Statistics instruction.

Double-click on your new instruction, to open it's dialog, and then select marker
A2 in the upper-most pop-up, change +0.050 to -0.050, and then press OK. This
Instruction is now setup to move the A2 marker to the left by 50ms, before
analyzing the vowsl.

Press the Go button at the upper right to run the task in [ Go ] [Step] [stup]
debugger mode. A triangle will appear at the left (P) that
shows which instruction is being executed. After afew seconds, press the Step
button to temporarily halt the execution.
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* Now press the W button, at the upper-left, to open th @ @ @

Wave dialog. From here, one can view a wave's values

with the Edit button, or the number of points with the Points button, for example.
To view another wave, simply select it in the upper-most pop-up menu. Press
OK to exit this diaog.

TheC, J, M, S,V and W buttons are used to view and modify controls, journals,
markers, strings, variables, and waves; during, before, or after running atask. This
Is helpful when a"problem™ is encountered. These buttons cause a new object to be
created if one does not already exist; otherwise they open the dialog for the first
item in the corresponding object list.

« Press the Step button to execute another instruction. The (#) will increment one
line. Press Step several times, and then press Go to let the task run free. When
the task is finished, exit the Task Editor by pressing OK.

Another form of debugging is to send information to a journal at run time. Several
journal reporting features are available, and fully described in The Menubar Chapter
of the SoundScope & SuperScope Il Reference Manual.

* Choose New under Journal to create a new journal. When the journal dialog
appears, change the journal’s name to Task80; and then set the Position pop-up
menu to Window. Press OK to open the new window-based journal.

Clicking in the front panel will cause the Task80 journal to become the back-most
window. To bring it to the front, choose Show » Task80 under Edit.

H
A

* Choose Run* Analyze under Task to run the [EO=——= Task80
task. Each instruction will be written to the

Task80journa|,asitisexecuted;asshowntothangt:ggggﬁze Date:8/15/92  Tim

right. It will beep when finished (this task may |ciear at beginning of task journal |
. . cl Calculat d Fed Displ
take a little while). Clear, Calculate and Redraw Display
Loop 2 times
Pulse analysis on Uoiced (pulse#

*  When the task is done, click once inthe journal |  Found Statistiss on 51 cshinn=

to select it's window. Loop 3 times

Pulse analysis an Uoiced Cpulse#

[

» Choose Cloverleaf 'a ( [Ca)lto select the entire contents of the journal, and then
press the Delete key to erase it.

» Choose Copy Task » Analyze under Edit to copy atextural description of the task
to the clipboard. Click once in the Task80 journal window and then choose Paste
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under Edit. A description of the task will be dumped to the journal.

Now choose Clear » Task80 under Journal to clear the journal of it's contents
(notice thisis similar to [a)] press Option 'a to copy atextual description of the
entire instrument to the clipboard, click once in the Task80 journal, and then
choose Paste under Edit. A description of the instrument will be dumped to the
journal. Use the scrollbar and resize box to view this description. For a more
complete description, press Option Shift ‘A,

We will now create a task, create a new menu command, and then setup the menu
command to run the task. For details on the Menubar Editor, please see The
Menubar chapter in the SoundScope & SuperScope Il Reference Manual.

Choose New under Task
to create a new task.
Name it "myTask", and

then drag the Alert, Beep

or Delay instruction
(near the bottom of the
instruction dictionary)
into the task region.
Select the Display
message radio, enter
"Hello." into the edit
field, and then press OK
to install the instruction

Press Go to see the task

run. It should execute

Alert, Beep & Delay
i1 Beep
i1 Stop task
' Break out of Trace Loop
» Wait for mouse down
iy Wait for mouse up

) Wait for key press
i3 Delay for|2.000 seconds
i3 Synchonize to secund intervals

@ Show Alert:|Hello.

[ Help ][ Do It ][ Cancel ]

the instruction which produces the "Hello," alert. Press Continue to exit this
aert. In Go mode, tasks beep upon completion.

Press OK to exit the Task Editor.

Choose Edit Menubar » Full under Edit to open the Menubar Editor dialog.
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Choose Task in the Menu pop-up,
to select this menu.

Choose New User Item in the
[tem pop-up to create a new men
item.

Choose the Show custom text

Custom Menuhar:@
Name:|FuII |
-—Menu:| Task I

i Show default text "Task"
O show custom text: [Task |
i Hide menu

radio under the item pop-up to
specify that the text in the adjace
edit field be placed into the meny

~1tem:| User Item 1 |

i Show default text "User Item 1"
i@ Show custom text: |Sag Hello |

Type "Say Hello" into thisfield.

1 Hide item
5] Run Task[_myTask

Cancel

Choose myTask in the Run Task
pop-up -- to specify that this task
be run when Say Hello is select
under Task.

Press Ok to exit the Menubar Editor.

Hello

Choose Say Hello in the Task

menu to view your creation. An
alert should appear, as illustrateq
to the right.

Now choose Save As under File
to save this new instrument undq
anew name, such as
"myTriVowelgram". Consequently, double-clicking on the new file will open
this instrument.

Notice that the Menubar and Task Editors enable you to build virtually any menu
driven application program, without knowledge of a programming syntax. Thisis
new in the world of computing, and is something that we are very excited about.

This concludes the first round of the Advanced Tutorial. For atour of QuickTime,
HyperCard XCMDs, and database work; please continue.
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QuickTime & HyperCard XCMDs

In the 1970's, the world developed computing tools for handling text. The 1980's
was the decade of graphics (e.g. the Macintosh user interface). Many expect the
1990's to be the age of moving graphics (video). It is also theorized that this will be
asinfluential to our society as the revolutionsin text and graphics. Apple's
technology for recording, playing, editing, compressing and databasing computer
videos is commonly referred to as "QuickTime". Many tools that support
QuickTime movies are available from Apple and Third Party Developers.
SoundScope can play and plot pre-made QuickTime movies via several QuickTime
XCMDs.

XCMDs are the programming port-hole through which HyperCard communicates
with the world. Physically, they are little functions whose code resides in afile on
disk. They are used primarily by HyperCard to control multimedia devices such as
tape recorders and framegrabbers, yet can be used to perform virtually any
function. XCMDs are callable from SoundScope, via the HyperCard XCMD/XCFN
instruction, and consequently add a new dimension to SoundScope programming.

An example of an XCMD is
FinderEvents, by Jon Pugh.
This XCMD sends messagesto
the Finder and is distributed
non-commercially by user-
groups and computer networkg
The XCMD isstored in a
HyperCard stack file called
"FinderEvents', illustrated to
theright. The stack contains
documentation on how to call
the FinderEvents() function. |
explainsthat the XCMD has o
parameter that tells the Finder
what to do. For example, executing Finder Events " AboutMacintosh” from
HyperCard or SoundScope instructs the Finder to show the "About This Macintosh"
dialog. Toinstall this XCMD into SoundScope, the user must place a copy of the
"FinderEvents' file into the "HyperCard XCMD/XFCN" folder, inside the
"Resources' folder, which must be at the same level as SoundScope, and then restart
SoundScope. Subsequently, one can create a SoundScope instruction

elcome to & demo of the currently available FinderEvents. These are a set of custorn Apple events
at the Finder in System 7.0 understands, Apple® will not support these events and warns you that
ey probably will change in the near future to conform to the standard Core suite of Apple events. In
e meantime, here is an *CMD that w911 send FinderEvents and give you some degrees of contraol over
e Finder fram HuyperTalk. The Finder is not intended to be scriptable. Thiz is version 1.2
LTicd o 2w nenegs Sele\w fo seE & Gescription oF Wt Function snd exsmoles.
About Move Selection Reveal Selection
Alias Selection Move Window Set View
Close About Open Selection Sharing
Close wWindow Page Setup Show Clipboard
Drag Selection Print Selection Shut Down
Duplicate Selection Print Window Sleep
Empty Trash Fut Away Zoom Window
Get Info Resize Window
Hide Clipboard Restart
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that opens the About This Macintosh EJE=———= fbout This Macintosh ===l
dialog by typing Finder Events System Software 7.0.1
" AboutMacintosh" into the HyperCarg
XCMD/XFCN instruction. XFCN are total Memory : 20,480K  Largest Unused Block: 2 735K

identical to XCMD, except that they 5327 zo00k I |
always return information into a g e s 2o -—:I "
SoundScope string named "retvalue’| g ol o e

[ — =] Macintosh IIfx Apple Computer, Inc. 1932-1991

Thousands of XCMDs are available commercially and as shareware. Several Apple
authored XCMDs that play QuickTime movies are included with SoundScope. For
details on XCMDs and the SoundScope-to-XCMD interface, please see the
Instructions chapter in the SoundScope & SuperScope |1 Reference Manual.

If you did not install the QuickTime, XLink Extensions, XLink Manager
Extensions; and the XLink Setup Control Panels, please do so now. Playing
QuickTime movies within SoundScope requires that the QuickTime extension be
installed in your System folder; however, this extension is not included with
SoundScope. Therefore, you must acquire this from your dealer if you desire
this feature (it's not needed in most applications). Installing extensions requires
exiting SoundScope and installing several files into your System Folder, as
described in the System Extensions Installation discussion at the beginning of this
manual. These extensions and QuickTime itself consumes some memory;
therefore, if your memory is already low, don't be surprised if you hit a memory
error. Make sure you Restart your computer and then launch your
TriVowelgram after installing these extensions.

Select Choose Menubar » Real Short in the Edit menu, if it is not already selected.

Choose Open under QuickTime. A file open dialog will appear. Select a random
guicktime movie file that is on your computer (severa are included with
QuickTime).

Now choose Play under QuickTime to play the movie in the left-most LPC
display. QuickTime movies are beautiful when run on =8bit color graphics
systems. Conversely, they tend lack appeal when run in black-and-white
environments. Additionally, QuickTime recordings sound better on faster
machines (= 25MHz 68030 processor).

If you do not see a movie and want to debug the situation: select Choose Menubar
» Full under Edit, choose New under Journal, select Window in the Position pop-
up menu, set the journal name to "TaskView", press OK, and then choose Run »
PlayMvie under Task. Thiswill cause the task to run while debugging
information is sent to the new journal. The right most column in the printout
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will show the value of the retValue string after each instruction. This string is
loaded with error information by the QTMovie() XCMD, and may provide a clue
to the problem.

* Now choose Plot under QuickTime to plot the movie frames across the screen.
Now lets take alook at the tasks that perform this magic.

» Select Choose Menubar » Full in the Edit menu to enable the complete menubar.
* Choose Edit * OpenMvie under Task to view the task which determined the file

pathname to the QuickTime movie. The Open command under QuickTime in the
Real Short menubar invokes this task.

Thefirst line in this task calls the FileName() XFCN{Task Begin

which opens the standard file open dialog. This ~ [El=tenecoew™s
function has one argument, a four character string ’

that specifies which type of fileis shown in the file dialog. QuickTime files are of
type "MooV", text files are of type "TEXT". XFCNs always return their results into
a string named "retValue", and in the case of FileName(), afile pathname is copied
into this string. For example, if the "Resources' folder resides at the top level of a
hard disk labeled "myHD", the pathname could be "myHD:Resources:QuickTime
Movies.Glottis'. The second line in the task calls another XCMD that creates a
string named "fileName" (if it does not already exists), and then copies the contents
of the retValue string into fileName. We copy the contents since another XCFN may
overwrite the retValue string and we need to hold onto the pathname.

» Choose PlayMvie in the upper-most pop-up menu to view the task which plays the
QuickTime movie. The Play command under the QuickTime menu in the Real
Short menubar invokes this task.

. . .. OTHMouvie "OpenMovie”, Direct, fileMame, L Snap D, Fastidle, loo
QTMOVle() XCM D, Wthh IS |nCI Ud SetGlobal l':"mn:w\,'iEID", retlalus i F
in the HyperCard Development Kit

Thefirst line in this task calls the Task Begin
OTHowie Direct, mowielD, Idle
and the QuickTime Developer Kit.

OTMowvie Direct, movielD, Dispose

3-12 SoundScope User's Manual



* Double-click on the first
QTMovig() line to open the
HyperCard instruction
dialog. Thisinstruction Auailable Objects
executes XCMD and XFCN [D]isplays:[_Time_D
placed into the "HyperCard || = Wournais:[_Ddate

HyperCard HCMD/HFCN

0TMovie "OpenMovie”, Direct, fileName, L_Snap_D, Fastidle,loop

‘6, 386, 635, 459
‘6/10/929R

|
|

XCMD/XFCN" folder (inside ZeerTi_—_ n.200%
the "Resources’ folder) via |  @ariabtes srror ] [5.666660
the XLink Extensions [aves:[_Calc | :
Extension, XLink Manager HCMD/FCN: [_PostTempo | | =
Extensions Extension and thnz e ) [oit ] (o ) [ ok )
XLink Setup Control Panel.

* Press on the lower-most pop-up menu to view which XCMDs areinstalled in the
"HyperCard XCMD/XFCN" folder. Each XCMD is stored in aresource, and
many resources can be placed into onefile.

The user types aline of text into the upper-most edit field, which is executed at run
time. SoundScope objects (e.g. displays, journals, markers, strings, variables) can be
passed as parametersto XCMDs. Since HyperCard is string based, these objects
correspond to a line of text, displayed to the right of each object's pop-up. For
example, in the above illustration, display Time D is shown as representing a string
set to "6, 306, 635, 459". Subsequently, passing Time_D as a parameter is like
passing "6, 306, 635, 459" as astring. The object pop-up menus select which object
IS represented in the text region to the right of each pop-up. The object buttons (e.g.
D, J, M, S) open the corresponding object dialogs.

The first QTMovie() XCMD opens a movie file at the fileName location and readies
it for play. A movie identification number is returned in retValue, which is
subsequently copied into movielD with a SetGlobal XCMD. The third instruction
tells the movie to play until the mouse button is pressed, and the forth instruction
releases memory used by the movie.

* Press Cancel to exit the HyperCard instruction, and then press OK to exit the
Task Editor.

This concludes our tour of QuickTime and the XCMD interface. For more details
on this topic, please refer to the HyperCard XCMD/XFCN discussion in the
Instructions chapter of the SoundScope & SuperScope || Reference Manual.
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Database Access

In many cases, it is desirable to save the results of an experiment into a database,
spreadsheet, or word processor; for later viewing, analysis, and comparison. A
FileMaker database that does this is included with the TriVowelgram instrument.
One record is created for each three vowel measurement; subsequently they can
easily be viewed, printed, and sorted. This system gathers and stores data in the
same way for each trial, and can therefore be used to monitor a subject over time, or
to compare multiple subjects. For an example of a printout from this database,
please see the TriVowelgram description in Chapter 5, Instruments.

= fileMaker.db 6 EE§|
\J ;
DEMOGEAPHICS !
Records: N
1 Elart ................................. ........................ :
Unzorted Street Addr ¥Work Phone
{34 Winter S | ifZ5-404h
City State
iCambridge i ia
i EXAMINATIO
Physician L. Silverstein
History Bart's throat became soar afer chewing o much bubble qurm.
i QUANTITATIVE DATA &
Yowel Shinmer HHE  Breathiness Jitter Fo Avg Fo Range
a woads 2264 -i.3d1 1.2010 196675 4812
& 3856 MAMNOZTE  -19.836 Bd43 198.357 227
[+ 5005 141818 -22.391 Srres 1978 2 BEY 4}
100 [l u[ BT[] =[5

* Choose Run?* Analyze under Task to execute the three vowel analysis. It will
beep when finished (this task may take a little while).

* Choose Show » Table under Edit and then choose Show » Export under Edit to
open the Table and Export window-based journals.
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Table

A 51 A 51 A 31 A 51 A 51
shimmer CAPOY  HHR breathiness jitter CRAPY 0 aug
B dB dB B Hz

4,995 1.920 —6.220 1.309 199,879
4. 160 HAMCOZ1 > —19.992 0. 904 200041
4,535 14.876 —21.906 0,699 200,105

=1

* Choose Run* Export unde
Task, and when the file
dialog appears (it might
take a little while), save th
text under the name _
composes a one line string|
with data from the various
journals and then savesit to disk. The string contains the following fields
separated by commas: firstName, lastName, examDate, vowel 1, vowel 2, vowel 3,
shimmerl, HNR1, breathinessl, jitterl, FoAvgl, FoRangel, shimmer2, HNR2,
breathiness?, jitter2, FOAvg2, FoRange2, shimmer3, HNR3, breathiness3, jitter3,
FoAvg3, FoRange3.

[ ] (Dmm—g
=

=
I

=] [

» Choose Edit » Export under Task to view the task that implemented the export.
To gain asense of the string handling capabilities in SoundScope, double-click on
afew instructions, pressing Cancel to exit each instruction's dialog. Press OK to
exit the Task Editor.

If FileMaker Proisinstaled on your hard disk and you want to see database import
at work, please continue; otherwise, we hope you enjoyed the show and request that
you phone us at 617/625-4096 if you have any questions. If you are currently
running the Demonstration version of SoundScope and want more information,
please contact us and request a FREE copy of the SoundScope & SuperScope ||
Reference Manual.

* Double-click on the TriVowelgram™ Database file; or launch FileMaker Pro,
and then choose Open under File to load the database.
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* Choose Import under File,
select the Export text file

Specify field order for import

A A Data In: “Export” Fields In: “Trilowelgram™ D...”
(i.e. the one that we just BT ame
saved), and then press OK ©/10/52 | 3/ Exam Date
Order dla|Og appears, as 4.995 | shimmer .1
. . 1.920 (=% hnr.1
|“Ustrated to the I’Ight. A -5.220 || breathiness.1

. 1.309 [ jitter 1
new record will 15257 Hlfo avet
automatically be created, angl 4.160 || shimmer .2
its fields will automatically e e 2
. . <<| Scan Data |»»| Record 1
be loadled with the data n the - *
H new records
teXt flle' ) Replace data in current found set
Text is the universal language A B C__ [p[E[F[ & H |
1 |Bart HSimpson § 6/10/92i8 ie i 49951 1 92: -5 22

with computers. It iseasily
transferred between SoundScope, word processors, HyperCard, and spreadsheets.
Opening our Export text file with Excel (i.e. a popular spreadsheet authored by
Microsoft Corp), with commas separating each cell, causes our datato be placed into
one row, as illustrated above. When loading or saving spreadsheet text, each column
IS separated by atab or comma, and each row is separated by a carriage return.

To copy adisplay from SoundScope to a FileMaker picture field, one would choose
Copy Display under Edit in SoundScope (to copy the display to the clipboard), click
once in the FileMaker window, place the insertion point into the picture field, and
then choose Paste. FileMaker Pro, a Claris Corporation product, is probably the
best flat file database in the world. One neat feature is its support of simultaneous
access over a network from both PC's and Macintosh computers.

Building a dedicated SoundScope instrument and FileMaker database is not a
particularly easy task. Learning the SoundScope design features could take 1 to 3
days, learning FileMaker could take 1 to 2 days, building a SoundScope instrument
could take 1 to 10hrs, and building a FileMaker database could take 1 to 8hrs;
assuming there are no major "snags'. Our commitment to database access is strong,
and we will continue to develop new and improved methods for communicating with
other applications, in our quest to create the world's most advanced recording tool.
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Chapter 4
Instrument Design

It is said that, in the future, programmers will not program (in the
traditional sense) due to the development of sophisticated software that facilitates
programming by the end user, "programming" being defined as the act of building
an application program. SoundScope is another milestone in this evolution since it
provides an environment where the end user can design their own menu driven
application program. We refer to these applications as SoundScope "instruments”,
and have included several with the product.
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SouNDScoPE OBJECTS

The SoundScope user creates and customizes objects with mouse driven pull down
menus and dialog boxes -- no previous programming experience is necessary. There
are several types of objects, as shown below. One can create as many of each type as
needed to build the application of their dreams. Each type has it's own dialog where
one can view and edit attributes, such as the object's name. This chapter summarizes
these powerful building blocks.

M1:C-0.7672

Markers

QuickTime

Offset 1

Journals Controls Menubars

Calculate Hauwe
Pulse Analuysi=

abcdef 1.123 Sound Statistics
Statistics
Strings Variables Tasks
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WAVES

Waves are used to represent real world continuous data
alist of values, which when plotted, produce a waveform.
Waves can be digitized, synthesized, analyzed, edited,
viewed, used to hold the results of analysis, loaded fron

disk, saved to disk, sent to the clipboard as a column of
numbers in text format, and sent to the clipboard as a graphical image. Typical
instruments have 3 to 10 (or more) waves and wherever you see a squiggle in
SoundScope, you are looking at a Wave object. Waves are stored in memory as a
list of 16-bit integer (£32,768) or 32-bit floating point values and their maximum
lengths are limited by memory (each point consumes two or four bytes depending on
the storage format).

Waves are created by choosing New under Wave. The wave dialog appearsand it is
from here that one can view and edit the number of points (via the Points button),
view and edit the internal storage format (via the Format button), view and edit the
individual wave values (via the Edit button), or synthesize.

shows the individual points with 5 points displayed in each 57, 065 I

The Value Editor is a spreadsheet-like environment that ;| 35,705 35,415

................................................................

row. Cells can be selected, cut, copied and pasted withthe! 25 0200 24,080
mouse. Additionally, selected cells can be edited
numerically with the keyboard. Wave segments on the clipboard are stored as a
column of numbers in a text format and can easily be transferred to a graphics,
spreadsheet or word processing program.

The Wave Synthesizer |oads a wave with a constant value, ramp, Sine-_.-—_.
wave, triangle wave, square wave, uniform noise (flat histogram), or —__r—_
gaussian noise (gaussian distribution).

One can easily edit a wave by moving wave segments to and from the “ :
clipboard via the standard Macintosh Cut, Copy and Paste commands. i : :
The user identifies a segment by dragging the mouse over the region o! :
interest. The insertion point is positioned by clicking the mouse once.:
Cut, Copy and Paste commands correspond to the selected wave (awave

Is selected by clicking on its wave label; or, if there is only one wave in the display,
clicking in the display).
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DISPLAYS

Displays reside on the front panel and are us
to view waveforms and perform calculations.
They are extremely versatile with many
customizabl e attributes such as
horizontal/vertical scroll/position controls,
labels, waves, markers and much more.
Displays can be positioned on the front panel i E—
any pattern and in any number, space : S
permitting. Each display can contain up to 8 El N 10D 1 ksec/mivfiY]
waves and supports mouse-driven cut/copy/paste of waveform segments, drawing of
waves, and logging wave values to ajournal.

&0
: : o de
....... S S FO AT

...... NP U S T

]

EIEEENE

To create a display, one must choose New under Display. Subsequently, the display
dialog appears and it is here that one specifies which waves are to be displayed (this
is done by dragging wave names from the waves list box to the display contents
box). There are four display types. Wave Plot, XY Plot, Analysis and
Snapshot. Wave Plot is used to plot 1 to 8 waves across the screen, XY plots1to 8
wave pairs, Snapshot analyzes (e.g. frequency spectrum) a timewave at a marker
position, and Analysis analyzes a segment of atimewave. Customizable |abels,
controls, axes, grids, plot graphics and markers are easily adjusted with dialogs
accessed by choosing Features, Labels, Controls, and Markers under Display.

The user can easily redraw a waveform segment by placing SoundScope rr—\fj
in Draw mode (choose Mouse » Draw under Display) and then drawing i
a Display with the mouse.

The user can vertically re-position a waveform by placing
SoundScope in Vertical Adjust mode (choose Mouse? Vertical
Adjust under Display) and then dragging the selected wave up or

down in adisplay. A double headed arrow is appended to the wave name of a
vertically adjusted wave to indicate that it no longer corresponds to the vertical scale
at the right of the display region. Clicking this double arrow once will cause the
vertically adjusted wave to snap back into its original position.

4 - 4 SoundScope User's Manual



JOURNALS

Journals are text regions that are used to enter, view 1

and edit text in amanner similar to that done with a Egégmbgfuzﬂ:k?n&ﬁeen
word processor. With commands in the menubar, thel, \jred and rinetu-tws.|[]
user can Clear, Save, View, Save to Clipboard, Print, B
Delete and Create Journals. The contents of Journals [<[f Fi
can easily be saved to disk and then loaded by aword
processor, graphics, or spreadsheet program. Journal windows can be resized and
positioned on the front panel in any pattern and in any number, space permitting.
Many task instructions transfer text to and from journals.

To create a Journal, one chooses New from the Journal menu. Subsequently, the
Journal dialog opens, and it is from here that one specifies several Journal options
such as journal name, the number of characters between each tab, and whether or
not the journal’s contents are stored with the instrument file.

Each journal can operate in one of two modes. Word Processor or Spreadsheet. The
Word Processor mode works with a fixed page width (e.g. 7 inches) and supports
automatic wrap-around. This mode is useful when one wants to send the journal
contents to a word processor or print the journal with a limited width format. The
spreadsheet mode is more like a traditional spreadsheet with an unlimited width, no
wrap-around, and horizontal scrolling that will go as far right as necessary. Thisis
useful when it is necessary to send the journal’s contents to a spreadsheet. Tabular
numeric data in SoundScope journals transfer nicely to spreadsheets, with each value
being placed in its own spreadsheet cell. Thisis made possible with a TAB delimiter
between each column and a CARRIAGE RETURN character between each row.
Thisis awonderful standard for text files since it insures compatibility between
journals, word processors and spreadsheet application programs!

The user can log points to a journal by placing SoundScope *:Hz Y dB

in Log Coordinates Mouse mode (choose Mouse » Log Coords 227884 18.080
under Display) and then clicking the mouse on a selected wave

(recall that you select a wave by clicking on its label; or, if there is only one wavein
the display, clicking in the display).
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CONTROLS & INDICATORS

Front panel Controls and Indicators, shown below, alow the adjustment of, Boolean
true/false values, scalars, lists, and text. These objects appear in avariety of styles,
sizes, fonts, and colors; and their states are easily read and updated with tasks.

- Power
‘m’ FILE On
Dout0 o i off
Lights Buttons Switches
indicate the state of a | often initiate the executignspecify a true/false Boolegn
Boolean true/false value of atask. condition.

107 i
J
0.

=]

Volume

Offset 1

Sliders Dials Meters

control a scalar quantity] control a continuous orf| indicate a scalar quantity.
guantized scalar quantity.

4.5% |#] channel o Duration = 12.32
Numeric Fields Static Text
control a scalar quantity of shows a scalar quantity off a
text string. text string.
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M ARKERS

Markers are typically used to mark atime in awave or display. The user can create
as many markers as he/she desires and can place any marker in any display (via
Markers under Display). In displays, they appear as vertical lines that can be moved
left and right with the mouse. Additionally, the display can be set up to show
marker labels at the top of the display (choose Label under Display). A neat trick is
to use two markers and one wave to describe another wave, called a "segment”,
which is defined as the section of the original wave between any two markers (via
Markers under Display). The segment and the source wave share the same data.

The cursor window isusedto (T

numerically view specific pointsalonga [ wave | Horizontal | Vertical
waveform. The contents of the cursor p——— Z162500 dB | 2234375 dB
window corresponds to the location of the[ znap Z162 500 dB =T
mouse. Thisis opened by choosing Show »
Cursor under Edit.
M ENUBARS
Menubars are a powerful
tool for modifying the Custom Menubar:| MyMenu |
current menubar, or creating
your own. In some cases, ifff ~ eme:MyMenu
is desirable to have avery ~Menu:| File }
simple menubar to limit a @ Show default text "File"
user's options. Menubars afp :
easily created, renamed, and| {_ Show custom text: (File
deleted. Each menubar ) Hide menu
consist of a set of menus andj [ User Ttem 1 |
a set of items for each meny| {~'tem:_—Ser tem |
Each menu and item can be {_) Show default text "User Item 1
renamed (e.g. change @ Show custom text: |Open Movie...
"Open..." to "Open Sesame™), i Hide item
hidden, or set up to run a [ Run Task| 0 i
, pen™ou |
Task when chosen.
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TASKS

Tasks are little program Task Begin
sequences that perform aseriedtlear at beginning of task journal Data
of operations when run. For Clear, Calculate gnd Redraw Display Analysis
example, one could write a tasq>'==d = Unized ttime .

Mowe M1 to absolute time X of time
to record data' analyze_’ update Mowve M2 to agbsolute time X of Lime
the screen, and then print the |Loop 3 times
results. Tasks are easly Pulse analusi= on Uoiced Cpulse# to Datg; t3
created, viewed, edited, and Sound Statistics on Segment Cshimmer ¢APOY to
debugged; and can be set up to " '—*:';F; i”df_ C eck of Uoicod

oLl [m] 1= pead [m] alze

wae\évgwa?/énc?]rgneggov\cﬁséna Mowve M1 to relative time X of Uoiced
specific menu item is chosen or when the user chooses Run Task. One "programs’
tasks using a powerful mouse/dialog user interface. The neat thing about
programming SoundScope is you do not need to know any syntax -- the mouse-
driven dialog boxes take care of you.

| NSTRUCTIONS

Instructions are the building blocks used {o———-—--——-- Analysis ——————-———--

. Calculate Houe
create tasks. There are over 30 kinds of |, -2 Aralus =

instructions, each of which is used to Sound Statiztics
perform a specific function (e.g. savea [Statistics Data Tranet
wave to disk, move amarker, choose @ |poiopipes

menu item, calculate the derivative of a [Disk 1.0
wave, etc.). Each task contains alist of
instructions that are executed in the order they appear in the list; and each
Instruction can be viewed, edited, cut, copied, and pasted.

DATAPIPES

A datapipe is areference to afolder on a hard disk or floppy disk. Technically, a
datapipe is a pathname to afolder. Think of it as a pipe, through which you squirt
data between SuperScope |1 and afolder on disk. Datapipes are often used to access
folders from within tasks, where the name of the folder may change with each
experiment. The Datapipe instruction can be used to create a new data folder, and
to attach a datapipe to that folder. The Disk /O instruction could then be used to
push data into the datapipe, and ultimately into the new folder. Datapipes, like
other SuperScope Il objects, are created, deleted, and named. To view or modify a
datapipe's folder, choose Datapipe Folder » under File.
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V ARIABLES

Variables are used to holdf

one 32-bit floating point
value (e.g. 16, 2.3,
1.34e6). They are easily
created, renamed, and
deleted; and their values
are easily viewed and
edited. Many task

instructions transfer value

to and from variables.

STRINGS

Strings are used to hold
series of characters of an
length, memory
permitting (e.g. "hi",
"1.2"). They are easily
created, renamed, and
deleted; and their text is
easily viewed and edited.
Many task instructions
transfer text to and from
strings.

Dariable: | U1 |
""" Parameters
Mame: |1
Ulalue: |1.23135
S Units: |Uolts
| Delete |
String: | H |

Mow 15 the time for all good men and wormen to come to the

gid of their, of others, country.

o

Parameters - ———— ;
Name: [# | (Cvew ][0k ]
Units: [Volts | (petete ) (cancel )

I nstruments
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TASKS AND INSTRUCTIONS

SoundScope provides an easy to use environment by which one explicitly defines
acquisition, analysis, archival and presentation features. From this environment, one
defines little programs called Tasks, each of which can be created, edited, viewed
and run. These little programs consist of alist of instructions which are executed in
atop to bottom sequence. Each instruction is not typed however, as done in
traditional textual programming environments; instead, each instruction has an
associated dialog box from which the user specifies, in detail, the instruction's
functionality -- with easy to use pop-up menus, check boxes, radio buttons and edit
fields. These dialogs appear when one initially adds an instruction to atask, and
when one edits an instruction by double clicking on it's text. Instructions are added
to a task by dragging one from the Instruction Dictionary; deleted from atask by
being selected and then removed with the Delete key; moved from one position in a
task to another viathe standard Cut, Copy & Paste clipboard features; and modified
by double-clicking with the mouse. An example instruction is the Calculate Wave
instruction which enables the user to place mathematical expressions into atask (e.g.
W1 = AutoCorrelation(W?2)). The instructions are summarized below:

ALERT, BEEP, OR DELAY is used tf
sound a beep, show amessage in an © Beep

aert, stop the task, wait until the O stop task

mouse button is pressed, wait until thel ) greak out of Trace Loop
mouse button is released, wait for a () Wait for mouse down

Alert, Beep & Delay

specific key press, freeze for a O Wait for mouse up
specified duration, or synchronize to g ¢ Wait forkey [ir_]press
specified duration. O Delay for[2.000 _|seconds

2 Synchonize to secund intervals

® Show Alert:|Max FFT Low!

[ Hetp ][ Doit ][ cancet || ok ||
ARITHMETIC is used to arithmeticalljy scalar Arithmetic
combine two objects (e.g. +, -, +, *)
and transfer the result to a third. I e :I sl %:
Objects include variables, strings,
waves, markers, journals and controls 0.00000 0.01000 0.00000 VoIt

[ Help. ][ Doit ] [ cancel || ok ]
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ASSIGNMENT is used to copy the
scalar value of one object into another|
object. A marker's value is derived
from it's position; a control's value is
derived from it's setting; a string or

journal’'s value is derived from it's tex;

and awave's scalar value is derived
from one

ANALOG & DIGITAL /0O isused to
read and write analog and digital valug
to and from MacADIOS hardware.

CALCULATE WAVE isused to
perform waveform cal culations; such
as FFT, cos, +, or *. Over 80
functions and operators are supported|

CHOOSE MENU is used to select a
menubar command or press a key (e.
choose Print under File, press Option
‘e, etc). Thisis very powerful sincei
brings all menubar and keyboard
commands within the scope of task
Instructions.

Scalar Assignment
| variable | . [ Value |
error | ~ |o.000
Eniiong..
; 1.00000 Volts 0.00000
[ Help.. ][ Deit ][ cancet ||| ok ||
Scalar Assignment
S
|_Uariable | _ | Dalue |
error | ~ |0.000
Eiinng..
1.00000 Volts 0.00000
[ Help.. ][ Doit [ cancel ]| ok ||
Calculate Wave
<[ Rin0 | = [ ninD |
< [ Rind | = [ finD |+ _1][o0.000 |
<[ Rin0 | = [ ninD |+ ][ ninD |
@[ w3 | = [ Histogram |
Min: [J use Dariables
( Help ] [view Data][ Doit ][ cancel J|[ ok |
Choose Menu
® Menu:
R Command: | Save As... || abs |
D
) Key press: I:'
)% Key: I:'
 0pen instruction number |1 in task | TakeData
[J Automatically press encountered 0K buttons
[ Help.. ][ Dot ][ cancet || ok |

I nstruments
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CURVE FITTING fitsawaveto a
lorentzian, sin, gaussian, polynomial,
exponential or linear expression.

Curve Fit:
# of terms: D

-Method
Model:| Polynomial |

ab +aly +azuiz + ..

-Results

Transfers

[J] Replace source wave with result

geit | [ Cancel | 4K

[ )

Help

C PROGRAMMERS can create and
debug their own instructions with
SoundScope Open running under Think
C. For more details on this, please
request the SoundScope Open
Programmer's Documentation.

Example of an instruction written by the End User in C

- At execute time:

dotted :
* lI.lrite to journal . rectangle |
* Move marker sec right. [ Check Box 1

] Check Box 2
static tent 1

* Add variable|[ error Jralue towave [ Fo s

point at the markerpusitiun. peace
Button 1
HEND ro popup e ] e ATITER
- ; ritField tonglk: O Radio 1
(Press To Play with Wave | | ¢ it fioid (double){2.000 | O Radio 2
wave popup:[ Fo | | Edit Field (test): [nenot | @ Radio3
0K
Please see 'developer eramples.c' and
‘Examples.rsrc’ files for details on how this is done.

DATAPIPES is used to show a datapipe
folder dialog, create a new folder for
data, or create a new folder and
prompt for a folder name.

Datapipe:

® Show datapipe's Folder Dialog
{7 Create new folder and prompt for folder name
{7y Create new folder with default name, don't prompt

[ Help... ][ Do It ][ Cancel ]

DisK /0 is used to transfer a wave
or journal to or from disk, delete a

file, transfer wave data to a journal, qr
transfer journal data to a wave.

Data Transfer

|[ Fo | to disk
@ Load [ journal ][ Data | from disk

) Delete last saved file

) Save [ wave

) Delete last loaded file

Do It 114
(

[

J{ J

] [ Cancel ]

[ File... ] [options...] Help
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DISPLAYS is used to clear, calculate, _
or redraw a display. Thisisimport Disploy: [_time |
since updating a display takes processffr @ Clear display
time, and therefore should not be dong & Ee e et dom clear
redundantly or tOO Seldom  Clear, Calculate and Redraw E:II displays
which are not current with the latest data
[ Help.. ][ Doit || cancel | ok ||
EXTERI\!AL I N_STRUM ENT is used t¢ Instrument: [ _Keithley 2001 DUM |
communicate with |EEE-488 hardwarle - options
devices without programming at the Function:
488 command level. Speed:
Filter:
Resolution:
Send to:
488 Address:
[ Help ] (Dot ] ( cancel |
FILTER is used to run alow-pass, or
. . Filter: [ F
high-pass FIR filter on a waveform. e
Alternatively, you can provide your Type: [ Low pass (FIR) | (Custom...)
own FIR filter coefficients to FreqCutoff: (% of sample rate)
Impl ement a custom filter. Boundries:
Freq Cutoff: 125.0 Hz Phase: linear
: Stopband: -98 dB Taps: 99
oo ) %)
FUNCTI ON G ENERATOR IS used to MacADIOS fg Function Generator
control the MacADIOS fg function Sot trequency .. _—
generator hardware. This device @
outputs a signal with a programmable]| | ofrset )
waveform shape, frequency, om0/ vottage | | | Moo _betue _J[o-oonouoon_
arnp“tUde, and Off%t Current value: 0.00000 @
-
[options..] [ 8siz | [ Clear | [Cancel | [ 8z ||
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GET TIME obtains immediate time
information for purposes of absolute
time, and duration measurements. Foj
example, one could use thisinstructior
to read the time since the beginning of
the task, twice, accurate to £20us, and
then subtract the two values to produc
a duration measurement accurate to
+20us.

1%

Get Time

Transfer... month to...

+“month
day O wave: | w1 | [ fnptians.. ] @
Year Variable:| _error By
year O [ | [Batsas..] @
minutes = Journal: [ Task80 | (options... ] @
seconds O string:  [_retlalue | [Bptions...] @
pPOLWEr On Secs
apl launch secs
begin task secs [
trigger secs

HYPERCARD XCMD/XFCN is useg
to call HyperCard 1.x XCMD/XFCN
functions. This provides access to
multimedia devices such as tape
recorders and frame grabbers; yet
more exciting are the thousands of
public domain XCMD/XFCN routines,.

|EEE-488 is used to communicate
with |EEE-488 hardware devices via
MacADIOS 488s or MacADIOS 488n
hardware, available from GW

I nstruments.

[ Doit ][ clear ] [cancel || ok |
HyperCard HCMD/HFCN
‘|ﬂTMDUiB "OpenMovie", Direct, fileName, L_Slicel, Fastidle,loop
--Available Objects
[Dlisplays:[_time | ‘6, 386, 435, 459
[JJournals:[_Data | { Segment Segment Segment
Mlarkers:[ M1 | i0.371356
(S)trings:[_message ]
[Uariables:[_error | ‘n.000000
[Waves:[ Fo ] §
HCMD/FCN: [ PostTempo | |
([ Hetp ][ Dont | [ cancer ][ ok
IEEE-488 Command
CLEAR 14 |
OUTPUT 14,C1% TOK
ENTER 14
o]
- Results
[ [ Append onto |journal [ J1 |
€[ Copyinto | string [ retvalue |
[ Read 1 scalar value and
O [ Append |[ ASCII | data into wave|_ W1 ]

(

Help Do It

J

] [ Options...

][ Cancel ][[

0K

)
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JOURNALS & STRINGS isused to
clear, insert text, append, copy, and
search-replace text within a journal or
string.

Journal or String:| Task80

 Insert wave definitions
) Insert today's date
) Insert today's time

1 Clear
@ Clear at beginning of task
) Copy to clipboard

) Copy into: TaskB80 ) Insert trace number
»Append onto:| Task80 () Update all journals

() Remove row number Dl (top row is #1)
) Remove column number |1 (first column is #1)
) Change |\t tol, |

) Insert:

Hello.

[ Help

][ Dot )

[ Cancel ] [ 0K ]

LOG MARKER is used to send the
marker position, or wave value at a
marker position, to journals, waves,
controls, strings, variables, and
markers.

Marker and Wave [_W1___ | Intersection
Transfer... value to...
{r
point# Owave: [ N | (gptians...] (W)
time i . 5
dag time X variable:[ U1 | (options...] @
O Journal: | Task80 | [i%gz‘émmm] @
Ostring: [_retbalue | [sstions...| @
M
-
(oot | [ clear | [cancel || ok

MOVE MARKER is used to move
markers to waveform minimums,
maximums, local minimums
("valleys"), local maximums ("peaks")
upstrokes, downstrokes, specified

points, and specified wave values. This

Instruction supports seamless traces,
subsequently, trace breaks have no
effect (e.g. ten seamless traces would

be viewed as one long trace).

Move Marker: IIl
Mouve to | first downstroke | of wave

5---l]ptiuns

Help
Hysteresis:

oo | o
o | w

Threshold:
Cancel

e

I nstruments
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PROGRAMMING supports common
programming features such as If...Then
Goto, While Loop, Loop N Times,
Define Subroutine, Jump To Subroutine,
Insert Comment, and Insert Label.

Do Every H Traces
Do Every Y Points
Loop

If-Then

While Loop

Add Subroutine
Jump to Subroutine
Add Label

Jump

Add Comment

Select instruction: Add Subroutine

Enter Subroutine Name:
mySubrouting

[ Cancel ] [[ 114 ]]

PULSE ANALYSIS is used to analyze
pulses and send up to 24 characteristics
(e.g. min, max, rise time, fall time, etc.
of each pulse to journals, waves,

controls, strings, variables, and markers.

Pulse Analysis on: El

READ WAVE INTERNALS is used to
extract wave characteristics, such as
sample rate and # of points, and transfey
them to journals, waves, controls,
strings, variables, and markers.

Send to journal:[_Data___| & Log pulse number
t3 tmax minz t4
I atmax i’
max
| {— augZ
w2
-t/ tet -t/ te2
e e
slape2
areal  maxZ
v l £ u\/_/
. — augl
min Y] a2
a3 areaqz
41 t2 t5
-
(elp ) {_concer)
Read Wave Internals:@
Transfer... start time to...
+ start time
sample time Owave: [ W1 | (gptians...| (W)
#ualid pre pts [ variable:[ error | (options...] @
#palid data pts _
pre size [ Journal: [_view | [antions..
data size Ostring: [_retalue | [sptisas...| @
post size
min 1U code [ Control:
ma 10 code O Marker: wme [
min EU value

RS-232 is used to communicate with
RS-232 hardware devices via the
computer's MODEM and PRINTER
ports. These ports support serial
communication at rates up to 57.6K
BAUD viathe Macintosh Seria Port
Driver. Thisinstruction can be used to
send text, receive text, copy areceived
string into a journal, and interpret a
received string.

[(poit | [ clear | [cancel | [ ok ||
R5-232 Command Sequence
ks
=]
- Results
R [Copyinto__journal [ J1____]
O [_Copy into string
[JRead 1 scalar value and
O [ Append |[ ASCII | data into wave[_ w1

[

Do It

J

] [ Options... } [ Cancel ] [[ 0K ]]

Help
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SET WAVE INTERNALS is used to s4
wave characteristics, such as sample
rate and # of points. Thisis done wit
values from journals, waves, controls,
strings, variables, and markers.

Set sample time ...

set Wave Internals:[_INT |

With...

start time
+“sample time

#palid pre pts

#palid data pts

pre size

data size

post size

min U code

max U code

min EU value

4 Read:[_Uariable][ H
Current value: 0.00000

FEEREEE

[ Doit ] [ clear | [cancel ||| 0K

SOUND STATISTICS is used to
calculate the following statistics on a
speech wave: % voiced, % unvoiced, ¢
silent, shimmer, jitter, HNR,
breathiness, Fo average, Fo kurtosis,
Fo skewness, Fo range and Fo std dev

Sound Statistics on:

Transfer... silence to...

voiced
0 unvoiced Owave: [ N | (gztians..] (W)

+ silence & Variable:[ error | [I]ptions...] @
shimmer (AFQ) -
HNR CJJournal: [_view | (gptians...] (4]
breathiness O string: [ retvalue | [zzg;%ézmxm] @
jitter (RAP)
ter contro
{0 kurtosis [ mmrigme; | ¢ time M
f0 skewness ’

[ Help... ] [I]ptions...] [ Do it } [ Clear ] [Cancel ] [[

0K

STATISTICS is used to calculate the
following statistics on awave: avg,
min, max, time of min, time of max,
std dev, rms and area. Results are
easily sent to Journals, Waves,
Variables, Strings, Controls and
Markers.

Statistics un:
Transfer... std dev to...
+fau i
mig | | Owave: [ deriv | (azsians...] (w]
max Variable:| error Bptisng..
H at min - | | [ g - ] @
H at man [ Journal: [_Notes | [gptiens...)
area String: retllalue Options...
Fsting: | | @ations... ()
ol O controt
duration O Marier: | time ™M
sum of points ] ;

[ Doit ] [ clear | [ cancel || oK

-
—

I nstruments
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SYNTHESIZE is used to load a wave
with a constant value, ramp, sine wave
triangle wave, square wave, gaussian
noise (gaussian distribution), or
uniform noise (flat histogram).

Synthesize: |II

Length:

200 points

i Periodic: |92 points/cycle
10.000 code amplitude

‘@ sine () Square () Triangle
O Ramp:  [0.000 | to [5.000 | code
1 Constant: I:l code

r Guassian: code rms noise
CrUniform: | 10.000 code random noise ()

[ Help ] [ Do It ] [ Cancel ]

TRANSCENDENTAL isused to
calculate a transcendental function (e..
sin, cos, abs, In) on one object, and
transfers the result into another object
A marker's value is derived from it's
position; a control's value is derived

from it's setting; a string or journal's
value is derived from it's text; and a

Scalar Transcendental

wave's scalar value is derived from one

point.

TURBODRIVERS is used to control
MacADIOS Nubus and SCSI data
acquisition hardware. For details on
these A/D and D/A products, please
request the GW Instruments Data
Acquisition catal og.

w— | Cos
I
fpibans...
0.00000 Dolts 0.01000
[ Help.. |[ Doit [ cancet || ok ||
TurboDrivers™ Library

Select function: Enter parameters:
CkControl Waves
CkSetup
Cread Points: 20:[_Uoiced | 4 ¢ |
Cwrite I| time | 5:[ ¢ ]
Digitize
Fastio Bank: |0 AR | 6:] ¢ |
FqControl i
FqSetup Period: |20 EH IR | 7:[ < |
PdControl 9
[ Device... ] [ Help... ] [ Do It ] [ Cancel ] [[ 0K ]]
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WAVEFORM GENERATOR is used tg
continuously output a waveform in the
background, while the computer
operates normally in the foreground.
Once the interrupt process is installed
it runs smoothly until finished, even
during file 1/O or switching to anothet

Interrupt-Driven Waveform Generator

Continuously output wave @tu board port

application.

USER INTERFACE is used to monitof

the X-Y position of the mouse, the
status of the mouse button (up or
down) and the status of the keyboard

(i.e. the last keypress). Results are sent

to journals, waves, variables, strings,
markers, and controls.

Number of points: l:ommand:
Number of passes: 0 = Install
1 = Deinstall
Time between points: bs 2 = Deinstall All
[ Help } [ Device... ] [ Do It ] [ Cancel ][[ oK ]]
User Interface
Transfer... mouse H to...
<5
mouse ¥ 1 wave: | w1 | [i%gz‘émmm] @
mouse status Variable:[ D2 opti
| Yoy press [ bariable:| | (options ]@
ClJournal: [ Data | (gptians...] @
[ String: | retlalue | [é}g;%éz)zzsm] @
L[ | Oarkee: |
-
[ poit ] [ clear | [ cancel || ok |

USER PROMPT is used to show a

custom alert, with an optional responsg Message

field and an optional Cancel button.
For example, the instruction to the
right results in the alert pictured
below.

Do you cook with gas?

User Prompt

Do you cook with gas?

] Response:

Right Button:
& Left Button:[Nope |

Dariable "error" is loaded with 1 if Right button is pressed; 2
otherwise. String "retUalue” is loaded with response text.

] [ [ Cancel ][[

Mo, | cook electric.

[ Help Doit | 0K

)

|Nu, | cook electric. |

) )

[ Nope Yep

I nstruments
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FUNCTIONS

The Calculate Wave instruction allows one to define waves in terms of other waves
(e.g. "W1 = deriv(W2)"). From within the Calculate Wave dialog, one can use any
of 12 operators and any of over 65 functions (e.g. FFT, cos, signal average), as
summarized in the table below.

Waves of type 16-bit integer and 32-bit floating point can be intermixed within a
function (e.g. "intl6Wave = Abs(flt32Wave)"). Integer waves are always analyzed
with respect to their engineering units. For example; if wave Result and Source are
both 16-bit integer waves with £10 Volts mapped to £32,768 (e.g. 5V corresponds
to 16384 internaly, etc.), Source is loaded with 1.0V (3,277 internally) and one does
"Result = cos(Source)"”, then Result would be loaded with 0.54 (1770 internally).
The neat thing about integer waves is that the user, the displays and the tasks only see
Engineering Units (e.g. Volts); subsequently, one does not need to keep track of the
internal values. Digitized data (e.g. from an analog-to-digital or digital-to-analog
converter) is aways contained in 16-bit integer waves, since thisis the native format
for I/O hardware. To see internal data, choose Edit Vaues under Wave and then
select Internal.
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Function Description Example
+ add W1=W2+ W3
- subtract W1l=W2-W3
* multiply W1l=WwW2* W3
/ divide W1l=W2/W3
AND bitwise AND W1l=W2& W3
OR bitwise OR W1=W2|W3
< 1if less then; O otherwise W1=W2<W3
> 1 if greater then; O otherwise W1l=W2>W3
< 1if < or equal; O otherwise W1=W2<W3
> 1if > or equal; O otherwise W1l=W2=>W3
== 1 if equal; O otherwise W1=W2==W3
I= 1 if not equal; O otherwise W1=W2==W3
Abs absolute value W1 = Abs(W2),
Alarm beep if value is out of bounds W1 = Alarm(W2, 5, 0)
Append append one wave to another W1 = Append(W2, W3)
Arccos inverse cosine W1 = Arccos(W2)
Arcsin inverse sine W1 = Arcsin(W2)
Arctan inverse tangent W1 = Arctan(W2)
AutoCorrelation |autocorrelation W1 = AutoC(W2)
AvgToDate average value to date W1 = AvgToD(W2)
Blackman generate a Blackman window W1 = Blackman(256)
Compress decrease sample rate W1 = Compress(W2, 2)
Convolve convolution W1 = Convolve(W2, W3)
CopyTiming copy sample period & start time | W1 = CopyTiming(W2)
Cos cosine W1 = Cos(W2)
CrossCorrelation | cross correlation W1 = CrossC(W2, W3)
CrossPower Cross power W1 = CrossP(W2, W3)

DeConvolution
Delete

de-convolution
delete a waveform segment

W1 = DeConv(W2, W3)
W1 = Delete(W2, 50, 100)

Deriv derivative W1 = Deriv(W2)
DerivFivePt 5 pt. Lagrange derivative W1 = DerivFivePt(W2)
Exp exponential W1 = Exp(W2)

Expand increase sample rate W1 = Expand(W2, 2)
FFT fast Fourier transform, reals W1 = FFT(W2, 256)
Hamm generate a Hamming window W1 = Hamm(256)

Hann generate a Hanning window W1 = Hann(256)

Histo histogram W1 = Histo(W2, 0, 50,10)
IR IR filter W1 =1IR(W2, W3, W3)
Imag convert complex imaginary W1 = Imag(W2)
IndexSort sort given indices W1 = IndexSort(W2, W3)
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Function Description Example
I nsert insert a segment into a wave W1 = Insert(W2, W3, 50)
Int convert to closest integer W1 = Int(W2)
Integ integrate W1 = Integ(W2)
IntegAV integrate, reset when area= A [W1 = IntegAV (W2, 10)
IntegPT integrate, reset whentime=T |W1 = IntegPT(W2, 0.1)
IntegTL integrate, reset at list of times W1 = IntegTL (W2, W3)
IntegTV integrate, reset when wave >V | W1 = IntegTV (W2, 5)
InvFFT inverse fast Fourier transform | W1 = InvFFT(W2, 256)
Kaiser generate a Kaiser window W1 = Kaiser(W2, 256)
Last return data from last trace W1 = Last(W2)
Limit apply high & low bounds W1 =Limit(W2, 5, 0)
Ln natural logarithm W1 =Ln(W2)
Logl0 logarithm with base 10 W1 = Logl0(W2)
Mag convert complex to magnitudes |W1 = Mag(W2)
MakeComplex return complex given real W1 = MakeC(W2)
Makelndex return indices for a sort W1 = Makel (W2)
Maximum maximum value W1 = Maximum (W2)
MaxToDate maximum value to date W1 = MaxToDate(\W?2)
Minimum minimum value W1 = Minimum (W2)
MinToDate minimum value to date W1 = MinToDate(W2)
Mod modulo W1 =Mod(W2)
MVFFT return magnitude FFT W1 = MVFFT (W2, 256)
OnOff on/off feedback control loop W1 = OnOff(W2, 5, 0)
Peak find peaks W1 = Peak(W2, 2.5)
PID PID feedback loop W1 =PID (W2, W3, 1...
PulseEndTimes | return list of pulse end times W1 = PulseEndTimes(W..
PulseMaxTimes | return list of pulse max times W1 = PulseMaxTimes(W..
PulseStartTimes | return list of pulse start times W1 = PulseStartTimes(W..
Phase return phase given complex W1 = Phase(W2)
Red return real given complex W1 = Rea(W2)
Reverse reverse the order of elements W1 = Reverse(W2)
Reciprocal return reciprocal of source W1 = Reciprocal (W2)
Shift shift wave horizontally W1 = Shift(Ww2, 50)
SignalAvg determine waveform average W1 = SignalAvg(W2)
Silent determine silent region W1 = Silent(W2)
Sn sne W1 =Sin(W2)
Smooth smooth waveform by n points W1 = Smooth(W2, 12)
Sort sort wave elements W1 = Sort(W2)
Spectrum calculate frequency spectrum W1 = Spectrum(W2, 256)
grt square root W1 = Sgrt(W?2)
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Function Description Example
Tan tangent W1 =Tan(W2)
TC find °C given thermocouple V W1=TC(W2, 1)
TimeHisto time histogram W1 = TimeH(W2, 2, 100)
TimeValues returns values given times W1 = TimeV (W2, W3)
UnVoiced determine unvoiced region W1 = UnVoiced(W2)
Voiced determine voiced region W1 = Voiced(W2, W3)
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ReEcorD EMG, EEG, PRESSURES,

AND SOUND SIMULTANEOUSLY

With Nubus and SCSI based data acquisition products from GW Instruments, one can
digitize up to 112 channels (e.g. pressure, EMG, EGG, sound, etc.) at sample rates
as high as 833K samples/second. SoundScope supports the hardware deviceslisted in
the table below. For details on these products, please contact GW Instruments and
request The Macintosh Data Acquisition Catal og.

Device Description

MacADIOS 1| Nubus board with sixteen (expandable to 112) 12-bit analpg
Inputs, two 12-bit analog outputs, 8 digital 1/0 and a
counter/timer.

MacADIOS 11/16 Nubus board with eight (expandable to 56) 16-bit analog
inputs, two 12-bit analog outputs, 8 digital 1/0 and a
counter timer.

MacADIOS I Jr Nubus board with sixteen 12-bit analog inputs, two 12-bit
analog outputs, 8 digital 1/O and a counter timer.

MacADIOS 8ain SCSI peripheral with eight 12-bit analog inputs.

MacADIOS adio SCSlI peripheral with two 12-bit analog inputs, 1 12-bit
analog output, and several digital 1/0.

MacADIOS 8dio SCSI peripheral with eight digital I/O.

MacADIOSfg SCSI peripheral that outputs a signal with a programmablle

frequency, amplitude, and waveform shape (triangle,
square or sine).
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QUICKTIME

SoundScope supports the playing and plotting of QuickTime movies viathe
QTMovieg() XCMD, which isincluded with SoundScope. SoundScope only supports
"Direct" QuickTime features; for the more extensive "XWindow" based features, we
recommend a dedicated QuickTime applications such as MediaGrabber or
MediaTools.

GLOTTAL VIDEO

We are very excited about several emerging technologies that facilitate the
digitization, viewing, editing and storing of QuickTime movies (i.e. computer
videos). With the MediaTime Nubus board from RasterOps, one can view live video
on the computer screen from a cameraor VCR. And at any time, one can record to

disk live video and 2 channels of 16-bit audio. Once on disk, you can easily view,
edit, compare, and save using one of the many QuickTime applications programs
such as Adobe Premiere™. SoundScope/16 fully supports the MediaTime board's
record and play features (i.e. the SoundScope/16 software thinks the MediaTime
board is a SoundScope/16 16bit Digitizer board). For details on the MediaTime
board and QuickTime software, contact:

Raster Ops Corp.
2500 Walsh Ave.

Santa Clara, CA 95051
800/729-2656 (tel.)
408/562-4065 (fax)

Adobe Systems, Inc.
1585 Charleston Rd.
Mountain View, CA 94043
800/833-6687 (sales)
415/961-4400 (tel.)
415/961-3769 (fax)

DiVA Corporation

222 Third St., Suite 1320
Cambridge, MA 02142
800/FY1-DIVA (394-3482)
617/491-4147 (tel.)
617/491-2010 (fax)

MediaTime™ Nubus Board
o 24-Bit video circuit

» real-time frame grabber
» 2 channels 16-bit record
» 2 channels 16-bit play
$2000 list price

Premiere™
* QuickTime Processing Software
o $495 list price

Photoshop™
* Image Processing Software

$895 list price

VideoShop™
e QuickTime Processing Software

o $595 list price
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Chapter 5
| nstruments

This chapter describes several software instruments that are included with
SoundScope. A SoundScope instrument consists of waves, markers, displays,
journals, datapipes, and tasks that have been assembled like building blocks to
create a software environment that is appropriate for specific work. You can use
these instruments as is, customize them to your specific needs, or build new
Instruments from scratch. More instruments may have been added to the disk
since this chapter was printed. Most object names are consistent across
instruments, so the extra ones should be easy to under stand.

I nstruments 5-1



USING AN INSTRUMENT

To begin using an instrument, either double-click itsicon from the Finder, or launch

SoundScope and then use Open Instrument from the File menu. It is usually a good
idea to verify the hardware setup, and save the instrument under a different name.

For example:

» From the Finder, double-click on the "2 Channel Analyzer" filein the

I nstruments folder.

» Select Setup from the Sound menu. Under the title Hardware, make sure all four

pop-up menus (Rec A, Rec B, Play A, Play B) show the name of your hardware
(e.g. 16-Bit Digitizer), and the correct slot or port if applicable.

* Pressthe Rec A button and speak into the microphone for two seconds. Then

press Play A. If you could clearly hear the sound that you recorded, simply click

the OK button to exit the dialog box. If not, verify that your hardware is
correctly installed. (See Chapter 1, Installation.)

» Select Save As from the File menu.
Move up one level to the "SoundScopse
Application” folder, as shown in the
ilustration.

Change the filename to "my 2 Channdl"
and click the Save button.

Y ou may want to repeat a similar
procedure each time you open a new
instrument for the first time.

cott's HD

<5 Instruments f
] == SoundScope Application .

% |=Scott's HD

% | Desktop psktop

O Finanng! Bnaiygser ey
0 7 fhanaei fdiay
o481 »uitints _
£ »48L Spodirpgram Cancel

D oeEL Specirum Getty [0 ((Fermat. )

File name: Folder:

| Channel Analyzer | Instrumel
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OBJECT NAMING CONVENTIONS

Nearly all SoundScope instruments from GW Instruments follow a single naming
convention. This consistency makes it easy to use the instrument most appropriate to
a specific task, without having to relearn the basics for each. It also allows tasks to
be created on one instrument and used in any instrument that contains similar
objects. These names strike a balance between simplicity and flexibility. Y ou may
alter any object name, or use any names when creating your own instrument.
However, doing so will make it more difficult to exchange tasks and instruments
with colleagues.

WAVES

Soundwaves are named with letters of the alphabet, to match the names for
SoundScope's two record/play channels. Waves which store the result of a
calculation specified in a display are named with the display type, abbreviated to 4
characters (Calc, Snap). If the instrument includes more than one, each subsequent
wave is numbered (e.g. Calc2, Snap2). Formants are a special case of aresult wave.
For the first (or only) soundwave, the Formants are labelled F1, F2 ... F5. For
additional soundwaves, the formants are prefixed by the associated Calc wave (e.g.
Calc2 F1).

SEGMENTS
Segment names are simply the wave name, plus"S" followed by the segment number
(eg. A_S1).

DISPLAYS

Displays are named for their type, followed by "D" to distinguish the display from
the result wave that certain display types produce. The Wave Plot display can store
a family of types, including time (Time_D), frequency (Freq_D), and other data
(Plot_D).

MARKERS

Marker names reflect the wave with which they are associated. For soundwaves, the
marker number is simply appended to the wave name (e.g. A1). For other waves,
the letter "M" and the marker number are appended to the wave name (e.g.
Snap_M1).

JOURNALS

Journal names are simple, as there is less need to convey specific information
about the type or contents. Journals are named "Notes’, followed by the number
if there is more than one. Journals that contain instrument documentation are
named "ReadMe". The contents of the ReadMe file is copied to the clipboard,
along with other things, when the user presses Option Shift ‘A’
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SOUNDSCOPE INSTRUMENTS

Each instrument is documented in the following pages.
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Chapter 6
Front Panel

This chapter provides a detailed description of all Front Panel features that are
relevant to instrument users, who interact with SoundScope using pre-defined
software instruments. You may use the standard instruments provided by GW
Instruments, or custom instruments created by a colleague. The SoundScope &
SuperScope |1 Reference Manual describes customization features for instrument
designers.

There are three different kinds of displays. A wave plot display shows a plot of a
sound waveform. It allows you to scroll through the wave and change the scale. An
analysis display shows the result of a sound analysis calculation, such as a
spectrogram, Fo plot or energy envelope. Finally, a snapshot display shows
information on a small portion of a wave (e.g. 20 msec) centered about a marker. A
commonly used option in the snapshot display is FFT (power spectrum). Both
analysis and snapshot displays have controls on the right-hand side for setting
various options.

1 Channel Analyzer
0370 A0, 264
m -

I L Gwl
[ J[i72=. 780038, 352

Spe

105

H
asoe ® =]l Snapshot
s000 ] al Display
4000 -
. | — o
3500
. T T T o Set]
Analysis N O —Te—
Display ~ |- o ] (]
Journal
og]
Wave Plot
Display —f—

Three Display Types
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WAVE PLOT DISPLAYS

A wave plot display shows a plot of a sound waveform. An instrument designer can
select specific features and controls, so not al wave plot displays look exactly

like the one shown above. If the duration of the wave exceeds the time range of the
display, you can scroll the display back and forth to see different parts of the wave.
As with any Macintosh application, you can drag the square scroll box to a new
position, click within the gray area on either side of the box, or click on the left and
right scroll arrows.

To see more of awave, or
expand the view for a : N :
small portion, click onthe - @ WIIE" & Al o 5 o T
horizontal and vertical 2 '» S0 edo 70 obo_of

scale arrows. Much

10001100 msec
Je]4] 100 meec/miv Jit

like an oscilloscope, the  Tett ™, | right” > Timescale 7
scaleissetintermsof  Scrol oy scroll scroll Arrows
Arrow ar Arrow

units per division. The
horizontal axis of awave plot display is usualy time, typically in units of msec/div
(milliseconds per division). Each division is approximately 1 cm wide, and is
labelled with the time. The total time shown in the display is simply the time per
division multiplied by the number of divisionsin the display. On a standard
Macintosh Il screen, for example, a wave plot display the full width of the screen
contains about 18 divisions. At 100 msec per division, the total time displayed is
1800 msec (1.8 sec), as shown in the screen shot.

The vertical scale is wave amplitude, measured in volts/div. Digitized waves span
from -10 volts to +10 volts. (Note that many instruments omit the vertical scale
arrows.)

6 -2 SoundScope User's Manual



ANALYSIS DISPLAYS

An analysis display shows the result of a sound analysis calculation. There are five
controls on the right-hand side of the display, the analysis option pop-up menu,
source wave pop-up menu, Calc button, Log button, and Setup button. The display
takes the source wave (or segment of awave) as input, computes the specified
analysis option, produces aresult wave and displays that wave. The Calc button
recalculates the specified analysis. Pressing the Command and period keys
simultaneously ( [_)halts most calculations. The Log button performs actions such
as logging datato ajournal, or executing atask. The Setup button lets you alter the
parameters of each analysis option, and select the events invoked by the Log button.

Each analysis option and its associated |~ Spectrogram
LPC History

parameters is described in the following| s sice

pages. Although the analysis for awhole 9 pectrum

wave or segment is displayed, most Jitter
Shimmer

calculations are performed one frame at |a,u,

time, on a sequence of frames spanning Eﬂﬂf;':."e

the source wave. (Recall that aframe is|azero crossing

!l Analysis Options

Source Wave

Calc Button
small interval of awave, with aframe | }pf%e .
length typically on the order of 10 to 50
ms.) Consecutive frames, separated by an|~a Log Button
amount of time referred to asthe frame | 73!
advance, are used to build the result wave Setup Button

from left to right. Since the frame length
typically exceeds the frame advance,
successive frames will overlap. Reducing the frame advance increases the overlap,
thus increasing the resolution. For further technical information, see Appendix A,
Sound Analysis Computations.
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SPECTROGRAM

A Spectrogram shows the
frequency components of a
soundwave, with the relative
intensity (indicated by
darkness or color) at each
frequency (vertical axis)
plotted as a function of time

Spectrogram Setup

-Analysis
FFT Points: | 256

Filter: [ 300 Hz (5ms) |

Darkness:| Medium |Max: 47 dB  Min: 20 dB

Display range: ||tu |5.l]l]l] |kH2

(horizontal axis). Frame advrance: ms (0.1...50)
(£ Use 6 dB pre-emphasis
%7 The EET pOiI’TtS ] After calculating, run task: E

55| pop-up, a the left,| rLog

256 sets the number of CRun task: [ ¢ |

¢512 i
T ?haéaFﬁ):O_II_ntzllézer?tﬁg [ Help... ] [ Color... ] [I]ptiuns...] [ Cancel ]

2048
4096

?;§§4 The Filter pop-up, illustrated to the right, selects the ‘5'3 :Z gg"‘s;
filter bandwidth. This selection imposes a lower limit |, sg nz (10ms)

on the possible number of FFT points (i.e. smaller bandwidths 184 Hz (8ms)

require more FFT points), so some of the point values may be 300 Kz (5ms)
grayed out. If you select afilter bandwidth that cannot be Nz tzms)

computed with the specified number of FFT points, SoundScope
automatically chooses the minimum number of points and updates that pop-up. Note
that a 59 Hz filter corresponds to narrowband analysis and 184 Hz to wideband
anaysis.

The Darkness pop-up controls the appearance of the spectrogram by changing the
range of intensity values that are plotted. Four options are available: three pre-set
levels (Dark, Medium and Light) and a Custom setting for specifying the exact Max
and Min thresholds. Energy levels in the spectrogram range from O through 16000.
Energies greater than or equal to the Max value are represented by the Max color
(which is black in a gray-scale spectrogram); energies less than or equal to the Min
value are represented by the Min color (which is white in a gray-scale spectrogram).
Everything between the minimum and maximum energy levels appears as an
intermediate color or shade of gray between the Min and Max colors.

The “optimal” setting depends on the nature of the data, type of analysis being
performed, and personal preference. A narrow range in energy levels yields a dark,
high contrast plot. However, if the range is so narrow that most of the energy
values fall either above or below the thresholds, the spectrogram is not very
informative.
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The Display range specifies the lower and upper frequency display limits of the

spectrogram (but does not affect the calculation). The Frame advance specifies
the distance that the frame is shifted right between consecutive FFT calculations.

If theUse 6 dB pre-emphasis option is checked, the high frequencies of the
source wave are emphasized by 6 dB per octave before processing. Enabling the
After calculating, run task checkbox and choosing a task from the associated pop-up
menu will run that task after each calculation.

The only Log option is Run task, which will run the specified task each time you
click on the L og button that appears with the other display controls.

Note that spectrogram analysis ordinarily produces no result wave, since the result
of the analysis is a two-dimensional image rather than a one-dimensional graph.

SPECTROGRAM OPTIONS
The Options button in the Spectrogram
Setup dialog box allows you to add

Spectrogram Options

formant-tracking data to the plot. Calculate
Formants are tracked using the LPC %f"f'}"“grﬂ? Ei:ﬂ formant

. 5 orman orman
methOd’ based on Fhe parameters setin ] 2nd formant [J]5th formant
the LPC History dialog. The Calculate ||
check boxes (Spectrogram, 1st formant)| [ Help... | [ cancel |

2nd formant, etc.) allow you to specify
which values to plot. Some formant options may be grayed out if there are not
enough result waves in the display to hold the formant calculation results. (If
necessary, create additional waves viathe New command in the Wave menu. Then
add the waves to the display list via the Options command in the Display menu,
starting with F1 in the second dlot, F2 in the third, etc. See Chapter 2, Tutorial and
the appropriate sections of the SoundScope & SuperScope Il Reference Manual for
more information.)
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SPECTROGRAM COLOR

The Color button in the Spectrogram Setupy
dialog box alows you to change the colors
(or shades of gray) associated with the Max
and Min thresholds. The Screen pop-up

menu selects between Color and Gray (i.e.
gray-scale) spectrograms. This setting take
effect the next time the Calc button is

Spectrogram Color

~Display

é Screen:| Gra é

| [Pike)| I )
S

clicked. The range of colors plotted in the spectrogram is displayed as a spectrum

between the Picker buttons, ranging from the Min color on the left to the Max color

on theright. If Gray is selected in the Screen pop-up, the range consists of all the

available levels of gray (typically 4, 16 or 256 shades, depending on the monitor and

the setting in the Monitors Control Panel). Selecting Color enables the Picker
buttons for altering the Min and Max colors with Apple's standard color picker.
The Color option is only available on color monitors, and only works when the
monitor is set to operate in color mode, as specified in the Monitors dialog box in
the Control Panels under the Apple ([J) menu.

To select a new color,
click on the desired shade)

directly in the color whesg|.

The upper half of the col¢
sample box indicates your
new selection, the bottom
half your previous
selection. You can make
the color brighter or
darker by scrolling the

brightness scroll bar to thg

right of the color wheel.
Y ou can also directly edit
the HSB or RGB values.

Hue
Saturation
Brightness

Red
Green
Blue

3 (€% (€3] E9)(€3) ([E 5y
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L PC HISTORY

LPC (Linear Predictive Coding)
History shows the estimated voca] . apalysis

tract transfer function over time LPC coefficients: (0...257) [<] Default

LPC History Setup

;I;Egsdt?'l[:tlrsegl’sene? ?;r\é]e;ﬂ&al Frame length: ms (5...30)
showi ng the peaks and bandwidthl Frame advrance: ms (1...30)

of the LPC at each frame. One FFT Points: (Hz resolution)
can thiﬂk Of the LPC History asan Display range: |I].I]I]I] | to |5 |kHz

aternative view of the same (] 6 dB pre-emphasis
information contained in a ] After calculating, run task: E
spectrogram. Log

[J Bun task: |I|

Note that spectrogram analysis
ordinarily produces no result ((Help.. | [options...] [ Cancel |
wave, since the result of the
analysisis atwo-dimensional
image rather than a one-dimensional graph.

The LPC coefficients textbox lets you adjust the number of coefficients used in
the calculation. Increasing the value helps to resolve formant peaks that are of
similar frequency, but can also introduce extraneous peaks. Clicking the Default
checkbox sets the value that is appropriate for the current sample rate. The Frame
length textbox sets the size of the frame on which LPC coefficients are based, and
the Frame advance textbox sets the distance the frame moves between
consecutive calculations. The FFT points pop-up sets the number of data points
used by one step in the LPC algorithm. A higher value will help to resolve peaks, at
the expense of computation time. The Display range specifies the lower and
upper frequency display limits of the LPC History (but does not affect the
calculation).

If theUse 6 dB pre-emphasis option is checked, the high frequencies of the
source wave are emphasized by 6 dB per octave before processing. Enabling the
After calculating, run task checkbox and choosing a task from the associated pop-up
menu will run that task after each calculation.

The only Log option is Run task, which will run the specified task each time you
click on the L og button that appears with the other display controls.
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LPC OPTIONS

The Options button in the LPC History
Setup dialog allows you to add formant- Calculate:
tracking datato the plot. The Calculate 5 LPC m'mru [] 3rd formant
check boxes (LPC history, 1st formant, 2nfl ] 1st formant ] 4th formant
formant, etc.) allow you to specify which || | C2nd formant [ 5th formant
values to plot. Some formant options may|| :
be grayed out if there are not enough resul

waves in the display to hold the formant (_Heip... ] [ Cancel |
calculation results. (If necessary, create
additional waves viathe New command in the Wave menu. Then add the waves to
the display list viathe Options command in the Display menu, starting with F1 in the
second slot, F2 in the third, etc. See Chapter 2, Tutorial and the appropriate sections
of the SoundScope & SuperScope Il Reference Manual for more information.)

LPC History Options
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HS SLICE

HS (Horizontal Spectral) Slice
takes a specific frequency of the

HS Slice Setup
~Analysis

sc)tundy¥aYe erd(dlfjpé?ys the FFT Points: | 5912 Filter: | 45 Hz (33ms) |
ntens ev In asa )

functiog of time. The name Horizontal frequency: Hz

derives from Viewing this Frame advance: Elms (1...50)

computation as a horizontal [ Use 6 dB pre-emphasis

"dlice" across a spectrogram at g [J After calculating, run task:[__ o |
single frequency value (actually g

‘e . ~Log
specified bandwidth around that 0 :
frequency). Thisanalysisisthe fon task:[_2_|
only one that focuses on asingle
frequency.
o The FFT points pop-up, illustrated to the left, sets the number of data

&4

128 points used by the FFT algorithm.
256
The Filter pop-up, illustrated to the right, selectsthe [ 45 Hz (33ms)

s0s | filter bandwidth. This selection imposes alower limit |, 3oy s siome)
4096 on the possible number of FFT points (i.e. smaller 184 Hz (8ms)

8192 bandwidths require more FFT points), so some of the | 300 Hz (5ms)
16384 | point values may be grayed out. If you select afilter | g0 bz (5:2ms)
bandwidth that cannot be computed with the specified number of
FFT points, SoundScope automatically chooses the minimum number of points and
updates that pop-up. Note that a 59 Hz filter corresponds to narrowband analysis

and 184 Hz to wideband analysis.

TheHorizontal frequency textbox specifies the single frequency of interest (the
value at which the "dlice” occurs). The Frame advance textbox sets the distance the
frame moves between consecutive calculations.

If theUse 6 dB pre-emphasis option is checked, the high frequencies of the
source wave are emphasized by 6 dB per octave before processing. Enabling the
After calculating, run task checkbox and choosing a task from the associated pop-up
menu will run that task after each calculation.

The only Log option is Run task, which will run the specified task each time you
click on the L og button that appears with the other display controls.
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AVERAGE SPECTRUM

The Average Spectrum showﬁ
the frequency distribution fo| ..analysis

the entire wave or segment, FFT Points:[ 256 Smoothing:
with intensity (in dB) on the Filter:[ 300 Wz (5ms) |

vertical axis and frequency o .

. . . Displ : to (4 kH
the horizontal axis. It is ofte isplay ronge: [N | iz
referred to as a power Frame advance: EI ms (5...30]
spectrum. Thisanalysisisthg | [lUse 6 dB pre-emphasis

0n|y onein this pop-up menu (] After calculating, run task:zl
that does not have time on th

Average Spectrum

——

14

-Lo
horizontal axis. [lgSEnd up to Elpeaks to juurnal:
[JTransfer spectrum to: folder
25; The FFT points CIRun task:[__o |
128 pop-up, illustrate tp
256 the left, setsthe

number of data

1024 . )
2048 points used by the FFT algorithm.

4096

?;§§4 The Filter pop-up, illustrated to the right, selects the ‘5'3 :Z gg"‘s;
filter bandwidth. This selection imposes alower limit |, }sg nz (10ms)

on the possible number of FFT points (i.e. smaller bandwidths 184 Hz (8ms)

require more FFT points), so some of the point values may be 300 Kz (5ms)
grayed out. If you select afilter bandwidth that cannot be Nz tzms)

computed with the specified number of FFT points, SoundScope
automatically chooses the minimum number of points and updates that pop-up. Note
that a 59 Hz filter corresponds to narrowband analysis and 184 Hz to wideband
anaysis.

+ None The Smoothing pop-up, illustrated to the left, allows you to select
Low the degree of smoothing to apply to the FFT. For example,
Medium | smoothing plots that contain many jagged peaks will make broad
High trends more visible. The Display range specifies the lower and

upper frequency limits to display. (This range affects only the

display, not the actual calculation.) The Frame advance textbox sets the distance
the frame moves between consecutive calculations.

If theUse 6 dB pre-emphasis option is checked, the high frequencies of the
source wave are emphasized by 6 dB per octave before processing. Enabling the
After calculating, run task checkbox and choosing a task from the associated pop-up
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menu will run that task after each calculation.

Any Log options that are checked will be executed each time you click on the L og
button that appears with the other controls. The Transfer up to X peaks to journal
option finds the first X peaks and sends their frequency and intensity values to the
designated journal. The Transfer spectrum to folder option stores the calculation
result in the folder designated by the specified datapipe. Finally, the Run task option
will run the specified task.
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FUNDAMENTAL FREQUENCY
The fundamental frequency (Fo)

Fo Plot Setup

corresponds to the rate of vocal -Analysis

cord vibration. An Fo plot is alsg Method: ® Peak-Picking

knqwn asa pItCh pl ot. It dlsplays T Autocorrelation [J§asipy
estimated glottal f_requen_cy (in Display range: (| to [190 |nz
Hertz) on the vertical axis and : :

time on the horizontal axis. Notd| | CAfter calculating, run task: [_< ]
that unvoiced portions of a -Log

soundwave and other portions that O] Transfer average f0 to journal:
have no discernable fundamental [ send period peaks to journal:

frequency appear as gaps in the Fp [ Transfer f0 wave to: folder
pI ot. [ Run task:lII

Method specifies the type of pitch| [(_Hete-. ] [Options...] [_Cancel |]

tracker, either Peak-Picking or
Autocorrelation. With thelatter, the Faster checkbox speeds up the calculation
(and reduces the accuracy). Peak-picking is generally more reliable over a wider
pitch range than autocorrelation. The Display range specifies the lower and
upper frequency limits to show on the screen, but has no affect on the actual
calculation (see Options, below).

Enabling the After calculating, run task checkbox and choosing atask from
the associated pop-up menu will run that task after each calculation.

Any Log options that are checked will be executed each time you click on the Log
button that appears with the other controls. The Transfer average Fo to journal
option computes the average and sends it to the designated journal. The Send period
peaks to journal option sends the raw peak data to the designated journal. The
Transfer Fo wave to folder option stores the calculation result in the folder
designated by the specified datapipe. Finally, the Run task option will run the
specified task.
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To change other .
Slgnlflcant parameters Of - Global Analysis Options

. . -Pitch Track
the FO Cal CUIatlon’ CII(;k Acceptable pitch periods: ® 120 to 280Hz (typical female)
the Options button (this () 80 to 150Hz (typical male)
dialog can also be acc O [55 |to [250 |Hz
by pr ng Optlon I' Frame advance ms (time between result points)
(IOWQr-Case L)) Reject all peaks witha> % variation in adjacent pitch periods
Acceptable pitch

periods setsthe bounds
of fundamental frequencies for the pitch tracking algorithm to seek. The Female
and Male radio buttons give suggested pitch ranges for adults. Y ou may also specify
your own exact pitch range. This setting has a dramatic effect on the accuracy of the
Fo calculation, and all calculations that depend on Fo (Jitter, Shimmer, HNR & many
Statistics).

The Frame advance textbox sets the distance the frame moves between
consecutive calculations. Reject all peaks with a > X% variation in

adjacent pitch periods specifies the maximum increase or decrease over the
previous pitch period allowed in the search for the next consecutive pitch period.
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JITTER

Jitter is a measure of the pitch
perturbation of the fundamental

ditter Setup

. -Analysis
U;?I%;n%{glgv;;hd%er':ee?)tnot?lethe (] After calculating, run task: E
horizontal axis. -Log

[JTransfer RAP jitter to journal:
Enabling the After Calculatingl, O Transfer jitter wave to: folder
run task checkbox and choosing CRun task:[__¢ |

atask from the associated pop-u
menu will run that task aftFe)r %ac% (_Hetp... ][ Options... |[_Cancel |
calculation. Any Log options that
are checked will be executed each time you click on the L og button that appears
with the other controls. The Transfer RAP jitter to journal option computes the
average and sends it to the designated journal. The Transfer jitter wave to folder
option stores the calculation result in the folder designated by the specified datapipe.
Finally, the Run task option will run the specified task.

Global Analysis Options

The significant l
parameters of jitt

are the same as foy| FPitch Track
the Fo calculation Acceptable pitch periods: @ 120 to 280Hz (typical female)

0 Opti ons leads td ) 80 to 150Hz (typical male)

the same dialog O[s5 [to [250 |hz

(thiS d|alog can alsu) Frame advance ms (time between result points)

be accessed by Reject all peaks with a > ‘3-?: variation in ad jacent pitch periods
pressing Option 'I'

(lower-case L)). I“

IS generally easier
to adjust the parameters to obtain a satisfactory Fo, and not make further changes
here.

Acceptable pitch periods setsthe bounds of fundamental frequencies for the
pitch tracking algorithm to seek. The Female and Male radio buttons give suggested
pitch ranges for adults. You may also specify your own exact pitch range.

The Frame advance textbox sets the distance the frame moves between
consecutive calculations. Reject all peaks with a > X% variation in

adjacent pitch periods specifies the maximum increase or decrease over the
previous pitch period allowed in the search for the next consecutive pitch period.
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SHIMMER

Shimmer is a measure of the
amplitude perturbation of the | na1ysis
fundamental frequency, with . _
. . . ’ . LI Aft Iculating, task:
intensity (in dB) on the vertical er calculating, run task: [_c_]
axis and time on the horizontal || .-Log

Shimmer Setup

axis. [ITransfer APO shimmer to juurnal:
[JTransfer shimmer wave tu: folder
After calculating, run CJRun task: [ ¢ |

task checkbox and choosing & i
task from the associated pop'UFﬂ [ Help... ] [ Options... ] [ Cancel ]
menu will run that task after
each calculation. Any Log options that are checked will be executed each time you
click on the L og button that appears with the other controls. The Transfer APQ
shimmer to journal option computes the average and sends it to the designated
journal. The Transfer shimmer wave to folder option stores the calculation result in
the folder designated by the specified datapipe. Finally, the Run task option will run
the specified task.

The significant
parameters of Global Analysis Options

shimmer are the -Pitch Track
same as fOI‘ the Fo Acceptable pitch periods: @ 120 to 280Hz (typical female)

calculation. so ) 80 to 150Hz (typical male)

Options leads to thg O[5 |t [250 [nz

same d|alog (thiS Frame advance ms (time between result points)

dlalog can aso be Reject all peaks with a > ‘3-?: variation in adjacent pitch periods
accessed by
pressing Option 'I'
(lower-case L)). If
IS generally easier to adjust the parameters to obtain a satisfactory Fo, and not make
further changes here.

Acceptable pitch periods setsthe bounds of fundamental frequenciesfor the
pitch tracking algorithm to seek. The Female and Male radio buttons give suggested
pitch ranges for adults. Y ou may also specify your own pitch range.

The Frame advance textbox sets the distance the frame moves between
consecutive calculations. Reject all peaks with a > X% variation in

adjacent pitch periods specifies the maximum increase or decrease over the
previous pitch period allowed in the search for the next consecutive pitch period.
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HNR

Harmonic-to-noise ratio (HNR) is
common measure of noise, and is
often used to indicate the
hoarseness of avoice. The plot
displays the HNR (in dB) on the (] After calculating, run task:[ o |
vertical axis and time on the

Harmonic-to-noise Ratio Setup
~Analysis

Average over pitch periods (3...301)

i i -Log
horizontal axis. []send average HNR to journal:[_Notes |
The Average over X pitch [ Transfer HNR wave to:[_Default | folder
I i Run task:
periods textbox specifies the CORun task:[__ o |

number of pitch periods averaged 1 (3otiors | [tarcai
for each HNR calculation. [ Help... ] [Options...] [ Cancel ]

Increasing this value improves
accuracy at the expense of computation speed. Enabling the After calculating,
run task checkbox and choosing atask from the associated pop-up menu will run
that task after each calculation. Any Log options that are checked will be executed
each time you click on the L og button that appears with the other controls. The
Send average HNR to journal option computes the average and sends it to the
designated journal. The Transfer HNR wave to folder option stores the calculation
result in the folder designated by the specified datapipe. Finally, the Run task option
will run the specified task.

The other significant -
parameters Of HNR are the - Global Analysis Options

-Pitch Track
Same aS for the FO_ Acceptable pitch periods: @ 120 to 280Hz (typical female)
calculation, so Options {3 80 to 150Hz (typical male)
leads to the same dialog O [55 Jto[250 |z
(thlS dlalog can also be Frame advance ms (time between result points)
accessed by pl’ ng Reject all peaks witha> % variation in ad jacent pitch periods
Option 'lI' (lower-case
L)).. Itis generally easi
to adjust the parameters to

obtain a satisfactory Fo, and not make further changes here.

Acceptable pitch periods setsthe bounds of fundamental frequenciesfor the
pitch tracking algorithm to seek. The Female and Male radio buttons give suggested
pitch ranges for adults. You may also specify your own exact pitch range. The

Frame advance textbox sets the distance the frame moves between consecutive
calculations. Reject all peaks with a > X% variation in adjacent
pitch periods specifies the maximum increase or decrease over the previous pitch
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period allowed in the search for the next consecutive pitch period.
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ENVELOPE

The envelope of a soundwav
represents the outer bounds
its amplitude (in volts),
plotted as a function of time.
It is the curve created by
connecting the peaks.

The Frame advance
textbox sets the distance the
frame moves between
consecutive calculations.
Unlike most other sound
calculations, increasing the
frame advance resultsin a

Envelope Setup

~Analysis

Frame advance: ms (1...50)
(] After calculating, run task: E

[JTransfer avg amplitude to journal:

[J Transfer min amplitude to journal:

[JTransfer max amplitude to journal:
[JTransfer envelope wave to:| Default |folder
[J Bun task: E

smoother envelope plot. Enabling the After calculating, run task checkbox
and choosing atask from the associated pop-up menu will run that task after each

calculation.

Any Log options that are checked will be executed each time you click on the L og
button that appears with the other controls. The Transfer avg, min & max
amplitude to journal options compute the parameter and send it to the designated
journal. The Transfer envelope wave to folder option stores the calculation result in
the folder designated by the specified datapipe. Finally, the Run task option will run

the specified task.

6 - 18

SoundScope User's Manual



ENERGY

The energy function plots the
energy envelope, i.e. the outet
bounds of sound intensity (in
volts squared) as a function of
time. It is created by
computing intensity and
connecting the peaks.

The Frame advance
textbox sets the distance the
frame moves between
consecutive calculations.
Unlike most other sound

Energy Setup
- Analysis

Frame advance: ms (1...50)
[J After calculating, run task:zl

[JTransfer avg energy to journal:
[JTransfer min energy to journal:
[JTransfer max energy to journal:
[JTransfer energy wave to: folder

[J Bun task: E

Cancel

calculations, increasing the

frame advance results in a smoother envelope plot. Enabling the After

calculating, run task checkbox and choosing atask from the associated pop-up
menu will run that task after each calculation.

Any Log options that are checked will be executed each time you click on the Log
button that appears with the other controls. The Transfer avg, min & max energy
to journal options compute the parameter and send it to the designated journal. The
Transfer energy wave to folder option stores the calculation result in the folder
designated by the specified datapipe. Finaly, the Run task option will run the

specified task.
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ZERO CROSSING
A Zero Crossing plot displays the

Zero Crossing Setup

rate (in Hertz) at which the -Analysis
soundwave crosses through zero Frame Length: ms (0.1...100)
volts, as afunction of time. Itis C1 After calculating, run task: [ ]

often used to identify when the
sound is voiced, unvoiced or silenf] :Log
[JTransfer Z2C wave tu:fulder
The Frame length textbox sets CJRun task:[__ ¢ |

the size of the frame over which

zero crossings are counted. A (cancet | [ ok ]

longer frame length produces a
smoother plot. Enabling the After calculating, run task checkbox and
choosing atask from the associated pop-up menu will run that task after each
calculation.

Any Log options that are checked will be executed each time you click on the Log
button that appears with the other controls. The Transfer ZC wave to folder option
stores the calculation result in the folder designated by the specified datapipe.
Finally, the Run task option will run the specified task.
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SPLINE

The Spline plot displays a very
smooth version of the soundwave,
derived from a cubic polynomial
curve fit.

The Knot width specifiesthe
number of data points between
adjacent knots. A smaller knot

width produces a better fit, but take

longer to compute. The Show
radio buttons (Splined signal, 1st
derivative, 2nd derivative) selects
which wave to compute and display

S

Spline Setup
~Analysis

Knot width: points

Show: & Splined signal (position)
3 1st derivative (velocity)
3 2nd derivative (acceleration)

(] After calculating, run task: E

[ Transfer wave to:| Default |folder
[J Run task: |I|

Enabling the After calculating, run task checkbox and choosing atask from
the associated pop-up menu will run that task after each calculation.
Any Log options that are checked will be executed each time you click on the Log
button that appears with the other controls. The Transfer wave to folder option
stores the calculation result in the folder designated by the specified datapipe.
Finally, the Run task option will run the specified task.
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L PC RESIDUAL

The LPC (Linear Predictive
Coding) Residual isthe
difference between the
estimated vocal tract transfer
function and the actual
soundwave.

The LPC coefficients
textbox lets you adjust the

number of coefficients used ijp

the calculation. Clicking the
Default checkbox sets avalue

LPC Residual 5etup

~Analysis

LPC coefficients: (0...257) [] Default
Frame length: IEI ms (1...30]

(] After calculating, run task: E

~-Log
[JTransfer L% laryngograph to: | Default |folder
[J Bun task: E

that is appropriate for the

current sample rate. The Frame length textbox sets the size of the frame on

which LPC coefficients are based. Enabling the After calculating, run task
checkbox and choosing a task from the associated pop-up menu will run that task

after each calculation.

Any Log options that are checked will be executed each time you click on the Log
button that appears with the other controls. The Transfer wave to folder option
stores the calculation result in the folder designated by the specified datapipe.
Finally, the Run task option will run the specified task.
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SNAPSHOT DISPLAYS

A snapshot display is used for viewing information about a small time interval
(called aframe) of a wave, centered about a designated marker.

There are five controlg 10ms
on the right-hand side | 2™
of the dISp| a_y’ the 100ms % =5 EI Analysis Options
snapshot option pop-u U I =
_ Wideband FFT  |. . . .. . ... .. . dE
menu, source wave pop Narrowband FFT |- % - - - - - - - .. L s 5 | & || Source Wave
up menu, source marker, pe : -
pop-up menu, Log Cepstrum A source Marker

button, and Setup [
button. Thedisplay |77, '
takes the source wave as selected
input, computes the P
specified snapshot )
option for the frame Snap M1
centered about the

source marker, produces a result wave and displays that wave. Each time one of
these items changes, the display automatically recal culates and displays the new
result. The Setup button lets you alter the parameters of each snapshot option, as
shown in the dialogs below. Finally, the Log button performs the actions that were
selected in the Setup dialog box, such as logging data to a journal, or executing a
task. Each snapshot option and its associated parameters is described below. For
further details on specific algorithms, see Appendix A, Sound Analysis

Computations.

Log Button

Setup Button
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TIME INTERVALS
As show above, the snapshot option
menu incI udes selecti ons fOI‘ 10 LEIS, This form of analysis does not support

the log button.

These commands zoom in on the framg
of data around the marker. Because
they do not involve any computation, the Setup and Log buttons do not apply. If you
press those buttons, you will get the dialogs shown above.

14
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W IDEBAND AND NARROWBAND FFT

An FFT (Fast Fourier :
Transform) ShOWS the P IWideband FFT Setup
frequency energy of a FFT Points: smoothing:
}/vaveformf(\]fertlcal axis) asa Filter: [ 300 Hz (5ms) |
(ﬁgﬁtég?,& a;elg)ueq%e result ffs ~ Disploy range: [NEJto [5  |kHz
often referred to as a power [ Use 6 dB pre-emphasis
spectrum. (] After calculating, run task: E
wzgglyddglf-—errencde between [J5end up to EI peaks to journal:
| an an. [JTransfer spectrum tu:fulder
Narrowband FFT is the fun task.
default Filter and number of CRun task:[__© |
FFT points. The Wideband
default Filter is 184Hz (5ms); [ concer ] (__x_J
whereas the Narrowband
default Filter is 59Hz (25ms).
3 The FFT points pop-up, illustrated to the left, sets the number of data

&4

296

1024

16584

128 points used by the FFT algorithm.

The Filter pop-up, illustrated to the right, selectsthe | 45 Hz (33ms)
2048 filter bandwidth. A wideband filter (184 Hz) shows
4096 broad trends, while a narrowband filter (59 Hz) reveals 184 Hz (ams)
8192 sharp details. This selection imposes a lower limit on
the possible number of FFT points (i.e. smaller

bandwidths require more FFT points), so some of the point values

59 Hz (25ms)
+ 150 Hz (10ms)

300 Hz (5ms)
450 Hz (3.2ms)
600 Hz (2.5ms)

may be grayed out. If you select afilter bandwidth that cannot be computed with the
specified number of FFT points, SoundScope automatically chooses the minimum
number of points and updates that pop-up.

+ None The Smoothing pop-up menu allows you to select the degree of
Low smoothing to apply to the FFT. For example, smoothing plots that
Medium | contain many jagged peaks will make broad trends more visible. The
High Display range specifies the lower and upper frequency limits to

) display. (Thisrange affects only the display, not the actual
calculation.)

If theUse 6 dB pre-emphasis option is checked, the high frequencies of the
source wave are emphasized by 6 dB per octave before processing. Enabling the

I nstruments
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After calculating, run task checkbox and choosing a task from the associated pop-up
menu will run that task after each calculation.

Any Log options that are checked will be executed each time you click on the L og
button that appears with the other controls. The Transfer up to n peaks to
journal option finds the first n peaks and sends their frequency and intensity values
to the designated journal. The Transfer spectrum to folder option stores the
calculation result in the folder designated by the specified datapipe. Finally, the Run
task option will run the specified task.
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LPC

Linear Predictive Coding (LPC)
provides an estimate of the vocal || ..analysis

tract transfer function, and the .

. K ; . LPC 1T ts: 14 (0...257) Default
residual signal is the difference coeTeiens bd Defau
between these predicted values antl LPC frame length: ms (5...30]
the actual soundwave. One can FFT Points: (Hz resolution)
think of an LPC as a different way | Displayrange: [0 |to|5  |khz

to look at the frequency spectrum [ Use 6 dB pre-emphasis

LPC Setup

of asoundwave. Aswith an FFT ] After calculating, run task:zl

frequency is displayed on the

horizontal axis, and intensity (in || :Log

dB) on the vertical axis. Ofranster[s__[peaks to journal:_Notes |
[J Bun task: E

The Show LPC and Show

Residual Signal radio buttons
select which analysisto display. In

either case, calculations are performed using the number of coefficients specified in
the LPC coefficients box. Usethe Default checkbox to let SoundScope select a
value appropriate for the current sample rate. The value specified in the LPC
frame length box sets the length of the frame (in milliseconds) on which the
calculations of the LPC coefficients are based. The FFT points pop-up sets the
number of data points used by one step in the LPC algorithm. A higher value will
help to resolve peaks, at the expense of computation time. The Display range
specifies the lower and upper frequency limits to display. (This range affects only
the LPC plot display, not the actual calculation.)

If theUse 6 dB pre-emphasis option is checked, the high frequencies of the
source wave are emphasized by 6 dB per octave before processing. Enabling the
After calculating, run task checkbox and choosing a task from the associated pop-up
menu will run that task after each calculation.

Any Log options that are checked will be executed each time you click on the L og
button that appears with the other controls. The Transfer up to X peaks to journal
option finds the first X peaks and sends their frequency and intensity values (as well
as the LPC coefficients) to the designated journal. Finally, the Run task option will
run the specified task.
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CEPSTRUM

Cepstrum is a computation
derived from the excitation-|| .anarysis

modulation mode! of SpeeCh FFT Points: Smoothing:
It attempts to separate the Filter: | 45 Hz (33ms) |

Cepstrum Setup

peaks due to speech from _
those due to glottal excitatior). | [Use 6 dB pre-emphasis
Time iS dlsplayed on the (] After calculating, run task: E

horizontal axis and intensity | .| g

(mdB) on th_e Vertical aXiS- [J5end up to peaks to journal:
(It IS Interesti ng to note that [JTransfer cepstrum tu:fulder

the name cepstrum was
. [J Run task: : |
chosen to mirror "spectrum’|] me
from which the calculation

derives. Hence, the time axig
is usually referred to as
guefrency, to mirror the frequency associated with a spectrum.)

i

;j; The FFT points pop-up, illustrated to the left, sets the number of data

128 points used by the FFT algorithm.
2596
The Filter pop-up, illustrated to the right, selectsthe | 45 Hz (33ms)

1024 . . . . . A~ 59 Hz (25ms)
onas | filter bandwidth. This selection imposes a lower limit |, 75g 1z (10ms)
4096 on the possible number of FFT points (i.e. smaller 184 Hz (8ms)

8192 bandwidths require more FFT points), so some of the | 300 Hz (5ms)
16384 | point values may be grayed out. If you select afilter | goo bz 3:2me)
bandwidth that cannot be computed with the specified number of
FFT points, SoundScope automatically chooses the minimum number of points and
updates that pop-up. Note that a 59 Hz filter corresponds to narrowband analysis

and 184 Hz to wideband analysis.

+ None The Smoothing pop-up menu allows you to select the degree of
Low smoothing to apply to the cepstrum. For example, smoothing plots
Medium | that contain many jagged peaks will make broad trends more visible.

High

If theUse 6 dB pre-emphasis option is checked, the high
frequencies of the source wave are emphasized by 6 dB per octave before
processing. Enabling the After calculating, run task checkbox and choosing a task
from the associated pop-up menu will run that task after each calculation.

Any Log options that are checked will be executed each time you click on the L og
button that appears with the other controls. The Transfer up to X peaks to journal
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option finds the first X peaks and sends their time and intensity values to the
designated journal. The Transfer cepstrum to folder option stores the calculation
result in the folder designated by the specified datapipe Finally, the Run task option
will run the specified task.
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% File Edit Sound Wave Display Journal Task (7] &y

Chapter 7
The Short Menubar

SoundScope has a set of short menus designed for the instrument user. Advanced
features that are only needed by instrument designers are described in the
SoundScope & SuperScope I Reference Manual.

Like most Macintosh applications, SoundScope includes an About command under
the Apple menu. The menubar then has the standard File menu for loading and
saving instruments. The Edit menu features the standard Cut, Copy, and Paste for
the current selection, plus additional commands to copy any SoundScope object to
the Macintosh Clipboard. The Sound menu covers recording, playing and hardware
setup. The Wave menu lets you load, save and manipulate sound waves. The
Display menu contains various options for interacting with the display, such as
defining mouse behavior. The Journal menu is for loading, saving and printing
textual notes and values. And the

Task menu allows you to run a pre-defined sequence of events.

To access a more complete menubar, choose Menubar » BTN g
Full under Edit. To enable the multi-channel data New... 3N

acquisition features in SoundScope (e.g. record 112 analog rhannel... b
input channels viaa MacADIOS board), choose Edit Delete b
Menubar » Full under Edit, select HardwareintheMenu | = .
pop-up, press "Show Default Text" (instead of "Hide Timebase... %M

Menu"), and then press OK. A new menu will appear, i
illustrated to the right, and it is from here that one setsug  T1199efr-..
aMacADIOS Digitizer. After setting up a digitizer, one | Trigger Modes...
can create atask that USes it by choosing New Digitizer |
under Task. For more details on multi-channel recording Digitizer 4
and the Full menubar, please see the GW Instruments Datq_Digitizer Setup...
Acquisition Catalog and the SoundScope & SuperScope |1

Reference Manual.
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FILE MENU | File |

In many Macintosh applications, the File menu New Instrument...
contains all commands that interact with the disk (e.g. DPen... #0
Open, Save) and that deal with the entire file or Save #S
document (e.g. Page Setup, Print). But typical save RAs...

applications only deal with one kind of document or

object. In contrast, SoundScope includes many Datapipe Folder... }

different objects, such as displays, waves, journals
and tasks. Each of these objects hasits own menu fQr page Setup...

loading, saving and printing (if applicable). Print Setup...

Together, they comprise a software instrument. The  print... %P
SoundScope File menu deals with the entire

instrument. Quit 30

New Instrument clearsal displays, markers, waves, journals, tasks and
datapipes from memory; and lets you create your own instrument from scratch.
SoundScope can only have one instrument active at atime.

Open... ( LQO)lets you select a pre-defined instrument file from disk (using the
standard File dialog) to replace the current instrument. SoundScope can only have
one instrument active at atime. Unless you press Cancel, all displays, markers,
waves, journals, tasks and datapipes will be cleared from memory, and replaced by
new ones. All changes that have not been saved will be lost. Be careful, thereis no
warning prompt.

Save ( [S) Writes the instrument configuration to disk using the current instrument
name (shown in the title bar), effectively deleting the previous version. An
Instrument Designer has some control over which information is saved with the
instrument. The name and attributes of all objects are always saved. To make sure
their contents (data) are saved, verify that the appropriate Save contents with
instrument file checkbox is selected. (In the Full Menubar, select the Options
command from the Wave menu, and click the Points button. Also, select the Options
command from the Journal menu. For more information, see the SoundScope &
SuperScope |1 Reference Manual.)

Saving wave and journal contents with the instrument is a convenient way of letting
you start up exactly where you left off. Note that this additional information can
increase the instrument size greatly.
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Save As... prompts you for afilename and location with the standard File dialog,
and then saves the instrument to disk.

Datapipe Folder... lets you change the folder associated with a datapipe. A
datapipe is a pointer to afolder on a hard disk or floppy disk. It provides a shortcut
method for loading and saving files repeatedly to or from the same folder, saving
you the trouble of having to find this folder each time you need to access it.
Datapipes are also useful for accessing folders from within tasks, where the name of
the folder may change with each experiment.

Page Setup...

LaserlWriter Page Setup

T.0

presents the standard| paper: @ us Letter 1 A4 Letter i
CIUS Legal () BS Letter —|_Tabloid

dialog for the currer
printer (specified
from the Chooser in
the Apple menu).
For example, the

Reduce or
Enlarge: %
Orientation

=

hdl

[ ok ]
Cancel

Printer Effects:

[<] Font Substitution?

(4 Text Smoothing?

(4 Graphics Smoothing?

[ Faster Bitmap Printing?

LaserWriter dialog i

shown above. Refer to your printer documentation for detailed explanations of the

available settings.

Print Setup... IetsyorL“
select the objects to pri

Y ou may print the entirg
Front panel or one or
more Displays, using
horizontal and vertical
scales according to the
Front panel setting or F
to page. Printout showg
you the Current length,
and letsyou set a
maximum number of
pages to print.

—

~Print

Print Display Control

i+ Front panel
i Displays: Rut:Rul

~Horizontal Scale:
i Front panel
i_» Fit to page

setting

~lertical Scale:

i Fit to page

i@ Front panel setting

~Printout

Current length: 2 pages

[ Help ]

[ Cancel ]
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Print... ([P

presents the standar
Macintosh print
dialog, similar to the]
one shown to the
right. You may
simply click OK or

Laserllriter “LaserllUriter 11 NT” 70 ||

Eupies:l!l Pages: @ All Frum:| |T“: | |

Cover Page: @ Mo (_)First Page _ Last Page
Paper Source: ® Paper Cassette (O Manual Feed
Print: i@ Black & White O Color/Grayscale
Destination: @ Printer i) PostScript® File

hit the Return key to print. Refer to your printer documentation for detailed
explanations of the available settings.

Quit ( CQ)leaves SoundScope, returning you to the Finder (the desktop). All
changes that have not been saved will be lost. Be careful, there is no warning

prompt.
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EpiT MENU | Edit |

As with most Macintosh applications, the Edit menu | #### 24
Contains commands to edit iNfOrmation and PIACE datay--
on the Clipboard for exchange with other software. |t Cut #H
also lets you show or hide the Clipboard and other Copy 3L
objects. Since waves are represented asacolumn of | Paste 1)
numbers separated by carriage returns, one can easily Clear
move wave data between SoundScope, spreadsheets, | Select All #A
word processors and graphics programs. TO SEIECE [t
part of a wave with the mouse, make sure that the Show b
Mouse mode (under the Display menu) hasbeen set to cgpy Task b
Edit. Then, click once to select the display that Copy Display b
contains the wave of interest. Finally, drag over any Copy LW Tent b
P ; y Wave TeH
part of the wave, highlighting your selection. To Copy Wave Graph b
select text in ajournal, click once on the journal then Py P
;:iec))(lflecllck on aword or drag over any amount of Choose Menubar )

Undo ( [Z)ds used by desk accessories to undo the last command.
Cut ( X)Femoves the selected wave data or text, placing it on the Clipboard.
Copy ( LC) places the selected data on the Clipboard.

Paste ( [Pyis used in anumber of ways. In awave, if the cursor is a cross-hair
(i.e. Mouse » Edit is selected under Display), Paste inserts the wave data stored in the
Clipboard at the cursor position. (It inserts nothing if the Clipboard contains non-
numerical text.) If part of the wave is selected, the Clipboard data overwrites the
selection. (If the Clipboard contains non-numerical text, Paste has the same effect as
Clear, i.e. it deletes the selection without inserting any datain its place.). Ina
journal, Paste inserts the text stored in the Clipboard at the cursor position. (It
inserts a the wave values if the Clipboard contains wave data.) If sometext is
aready selected, the Clipboard data overwrites the selection.

Clear removes the selected wave data or text, without altering the contents of the
Clipboard.

Select All ( CA)kelects dl of the datain the active display or journal.
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Show will bring a different window to the XTI Front Fanel
front, creating it if necessary. As with most Clipboard
Macintosh applications, Show » Clipboard CLursor
opens a window onto the Clipboard data. Show Notes

» Cursor presents a
m window, shown to the left, that tracks the wave
. . values for the current cursor location. The
Wave| Horizontal lertical . . .
e | 0 0% Sec 453 o1t | ohow command will also bring any window-
find 0.079 Se= | -0.957 Uolt based journal to the front. Thisis useful since
S R the Front Panel often occupies the entire screen.

b Iy

Copy Task places atextual copy of atask onto
the Clipboard. To save or print, ssmply paste the data into a SoundScope journal or
another application. To copy all tasks to the clipboard, press Option $hift 'O'. To
copy a description of the instrument to the clipboard, press Option ‘a. To copy a
description of the instrument, including the menubars, press Option Shift ‘A’

Copy Display places avisual copy of adisplay (in PICT format) onto the
Clipboard. To create a report or presentation, simply paste the data into another
application.

Copy Wave Text places wave values (in text format) onto the Clipboard. To
save, print, plot or analyze the data, ssmply paste into a SoundScope journal or
another application.

Copy Wave Graph places avisua copy of awave (in PICT format) onto the
Clipboard. To create a report or presentation, ssmply paste the data into another
application.

Choose Menubar lets you select SoundScope's Full menubar, or any other
menubar created by an Instrument Designer. For information on Full menubars, see
the SoundScope & SuperScope |l Reference Manual. To copy a description of the
current menubar to the clipboard, press Option 'p'. To copy all menubars, press
Option Shift 'P'.
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SounNnD M ENU | Sound

SoundScope is designed to record, play and analyzetwo | Flay A #6
channels of data, referred to as Channel A and Channel § Flay ﬁ ?E?
(or simply A and B). You can specify the hardware Piay lares LR

source and destination for each channel. Depending on | FPlay Selected 39
your hardware’ SoundSCOpe may record (and/or pl ay) .....................................................................
these two channels ssmultaneously (although it cannot both Record A #0
record and play at the same time). However, you can still Record B -
analyze two channels of sound by recording and playing | @ssaid ipren ®=
themoneat atime. e

Test...
Play A ( [6) dutputs the Channel A wave through the Controls... #B
Channel A hardware. setup...

Play B ( [CZ) dutputs the Channel A wave through the Channel A hardware. (See
the Setup command, below.)

Play Stereo ( [8) dutputs both the Channel A sound and the Channel B sound at
the same time. At present, only the SoundScope/16 NuBus card supports this
feature, so this command will be grayed out for other hardware (the Macintosh
internal speaker and MacSpeech Lab).

Play Selected ( [9) dutputs the currently selected sound (i.e. the highlighted
portion of a wave) through the Channel A hardware. It will do nothing if thereis
nothing selected. (Remember that the portion between two markers is a segment not
aselection.)

Record A ( CO) digitizes sound for a specific duration (set with the Controls
command, below) from the Channel A hardware and places the data into the Channel
A wave. Recording begins as soon as you release the mouse button. Thereisno
way to stop recording in the middle.

Record B ( =) digitizes sound for a specific duration (set with the Controls
command, below) from the Channel A hardware and places the data into the Channel
A wave. Recording begins as soon as you release the mouse button. Thereis no
way to stop recording in the middle.

Record Stereo ( [=) dligitizes both the Channel A sound and the Channel B sound
at the same time. Recording begins as soon as you release the mouse button. There
IS no way to stop recording in the middle. This feature is only available with the
SoundScope/16 NuBus card or two MacRecorders, so this command will be grayed
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out for other hardware (the Macintosh internal microphone and MacSpeech Lab).

Test... presents a series of
d|a|0g boxes to glJI de yOU ‘we will now play a 1kKHz tone for | second at a 21Ks/sec rate with the
through record/play hardware || [Macspeech Lab 11 hargware.

d|agn0$| CS. EaCh dla|Og IT different hardware 15 selected in the Setup dialog or your hardware is
1 t yet installed, pl it this test b ing the Stop button.

Cor_responds to a dlfferent teSt’ Eihegrewi]snes, Sre?as F'Dlaejsteo ?:ar tr:; tuer?e,naun\{; trlileirsi;r;gmnetinuneptnu o
Wh|Ch 1S deSCH bed N the d|alog proceed with the next test. If you don't hear the tone please check the
The first test plays atone when|| ['*™ "%
the Plgy buttgn IShpret$hed|’:ethe :nal:al;? sure your hardware is installed properly, as described in the
Second recoras wnen tne Recor

. - working order. | possible, try another amplifier, swap speakers, etc.
bUtton IS pressed, the thl rd play ® Make sure your play volume control is reasonable.
your recording when the Play [
button is pressed, and the forth
lets the user record and play at will. In each dialog, the Continue button advances to

the next test, and the Stop button aborts the test sequence.

Hardware Tone Test

& Make sure your play path (eg. cables, amplifier, speakers) is in good

vJ

Play ] [ Help... ] [ Stop ] [[ Continue ]]

Controls... ([B) dpensa
dialog, illustrated to the right, -Record
that affects various record &

Record/Play Control

play parameters. Before buration: | EHITINENNsecs
aCtlvatl ng thlS dlalog, ||'||]|_|t lepel: -
SoundScope performs a quick

test to make sure the hardware [k (] Auto normalize

connected and working
properly. If the hardware chedk
is unsuccessful, you will get an || ¢FPlay -
error d|a|OQ and then the Setup Hnhameln % Hepetitiuns:lzl

diaog.
The Duration textbox defines

the amount of time to record. SoundScope records continuously during this period,
even during moments of silence. The Input level pop-up menu controls the input
volume of the 16-bit digitizer, with O denoting minimum sensitivity, and 5 denoting
maximum sensitivity. This item will be grayed out for other sound hardware.
Selecting the Auto normalize checkbox normalizes the entire digitized wave
immediately after recording, digitally amplifying as high as possible without
clipping. (You can manually normalize the wave at any time with the Normalize
command in the Wave menu.)

The VU Meter shows the sound volume as you speak into the microphone, to help
you find the optimal distance between the microphone and your mouth. If the level
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IS too high, you risk signal clipping; recording at too low a level reduces signal
resolution. Level 8 isagood balance.

In the Play region, you can set the Volume for the internal Macintosh speaker. This
item will be grayed out for other sound hardware. The number of Repetitions
specifies how many times the selected channel is repeated when you select Play from
the menu. Clicking the Setup button at the bottom of the dialog has the same effect
as selecting Setup from the menu.

Setup... brings up adialog to specify your hardware configuration. SoundScope
supports two record channels and two play channels, which can each be set
independently. Although the A and B channels are typically set up to play the waves
named A and B (if the latter exists), any wave in integer format can be played. Note
that most analysis calculations yield a floating point result wave. Certain hardware
configurations can record (one AudioMedia board, two MacRecorders) or play
(AudioMedia board) both channels simultaneously.

Each hardware supports different Sample Rates. The sample rate corresponds to the
number of times per second that the analog sound signal is digitized. Higher sample
rates are able to capture higher frequency components but require more memory,
disk storage and computation time.

If you want to record from the microphone selected in the Sound Control Panel (e.q.
internal microphone, MediaTime digitizer, AudioMedia digitizer), select Apple with
the Internal Option, and use the Options button in the Sound Control Pan€l to set the
Input options.

SoundScope/16
SoundScope/LC _
A 16bit AudioMedial, hec iR [ Te-Bit Digitizer ] [ Teftnic ][ 2205 kiz)
AudioMedialll, or MediaTime

digitizer board is setup, as
illustrated to the right. The
default sample rate is 22.05 kHz,
half Of the CD Standard Th|S [ Rec A ] [ Rec B ] [Hec A& B] [ Test... ]
rate captures most of the [ Playn | [ PlayB | [PlayA&B] [ Help... | Cancel
"interesting” frequencies in
speech, and speeds up all analysis by afactor of two (since the computer processes
half the samples that it would with 44.1KHz data). The AudioMedial & |1 boards
can only directly record and play at the 44.1 kHz rate. Data at lower sample ratesis
filtered after recording and before playing, resulting in a noticeable delay. The
MediaTime board (available from RasterOps Corporation for ~$2000) includes a
24bit video circuit, areal time frame grabber, two 16bit record channels, and two

Hardware Setup

Rec B:|_B || 16-Bit Digitizer || Right+Mic]| 22.05 kHz|

Play A:| A || 16-Bit Digitizer |

Play B:| B || 16-Bit Digitizer |
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16bit play channels -- it is truly amazing.

SoundScope/12 &
MaCSpeeCh Lab I Wave Hardware Option Sample Rate
A MacSpeech Labl _OI' . Rec A:| A || MacSpeechLab1 || < [ 10.4kHz |
SoundScope/12 digitizer is setuy

Hardware Setup

. . Rec B:| B || MacspeechLab 1 ][ =« || 10.4 khz |
asillustrated to theright. The || ., .. [ Macspeech tan T |
default sample rate is 10.4 kHz|| ., 5B [ Macspeech Lab T |

((RecA | [ RecB | [secnwo ] [ Test. |

[ Playn | [ PlayB | [Pisgaw 3 [ Help.. |

SoundScope/8 &
Sound Control Panel _
The Apple ReCOI‘d Settl ng refer L Wave ” Hardware ” hfg;;ur: IlSa;n;lzekHHazte

Hardware Setup

4

. Rec H:| A Apple |
either to the I\/I_acRecor_d_er, (_)r Rec B:|_B || Appie |[ Modem ][ 22.2 kHz |
the current device specified in || . n[n \[ Tnternal speaker |
the Sound Control Panel. The Play B:[ B [ Tnternal Speaker |

Option pop-up specifies whethef
to use the modem port, printer [ RecA | [ RecB | [Hecig]| [ Test.. |
port, or internal microphone (Oﬂ [ Playn | [ PlayB | [ptays& 8] [ Help.. | Cancel
machines such as the Macintosh
LC and Ilsi). Theinternal microphone is that which is selected in the Sound Control
Panel, and can therefore be used to access any standard sound input device (e.g.
VoicelLink digitizers, RasterOps MediaTime board, etc). Note that you can record
In stereo with two 8-bit digitizers, one connected to the modem port, the other to the
printer port.

MacSpeech Lab Il hardware Setup

For the MacSpeech Lab 11 _

hardware, a Slot POp-up will Rec A:| u;aue I Ma::;gllaucahrfah | men ||sa:nup.I:kHHaztB|

aS%ﬁ?]%rSi%%\éecg?]eugjﬁlg/uuon. Rec B:| B || MacspeechLab 11 |[ = [ 10.4kHz |
- 4 . Play A:| A || MacSpeech Lab 11 |

determine which slot contains Play B:[ B |[ ™MacSpeech Lab 1T | slot:[_4 |

the board, although it cannot

distinguish between an MSL [ RecA | [ RecB | [wecnwog] [ Test.. |

board and a standard GWI [ Playn | [ PlayB | [Pisgz s8] [ Help... |

MacADIOS data acquisition
board. Note that the Macintosh Ilcx and I1ci number their slots beginning with 4.
See Chapter 1, Installation, for details.
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WAVE MENU P
The Wave menu groups together various actions thaj  SaUe As...

you can perform on waves. Most items are

Load Data...

ww

hierarchical menus with which you can choose an
entire wave (by name), a named segment (defined as
the portion between two markers) or the currently
selected portion (if something has been selected).

Edit Dlalues...
S5ynthesize...

ww

Note that both the recorded sounds and the results of
most calculations are stored as waves, and certain
functions only apply to the waves associated with the
two channels of sound data.

Zero...
Normalize...
Amplify...
Calculate...
Filter...

IWave Statistics...
Sound Statistics...

vwvw

wvw
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Save As... writesto disk the datain the
wave that you select, prompting you for g
filename and location (folder), as
illustrated to the right. Specify the name
of the file in the File name textbox. For
soundwaves, the default name isthe
channel (A or B), so you will usually w

to enter a more descriptive name. Like a

standard File dialogs, the pop-up menu at
the top lets you move "up" in the folder
hierarchy. As an alternative, the Folder

|23 SoundScope Betal v| = Scott's HD
O dedauiiy 2 ifs Eipni

O defasits Tor dispings -

0 fusl  hanned i Desktop

O odunt channal - B pr—
O D Chasnel i pichae |ml
™ T rpan H o

= ii i g <;§§$ vy BERme Huin
L1 Bingls Channed

3 Single Channeblbisi § Format...
File name: Folder:

[ | Soundsco]

pop-up menu in the bottom right corner

lets you select a datapipe as the destination folder. If no datapipes exist, it will

simply show the current folder.

The Format button let

you change the file
-File Format

Save Wave Options

~-Data

format and other
parameters. The defaulj
format is 16-bit integer
or 32-bit floating point,
depending on the interngl

data type. (To check or ) Audio IFF
change the type, switch g :;_S_;"WE

to the Full Menubar,

i@ 16-bit integer

) Bz-ni floating paind

() Text (engineering units)

i3 MacSpeech Lab (16-bit int)

0 All points
2 From points:

(| to 100 |

~Append to file name -
[ Trace Number

[] Date
O Time

select the Options
command from the Waue

menu, and click on the

Points button.) The data can be saved as Text for use in another application. The
Audio IFF (AIFF) format is an emerging industry standard for sound. (See

Appendix B, File Formats of the SoundScope & SuperScope |l Reference Manual for

additional information.)

The Data options let you save only a subset of the wave, and the Append choices

will annotate the filename with useful information. As noted earlier, wave data can

aso be saved with the instrument.
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Load Data... letsyou select afile, and then loads its contents into an existing wave,
typicaly A or B (the waves associated with record/play channels). The new data
will overwrite information currently in the wave.

Edit Values... organizep _
wave values in atable for EditUalues: A |
simple viewing and S8L

) . 0,000 -0.039i 0,029i 0,020i 0,034
editing, asillustrated to 4.80e-4| 0,044 0,034 0,0200 9,77e-3
the right. 9,60e-4| 0.77e-3.  0.020i 0,039 0,059
l.44e-3[ 0.0200 9. 77e-3i 0,015 0,015
- 1.082e-3[  -0.044: -0,2290 -0.2000 -0,176
The leftmost column in
\ _ _ 2.40e-3| -0.146; -0.142i 0,107 -0,083
thetableisan index whidh | 2. 8ge-3| . -0.044. 0,039 -0,029° 0,039
corresponds to the point I |...3:36e=3]...z0.038:  -0.020 0.024 0.039
: 3.84e-3| -9.77e-3; -0.0200 -0,020i -9.77e-3
.the o) a.Cent column _(e.g. 4.32e-3| -0.0200 -0.024; -0.020i -0.020
in the dialog to theright,| ~ .
the value at 00048SGC |S Index Format Units Typing :
.044Volts). Thisindex ig( : @Time @Dec @ Dolt @ Dverwrite |
shown in units of time o Point (O Haw o Internal ) Insert i

(e.g. seconds) or point
number (i.e. an incrementing integer, starting with 1), depending on the setting of
the Index radio buttons. The five right-most columns hold the wave data,
proceeding left to right then top to bottom.

There is no way to cancel or undo changes made in this dialog. To change the value
at any point, just click on its cell and type a new number. Use the arrow keysto
move the cursor up, down, right and left between cells. Depending on the Typing
option, both the Tab and Return keys will either move the cursor to the right
(Overwrite mode) or insert a new cell (Insert mode). To select arange of values,
simply drag the mouse over any series of cells. Although the File menu is disabled,

the keyboard equivaents for Cut ( LX),1Copy ( LC)land Paste ( [\M)1wvork as
expected. The Delete key has the same effect as Cut, and the Enter key will accept
changes and exit the dialog.

Several display options are available. The two Format radios determines whether
points are displayed in Decimal or Hexadecimal form (e.g. decimal 25 in
hexadecimal form is 0x019). Hexadecimal can only be selected when displaying
16hit integer Internal data. The Units option specifies whether values are displayed
In engineering units (e.g. -10 to +10Volts values) or Internal units (e.g. -32768 to
+32767 values from a 16bit A/D converter). Internal units only apply to 16-bit
integer waveforms. Independent of the display options, data is always Cut, Copied,
or Pasted in engineering units.
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The Typing option controls the behavior of the Tab and Return keys. In Overwrite
mode, pressing Tab or Return moves the cursor one cell to the right. In Insert
mode, Tab or Return inserts a new cell, increasing the total length of the wave by
one point. Finally, the upper-most Wave pop-up menu allows you to select another
wave, segment, or selection.

Caution: Only 3 digits after the decimal are shown in the Wave Editor, yet more
precision is stored internally. 16bit integer waves often have a least-significant-bit
value of 0.000305 (i.e. 20/65536) and 32bit floating point waves offer 7 significant
digits of scientific notation accuracy (i.e. X . XXXXXX exYY). Copy Wave Text
in the Wave menu is a more accurate way to copy wave data to the clipboard.
Pasting into the Wave Editor is very accurate and does not involve unnecessary
truncating. If you select a cell and move to another cell, it will read the text if it
differs by more that .001 from the value stored internally and update the internal
value to that (truncated) viewed value (careful!).

Synthesize... dlowsyou to
load waves with internally-
generated (i.e. synthesized)
data. Waves can be loaded with
asine wave, square wave,
triangle wave, ramp, constant
value, guassian noise, or
uniform noise. Sine, Triangle
and Square waves are defined
with the Points-per-cycle and
Peak-to-Peak Amplitude edit
fields. The Ramp is define with
two edit fields that specify the
value at the two end points.
Gaussian noise has agaussian
distribution (i.e. a histogram of

Sgnthesize:

Length:

 Periodic: |52 points/cycle

Uolt amplitude

@ sine () Square () Triangle

CRamp: [0 | to {10 |voit

i Constant: ICI Uolt
i Guassian: lolt rms noise
3y Uniform: Volt random noise ()

i_» Don't synthesize

the wave datais a gaussian curve centered about 0) with the specified RM S (Root

Mean Sguare). RMS is the same as standard deviation is this case. For example,

10V rms gaussian noise will have 60.6% of it's values between -10 and +10V.
Uniform noise is evenly distributed about the specified bound. A histogram of
uniform noise shows values evenly distributed between -Bound and +Bound.
For example, each point of £10V uniform noise has an equal probability of
appearing anywhere between -10V and +10V. The Length edit field is used to

specify the # of points in the synthesized wave, the maximum being that permitted

by available memory. The wave isloaded with synthesized data when the user
presses OK or moves to another wave via the pop-up at the top of the dialog. |If
you want to use the pop-up and do not want synthesis to occur, select the Don't
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Synthesize radio before hitting the pop-up menu.

Zero... sets every point in the designated wave, segment or selection to 0 Volts;

effectively replacing sound with absolute silence.

Normalize... amplifies the designated wave, segment, or selection so that its
extreme value (maximum or minimum) equals the upper or lower bound (10

Volts).

Amplify... increases or attenuates the amplitude
(voltage) of the designated wave, segment or
selection by a specified percentage, clipping any
values that exceed the £10 Volt bounds.

For example, an "amplification" factor of 50% wil
multiply by one-half; a factor of 200% will

Amplify wave by: %

multiply by two. To invert the wave, use a negative number (e.g. -100%).

Calculate... isused to perform
waveform calculations. Over 80

Calculate Wave

functions and operators (e.g. fft, cog, ©tat

| = [ caic |

+, *) are supported. The calculation] o [tar

| = [ calc |+ 1[0.000 |

takes place only when the Do It o [ tale

| = [ calc |+« ]| caic |

button is pressed. For details on thig

@ [ Doiced

| = [ Doiced |

dialog box, please consult the
Calculate Wave instruction (which i
identical to the Calculate command

Source:

A ]

[ use Dariables

under the Wave menu) in the

Instructions chapter of the (_Hetp ] (view

Data)[ Dot ][ cancel J[[ ok ]

SoundScope & SuperScope ||

Reference Manual. For details on each function, please refer to the Functions &

Operators chapter in the same reference manual.
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Filter... isused torun alow- Gj
pass, high-pass, band-stop, bang}
pass or user defined FIR filter
on awave, segment or selection
For details on this dialog box,
please consult the Filter

Type:

Freq Cutoff:
Boundaries:

Filter: Selected

| Smoother (ham)

| (Custom...]

(% of sample rate)

instruction (which isidentical t(
the Filter command under the
Wave menu) in the Instructions

g

Freq Cutoff: 100.0 Hz
Stopband: -42 dB

Phase: linear
Taps: 20

chapter of the SoundScope &
SuperScope |1 Reference
Manual.

Wave Statistics... provides general
information on the designated wave,
segment or selection. Depending on the
size of the wave or segment, you may
have to wait several seconds for the dat
to appear. The Wave pop-up menu at the
top of the dialog box allows you to view
statistics for a different wave, segment qy
selection.

Wave: Selected | Statistics

204
10.417 points / msec

Number of points in memory:
Data sampled at:
Minimum: -6.733 Uolt (at 145.4 msec)
Maximum: 9.985 Volt (at 145.9 msec)
0.040 Dolt

Standard deviation:

Mean:
2.902 Volt
1.93e-3 Dolt - sec
2.902 Volt

Area under wave:

Root mean square:

7 - 16
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Sound

Statistics Sound Statistics:

provides a variety|| Uoiced: 100.000 % Jitter (RAP): 0.326 % (-49.73 dB)
of calculations for| Unvoiced: 0.000 % Fo Average: 122.911 Hz

the designated Silent:  0.000 % Fo Kurtosis: -0.860

wave %gment or Shimmer (APO): NAN(D21) % Fo Skewness: 0.716

selecfion Many aof HNR: NAN(D21) dB Fo Range: 0.615 ST (4.378 Hz)
the cal cuiations Breathiness: -3.977 dB Fo Std Dew: 1.594 Hz

depend on avalid
Fo, based on the

settings in the Fo options dialog. The Fo Options dialog is opened by pressing the
Options... button, or by pressing Option Shift 'l' (lower-case letter 'L') when the
front panel isvisible. For long utterances (i.e. several seconds), you may have to
wait several seconds for the data to appear. Depending on your machine, it could
take from one to over ten seconds to analyze a single second of data.

The Wave pop-up menu at the top of the dialog box allows you to view statistics for
a different wave, segment or selection. Note that it is not always possible for a
statistic to be computed, yielding "NAN" (not a number). For technical information
on these statistics, see Appendix A, Sound Analysis Computations.
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DisPLAY M ENU | Display |

The Display menu controls your interaction with the Move... 4

SoundScope front panel. It includes commands to contro

marker location and various choices for mouse behavior.| M™Mouse »
Grid Snap On

Log Coords To P

Panel Edit On ¥E

Move... shiftsadisplay, movesa
marker or both. For displays, the ~Move:
first Position option shifts the [ Display:

contents by the specified amount. T¢ [] Marker:
move |eft, enter a positive number; tp o

move right, enter a negative numbe

Note that "moving" the display ® secs et N
contents left is equivalent to pushing CTo the secs position
an imaginary piece of graph paper t¢ O To marker:

the left. An unfortunate (but
arguably unavoidable) subtlety of thg

Macintosh user interface is that
"moving" left is equivalent to
"scrolling” right. The second option sets the left edge of the display to the specified
value, and the third sets the left edge to the marker position. For markers, the first
Position option moves the marker by the specified amount. To move left, enter a

positive number; to move right, enter a negative number. The second option moves
the marker to the specified value, and the third to the position of another marker.

Move Display

g

Mouse... isused to select one g
five mouse modes: Edit, Draw,
Move Marker, Log Coords, or
Vertical Adjust. In each mode,
the operation of the mouse relates
to asingle wave in adisplay that
has been selected. If adisplay includes more than one wave and you need to operate
on awave other than the first (as viewed in the Contents list of the Display Options
dialog), wave labels must be visible. To enable wave labels, select Features from the
Display menu (which is available in the Full Menubar), and click on the Add Wave

L abels checkbox. The first four letters of each wave name are shown in the wave
label area, and clicking on awave label selects that wave for mouse work.

Move Marker
Log Coords #*4
Vertical Ad just #5
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Edit ( D) s the most commonly used mode and is automatically :
selected when you first launch SoundScope. In this mode, you can Cult
Copy and Paste sections of awave much like one would edit textina !
word processor (i.e. by dragging the mouse over the area of interest).: :
The selected portion is highlighted and magically becomes a waveform of its own
called "Selected". The Selected wave appears in wave submenus, shares data with the
host wave, and is viewed as an ordinary waveform by the analysis and presentation
tools. Only the user can change the length of the Selected wave (i.e. with the
mouse).

Draw ( [2) ¢hanges the cursor to a pencil and allows you to edit the wav:_\Jj
data graphically. When the mouse button is held down, the pencil leaves

mark everywhere it is dragged. When the mouse button is released, the wave is
updated with the drawing.

Move Marker ( [3)thanges the cursor to a "+#*", which isused to move :.|..i..:
markers. If Move Marker mode is not selected, you can still move markers
by holding down the Option key while dragging the mouse.

L og Coords ( [4)_thanges the cursor to a cross-hair, which iséégg - fédgﬁn
used to log wave coordinates to ajournal. Each time the mousezz=g s= 12 0mno

is clicked on awave, it's position (usually time) and value are

sent to ajournal. The coordinates are preceded with a header on the first click, as
shown in the above illustration (e.g. "X:Hz Y:dB"). The Log Coords To submenu

specifies which journal receives the text.

Vertical Adjust ( [5) thanges the cursor to a hand, which is
used to move the selected wave up and down in its display. i
Moving awave is purely a graphical operation and does not affect the wave data.
Clicking once on the "+" symbol next to the wave name will cause that wave to snap
back to it's non vertically adjusted position.

Grid Snap On/0OfT isused by the Draw mode, described above, to force the
cursor to specific grid intervals while drawing.

Log Coords To isused by the Log Coords mode, described above, to specify
which journal receives coordinate data.
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JOURNAL MENU | Journal [

A SoundScope journal is atext editor for entering notes, | Clear 4
logging values and recording any information pertinent gy
your analysis. Text may be transferred between journals| Save Rs... 4
and the Clipboard using Cut, Copy and Paste. Journal filgs Load Text... »
that have been Saved to dlSk can be read dlrectly from (110 < T
spreadsheets and word processors. Page Setup... |}
Print... 4

Clear... erases the contents of the specified journal. All
changes that have not been saved will be lost.

Save As... writes the specified journal to disk, prompting you for afilename and
location (folder) with the standard File dialog.

Load Text... reads from disk the contents of atext file that you select with the
standard File dialog, placing the data in the specified journal.

Page Setup... presents the standard dialog for the current printer.

Print... presents the standard dialog and then prints the journal contents.
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TAsSK MENU | Task |

SoundScope tasks let you set up sequences of events such as Open...

sound acquisition, analysis, playback, printing and file output. .

Hun
Open... readsin atask from disk. S5top 4
Continue

Run executes the task that you select from the hierarchical
menu.

Stop halts the task that you select from the hierarchical menu.

CONTINUE EXECUTES THE TASK THAT YOU SELECT FROM THE
HIERARCHICAL MENU, BEGINNING WHERE IT WAS PREVIOUSLY
STOPPED.
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Appendix A
Sound Analysis Computations

This appendix explains in detail how each SoundScope analysis function is computed.
For information on how to perform the analysis, please see Chapter 6, Front Panel.

THE FOURIER TRANSFORM

This section introduces you to the basic tools and terminology of Fourier analysis,
and describes how it is used in SoundScope. For a more detailed and comprehensive
introduction, you may want to read a book on speech analysis such as Thomas
Parsons’ Voice and Speech Processing.

INTRODUCTION

Soundwaves may be described as fluctuations of sound pressure over a period of
time. The most direct way of recording these fluctuations is to use a microphone to
translate the sound pressure into atime-varying voltage. The resulting timewave
may be plotted on a graph, typically with time on the horizontal axis and voltage on
the vertical axis.

Information about the various frequency components contained in a timewave can be
derived using Fourier analysis. Fourier analysis is based on the principle of
Fourier's Theorem, which states that any timewave can be expressed as a sum of
sinusoidal waves. In general, the more complex the timewave, the more frequency
components enter into this sum. Each frequency component contributes a certain
magnitude and phase. (The phase describes how the frequency component is shifted
in time, e.g. to differentiate between a sine wave and a cosine wave.) The magnitude
and phase values may be expressed as a function of frequency; this function is called
the Fourier transform of the timewave. You can think of the Fourier transform as a
“frequency wave,” an alternate representation of the timewave. It contains all of the
information of the original timewave, and in fact the timewave can be recovered by
applying an inverse Fourier transform to the “frequency wave.”

If you ignore the phase information of the Fourier transform and graph only the
magnitude as a function of frequency, you obtain an estimate of the power spectrum,
also called a frequency spectrum or energy spectrum. (The magnitude is usually
expressed in dB, and the frequency in Hz.) The peaks in the power spectrum
identify the strongest frequency components in the signal. For example, the power
spectrum of the sound of a soloist tuning her instrument to middie A (440 Hz) would
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have a sharp peak centered about 440 Hz. Other frequency components would be
present as well, because of overtones created by the instrument, the presence of noise
coming from the audience, etc. As another example, the power spectrum of a vowel
usually contains peaks at the formant frequencies.

DIGITIZATION AND THE FFT

In order to understand how SoundScope uses Fourier technigues to analyze sounds,
you should have a basic understanding of how sound is represented in the computer's
memory. When the computer records a sound, a special piece of hardware called an
analog-to-digital (A/D) converter trandlates the continuously-varying analog signal
from the microphone into a sequence of numbers. In this digitization procedure, the
signal is sampled at a certain sample rate (typically tens of thousands of times a
second), and the digitizer assigns an integer value to each sample. Each integer
value corresponds to a voltage; together, the set of all allowed integer values maps
out the entire voltage range used by the digitizer. These coded values can later be
converted back into sound — that is, played back through a loudspeaker — via a
digital-to-analog (D/A) converter.

The sequence of numbers (digital data) captured by the A/D converter forms a wave,
which is so named to suggest its correspondence to the original continuous analog
waveforms. Just as a mathematician applies the Fourier transform to a continuous
waveform, the computer applies a specially adapted version called the Discrete
Fourier Transform to awave. A short-cut method called the Fast Fourier
Transform (FFT) lets a computer calculate Fourier transforms in a reasonable
amount of time, but restricts the length of waves it can analyze to a power of two,
like 16, 256 or 1024 points. (This restriction can be circumvented by a technique
known as zero padding, discussed later in this chapter.)

The Fourier transform accepts a wave containing N samples that are equally spaced
In time and returns magnitude and phase values for N/2 frequencies. The frequency
components returned by an FFT are equally spaced in frequency from O to half the
sampling frequency. Increasing the sampling rate improves the fidelity with which
signals are captured by making the digitizer receptive to higher frequencies, but
Increases the memory required to store digitized sounds.

FRAMES, FILTERS, AND THE SHORT-DURATION FFT

Although it is possible to perform an FFT on waves of unlimited length, most kinds
of frequency analysis look at relatively small portions of larger waves, called
frames. (A typical frame has a duration of about 10 to 50 ms.) It is often useful to
compile FFT results taken from a number of frames spaced evenly throughout an
utterance. This procedure yields different results than performing one FFT on the
entire utterance. It isimportant to consider how the size of an FFT frame affects
calculation results.
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A basic principle of Fourier analysis holds that time information and frequency
information are complementary — the more you know about one, the less you know
about the other. In theory, to know the exact frequency composition of a signal, you
have to evaluate the Fourier transform from t = -infinity to t = +infinity. However,
this precise spectrum contains no information about when the various frequency
components appeared and disappeared. On the other hand, if you transform afinite
segment of that signal, you obtain time information at the expense of some frequency
resolution. The frequency resolution (also called bandwidth) describes how close
together two frequency components can come and still be distinguished as separate
peaks in the FFT.

In addition to frame duration, you may need to know how the frame was isolated
from the rest of the signal. One method of isolating the frame is to multiply the
entire signal by a wave called a rectangular window that has a value of O everywhere
outside the frame and 1 inside. In fact, non-rectangular window shapes are used
more often. The choice of window shape affects the frequency spectrum obtained by
the FFT, and different window shapes are appropriate for different applications.
The most common window used in speech analysis is the Hamming window. This
window attains a maximum in the middle and tapers off close to zero at the edges.
(The formula for the shape is given later in this chapter) The Hamming window has
the advantage of introducing fewer spurious peaks in the frequency spectrum, with
the disadvantage that its bandwidth is greater than that of a rectangular window of
the same duration.

In some forms of analysis, many short-duration FFT's are performed on an entire
sound utterance, each applied to a different section of the timewave. A prime
example of this technique is found in the spectrogram, which shows the progression
of the frequency spectrum over a period of time. Each FFT is applied to a
Hamming-weighted frame. The position of the frame is advanced between
consecutive FFT calculations by an amount of time called the frame advance. You
can adjust the length (amount of time) of the frame by specifying the filter
frequency, a parameter originally used to describe the frequency resolution of
traditional analog spectrograph machines. A low filter frequency, such as 59 Hz,
specifies a narrow bandwidth, which means that the spectrogram plot can resolve
frequency components as small as 59 Hz apart. A high filter frequency, such as 184
Hz, specifies a wide bandwidth, indicating a coarser resolution. The advantage of
the wide bandwidth spectrogram is that it is more sensitive to the timing of spectral
events (e.g. the onset of a vowel) than the narrow bandwidth spectrogram.

Since multiplying a time waveform by a window corresponds to convolving the
timewave's frequency spectrum with the FFT of that window (signal processing
theory says this), there exists a relationship between the window width (ms), and the
width of it's associated FFT (Hz), as noted in the table below:
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Window Width (ms) Filter Width (Hz)
33 45
25 59
10 150
8 184
5 300
3.2 450
2.5 600

MacSpeech Lab | and Il refer to an 8ms window as a "300Hz filter", and refer to a
25ms window as a "45Hz filter"; whereas SoundScope refers to an 8ms window as a
184Hz filter, and a 25ms window as a "59Hz filter". Subsequently, MacSpeech Lab |
& I1's 45Hz filter is referred to as 59Hz in SoundScope, and

MacSpeech Lab | & 11's 300Hz filter is referred to as 184Hz in SoundScope. The
change is attributed to a more popular method for interpreting filter width (i.e. the
newer method is used by other manufacturers). We apologize for any confusion that
this may have caused.
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BAsic DEFINITIONS

This section describes some computations that are common to many SoundScope
anayses. The following section Algorithms and Formulas, assumes that you
understand the material presented here.

THE FFT
An N-point FFT of the wave composed of discrete points Ap A; ..., Ay Where N is
some integer power of two, is defined as:

N-1 .
=Y An e(-2mi) nk/N
n=0

for k=0 through N-1. The result is a sequence of N complex numbers, each number
F, representing the magnitude and phase at a frequency equal to k/N times the
sampling rate of wave A,. Since the SoundScope FFT routine always expects wave
A, to be composed entirely of real numbers, the output points possess a complex
conjugate symmetry: F, = F*, >, where N/2 < k < N-1. Asaresult, wave F, only
needs to be specified for values of k from O through N/2, corresponding to
frequencies ranging from O to the Nyquist frequency (half the sampling rate).

Note that, although the formulais valid for all positive integers N, the FFT
algorithm used to compute the formula only works when N is an integer power of
two.

THE INVERSE FFT
An N-point inverse FFT of the sequence F,, F,, ..., Fy.; is defined as:

Ap=1 Nz'l Fy, e(2mi) nk/N
N =0

for n=0 through N-1. This equation is the dual of the FFT equation above. In
general, the result A, is a sequence of N complex numbers equally spaced in time. |If
the sequence F, possesses conjugate symmetry (see the FFT definition), then each
number A,, must be real.

Note that, although the formulais valid for all positive integers N, the inverse FFT
algorithm used to compute the formula only works when N is an integer power of
two.
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THE HAMMING WINDOW
The Hamming window is an N-point wave defined by the formula

Hamm,, = 0.54 - 0.46 cos (21t n/(N-1))

where n ranges from 0 through N-1. The window attains a minimum of 0.08 at both
edges and peaks at avalue of 1 in the middle. The bandwidth (“filter frequency”) of
the spectrum resulting from an FFT of a frame of data which has been multiplied
point-by-point by a Hamming window is given by:

Bandwidth (in Hz) = 1475 / duration of frame (in ms).

ZERO PADDING

The number of samples included in aframe for an FFT calculation must equal an
even power of two. To guarantee this, SoundScope sets the frame size to a number
2Nthat equals or exceeds the size of the Hamming-weighted frame to be processed.
Any points beyond the actual data are padded with zeroes.

6 dB PRE-EMPHASIS

A 6 dB pre-emphasis option is available in many SoundScope analyses. When this
option is enabled, the wave to be analyzed is processed so as to emphasize the higher
frequencies before the analysis is performed. The transformation is achieved by
“differentiating” the wave to be analyzed, i.e. by generating a new wave whose
points equal the differences of consecutive pointsin the original wave. (Note that
the 6 dB pre-emphasis generates a new wave that is used internally in the analysis
calculations; the original wave being analyzed is unaffected.) The procedure boosts
higher frequencies at the rate of 6 dB per octave. This option is particularly useful
for speech analysis because it counteracts the natural high frequency roll-off of
speech, yielding less downward-skewed graphs for those plots that display frequency
on the horizontal axis.

Note about Decibel Values. Many SoundScope analyses such asthe FFT and LPC
return results in decibels (dB). It isimportant to realize that the decibel values have
not been calibrated to any absolute scale, so they should be interpreted as relative
values. If you need to calibrate to an absolute scale, you will have to digitize some
reference signals and use the decibel readings you obtain as reference dB levels.
When you are making recordings with a microphone, you should keep in mind that
the distance between the microphone and the speaker’ s mouth affects dB levels.
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ALGORITHMS AND FORMULAS

This section describes the computational details behind each form of analysis. It
explains how the result wave of each analysis (e.g. average spectrum) is calculated
from the source wave (e.g. human speech). Familiarity with the previous section,
Basic Definitions, is assumed.

AVERAGE SPECTRUM

An Average Spectrum plot displays the average power spectrum of an entire
segment or wave. The spectrum is graphed in terms of dB versus frequency.
The following agorithm is used:

1. For each frame:
* Apply optional 6dB pre-emphasis.
Hamming-weight the frame.
Take FFT (magnitude values only), after zero padding, if necessary.
Take 20*log,,,
Apply optional smoothing.
2. Average the results for each frame to obtain result wave.

CEPSTRUM

The cepstrum of a speech waveform is the Fourier transform of the logarithm of its
power spectrum. The motivation for defining this waveform arises from the
excitation-modulation model of speech, which hypothesizes a linear relationship
between speech and glottal excitation: X(f) = G(f) H(f), where X and G are the
Fourier transforms of the speech and glottal excitation waveforms, respectively, and
H is the vocal tract transfer function. The argument f denotes frequency. The
cepstrum C(q) is given by:

C(q) = FFT{log [X(F)I’}
= FFT{2log (IG(f)| HA))} = 2 FFT{log |G(F)[} + 2 FFT{log [H(f)[} .

The argument g has the unit of time; it has been dubbed “quefrency” to suggest its
duality with frequency. (Similarly, the name “cepstrum” was chosen to mirror the
spectrum from which it derives.) The logarithm serves the important function of
converting the product of G and H into a sum, so that the peaks due to G will be
visible in C(q) separately from those due to H. If X(f) is the Fourier transform of a
vowel sound, then the peak due to H is found near g=0, whereas the one dueto G is
found at a quefrency corresponding to the fundamental period of the glottal
frequency. Peaks at multiples of the fundamental quefrency may also be visible.

The excitation-modulation model is idealized and must be modified to account for
the presence of noise that is inherent to all speech: X(f) = G(f) H(f) + NOISE(f) .
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The expression for C(q) no longer breaks down neatly into a sum of G and H
components, but the main features of the graph remain visible provided the noise is
not too heavy. The following algorithm is used:

1. Take frame of speech about the marker.

2. Apply optional 6dB pre-emphasis.

3. Take FFT (magnitude values only), after zero padding, if necessary.
4. Takelog,, then take FFT (magnitude values only) again.

ENERGY
An energy plot describes the shape of the amplitude squared of a wave's peaks.
The following agorithm is used:

1. For each frame, find the maximum of the square of all samplesin the frame.
2. Divide by 32768 to convert to energy, in units of volts squared.

ENVELOPE

The envelope of awave is the shape that describes the amplitude of its peaks. The
envelope is related to the energy of the wave; see also the Energy entry above. The
following algorithm is used:

1. For each frame, find the maximum of the absolute value of all samplesin the
frame.
2. The sequence of maxima (one obtained for each frame) forms a wave.

FFT

An FFT plot shows the power spectrum of a frame of timewave data centered about
the marker. The spectrum is graphed in terms of dB versus frequency.

The following agorithm is used:

Apply optional 6dB pre-emphasis.

Hamming-weight the frame.

Take FFT (magnitude values only), after zero padding, if necessary.
Take 20*log,,.

Apply optional smoothing.

WwhwnNE

FUNDAMENTAL FREQUENCY (FO)

Fundamental frequency (F,) corresponds to the rate of the speaker’s vocal cord
vibration. This vibration appears as a periodic component in a speech waveform
whose frequency varies over time. Naturally, the fundamental frequency can only
be evaluated during voiced intervals. Fundamental frequency is determined using
either an auto-correlation technique or a peak-picking algorithm, as specified in the
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F, Setup dialog box.

The auto-correlation technique is a standard one (see Rabiner and Schafer in Digital
Processing of Speech Signals, pp. 141-144 and 150-154 for details), and uses a frame
size equal to the minimum acceptable period specified in the FyAnalysis Options
dialog. Calculation speed is directly proportional to the Acceptable pitch periods
range, specified in the same dialog. If the Fast option is selected, a center clipper is
applied to the source wave, thereby speeding up the auto-correlation calculation (at
the expense of some accuracy). This clipper converts all samples into either O, 1 or
-1 according to the following rule: samples near 0 Volts are converted to 0, samples
above a certain threshold are converted to 1, and samples below a certain threshold
are converted to -1.

The peak-picking algorithm identifies the individual cycles in the source wave in
order to calculate the fundamental frequency. The technique used is described in
Gold, “Computer Program for Pitch Extraction.” JASA, 34(7). The peak-picking
algorithm produces a sequence of pitch values, one value for each pitch period.
Variations in pitch cause this sequence of numbers to be spaced somewhat
irregularly in time.

Both pitch-tracking techniques limit their search for pitch values to the pitch range
specified in the F, Options dialog. Gaps appear in the F, plot in those regions in
the source wave where no pitch has been detected in the pitch range.

HARMONIC-TO-NOISE RATIO (HNR)

Vowel sound waveforms may be regarded as a sum of two components. a harmonic
(i.e. periodic) component, which characterizes the fundamental frequency F, and a
noise component. The ratio of the energy of the harmonic component to that of the
noise component is called the harmonic-to-noise ratio (HNR). An HNR plot shows
theratio (in dB) over time. Thisratio has been used as an index of the degree of
hoarseness of speech, hoarse speech having more noise and a weaker harmonic
component than normal speech.

SoundScope uses the algorithm described by Y umoto, Gould, and Baer in
“Harmonic-to-noise ratio as an index of the degree of hoarseness’ JASA 71(6). A
brief explanation follows. A peak-picking algorithm (see Fundamental Frequency
above) identifies the cycles (pitch periods, from one peak to the next) in the wave.
(The autocorrelation method is not used in computing HNR.) For each pitch period
P, the following calculations are performed: To cancel out noise, the speech waveis
averaged over n consecutive pitch periods centered about P, resulting in a wave one
pitch period long that is almost entirely harmonic. (The number n of consecutive

pitch periodsis specified in the HNR Setup dialog. For the statistics calculation, n
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isfixed at 31. The n pitch periods must be similar.) This harmonic waveis
subtracted from the one pitch period centered about P, yielding a noise wave. HNR
Is the ratio of the two. The following calculation is used:

M = number of pointsin one pitch period
N = number of pitch periods averaged to find harmonic energy

N/2-1

Wave,\\ m=1 IZI\I/Wave ((IM+N) mod M )

M
Harmonic Energy =H, = nZ: Waven (n)

M
Noise Energy = N = nz—l( Wave /. () - Wave_. (n))

Hi
HNR (dB)i = 10'0910(N_i)

Note that HNR can only be computed on a voiced interval that has avalid F,
calculation over regions with similar pitch periods (e.g. vowels).

HORIZONTAL SPECTRAL SLICE (HS SLICE)

A horizontal spectral slice plot shows a horizontal “slice” of a spectrogram — a
graph of intensity in dB versus time at a specified constant frequency.

The following algorithm is used:

1. For each frame:

Apply optional 6dB pre-emphasis.

Hamming-weight the frame.

Take FFT (magnitude values only), after zero padding, if necessary.
Take 20*10g,, of the magnitude at the specified frequency.

Apply optional smoothing.

2. The sequence of dB levels over time produces the result wave.

JITTER

Jitter is a time-varying parameter that measures pitch perturbation, i.e. how quickly
the pitch period changes in a vowel utterance over time. A jitter plot is formed by
tracking the pitch period over 3 successive pitch cycles, using the peak-peaking
algorithm described in Fundamental Frequency, and the duration of zero crossings
preceding each peak. (The autocorrelation pitch-tracking method is not used in
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computing jitter.) The following agorithm is used:

Period AT B
AVG; a 3
Period Difference; = PerlodAVGi - Perlodi
Jitter . (%) = 100 o ifference
. 0) = -
i
PerlodAVGi

where P, P, P, are consecutive pitch periods. Note that jitter only makes sense
on sustained vowels with avalid F,. Thejitter statistic (F, Perturbation) is described

later in this appendix. Shimmer also measures perturbation, but of amplitude rather
than pitch.

L INEAR PREDICTIVE CODING (LPC)

An LPC plot shows an estimate of the vocal tract transfer function, graphed in terms
of dB versus frequency. The peaksin the LPC plot of avowel sound occur at
formant frequencies. The plot is derived from a set of LPC coefficients which
are calculated using an autocorrelation method (with rectangular window) known as
Durbin’s recursive procedure (see Rabiner and Schafer, p. 411); the length of the

frame used in the procedure is specified in the LPC Setup diaog. The estimate of
the vocal tract transfer function is based on the assumption that the transfer function
H(z) is an al-pole function of the following form:

H(2) = GAIN
(1 +alz-1+ a2z-2+ ...+ anz-p)

where a, through a, are the LPC coefficients. The LPC plot displays the function
10 log,, [H[? on the vertical axis (in dB) versus frequency on the horizontal axis (in

Hz). Alternatively, the LPC Setup dialog allows you to display the Residual
Signal, explained below, in place of the LPC plot.

The reason for the name “linear predictive coding” is that the coefficients appearing
in the transfer function serve a predictive function: given the p most recent data
POINS Yp.p» Yrpe1s --» Yna OF @ Speech wave, the estimated value y', of the next point
y, may be calculated as follows:

y'n =-Yn1 - dYnpo - - anyn-p
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i.e., y' isalinear combination of the p points that precede it. The difference
between the actual and predicted values forms a prediction error sequence e, defined
ase, =Y, -Y, aso known as the residual signal. Besides measuring the error of
the prediction calculation, the sequence e may also be regarded as the voice source
that drives the vocal tract and which transforms directly into speech via the transfer
function H(2).

The optimal choice of the number of LPC coefficients depends mainly on the sample
rate of the speech wave being analyzed. All LPC-related analyses in SoundScope
allow you to choose a default number of LPC coefficients given by the following
formula (see Rabiner and Schafer, p. 419):

Number of coefficients = (Sample rate in kHz) + 3
e.g. the default # of coefficients for 10 Ksamples/sec is 13.

However, the number of coefficients may be changed in some analyses. In general,
increasing the number helps to resolve formant peaks that are close together in
frequency but may also introduce extraneous features into the LPC plot. The default
values are optimal for male speech; women or children may require analysis with
more coefficients.

LPC HISTORY

The LPC History plot presents a spectrogram-like “history” of the LPC transfer
function, with time on the horizontal axis and frequency in Hz on the vertical axis.

A point is shaded in on the graph only if the transfer function H(z), calculated at the
time and frequency specified by the point, exceeds the energy cutoff (measured in
dB) specified by the user for the graph. The LPC History plot resembles a very
high-contrast spectrogram. The LPC History Setup dialog gives you the option to
perform formant tracking, and plot one or more formant lines on top of (or in place
of) the LPC History plot. The following algorithm is used:

1. For each frame:
* Apply optional smoothing to source wave.
» Compute LPC coefficients and transfer function H(z).
» If the LPC history option has been enabled, plot avertical stripe of the
L PC History, shading in only those frequencies whose energy level exceeds the
specified energy cutoff.
» Advance to the next frame.
2. If any of the formant options have been enabled, compute the formant waves
and plot them.
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LPC RESIDUAL

An LPC Residual plot shows an estimate of the voice source that drives the
production of speech according to the linear predictive coding model. This estimate,
called the predictive error or residual wave, corresponds roughly to the
vibration of the vocal cords. The following algorithm is used:

1. For each frame:
» Compute LPC coefficients.
» Generate a residual signal for the length of the frame.
» Advance to the next frame.
2. Concatenate (i.e. string together) the residual signal of each frame to generate the
result wave.

SHIMMER

Shimmer is atime-varying parameter that measures amplitude perturbation, i.e. how
quickly the amplitude changes in a vowel utterance over time. A shimmer plot is
formed by tracking the pitch period over 11 successive pitch cycles, using the peak-
peaking algorithm described in Fundamental Frequency, where the period is from
one peak to the next. (The autocorrelation pitch-tracking method is not used in
computing shimmer.)

The following algorithm is used:

A +A + +A
A i-5 i-4 - i+5

AVGi 11
ADifference; ~ AAVGH T A
. A Difference;
Shi mmer; (%) = 100
AVGi

where A, and A, are the peak amplitudes of consecutive pitch periods. Note that
shimmer only makes sense on sustained vowels with avalid F,. The shimmer
statistic is described later in this appendix. Jitter also measures perturbation, but of
pitch rather than amplitude.

SPECTROGRAM

A sound spectrogram (also called a “sonogram”) is avisual display of the frequency
analysis of atime waveform. The horizontal axisistime; the vertical axis shows
frequency. The relative darkness at any point represents the relative energy level at
that frequency and time. Traditionally, analog sound spectrographs produced
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spectrograms by converting the energy output of an analyzing filter (184 Hz for
wideband and 59 Hz for narrowband) into a variable degree of burn on thermally
sensitive paper.

The Spectrogram Setup dialog gives you the option to perform formant tracking,
and plot one or more formant lines on top of (or in place of) the spectrogram plot.
The following agorithm is used:

1. For each frame:

* Apply optional 6dB pre-emphasis.

* Hamming-weight the frame.

» Take FFT (magnitude values only), after zero padding, if necessary.

» If the Spectrogram option has been enabled, plot avertical stripe of the
Spectrogram. The spectrogram is white everywhere the energy level is less
than or equal to the specified minimum energy level; energy levels equal to
or greater than the specified maximum energy level are shaded black; and
energy levels between the minimum and the maximum assume intermediate
levels of shading. (See the note below on color spectrograms.)

» Advance to the next frame.

2. If any of the formant options have been enabled, compute the formant waves
and plot them.

Note about color spectrograms: If the color option in the Spectrogram Setup dialog
box has been selected, then the shading used falls along a spectrum of shaded tones.
This spectrum is bounded by two colors that have been selected in the Color Picker
dialog box, one designating the color of the minimum energy level, the other the
color of the maximum.

SPLINE

Spline-fitting is atechnique for fitting cubic (third-degree) polynomials as closely as
possible to waves. A spline plot shows a very smoothed-out version of the source
wave.

To produce a spline, the source wave or segment is smoothed out by averaging
adjacent points to eliminate noise and is partitioned into smaller segments. The
points are averaged together in each small segment to generate a data point called a
"knot"; the sequence of knots approximates the entire wave within the current
segment. The spline-fitting procedure generates cubic polynomials to connect the
knots, requiring that both the first and second derivatives of adjacent polynomials
match at the knot between them. A wave based on these polynomialsis then
generated that passes through al the knots.
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The knot width is specified in the Spline Setup dialog, which gives the choice of
displaying the spline, as well asitsfirst and second derivatives.

ZERO CROSSING

The zero crossing function counts how often a sound wave crosses the time axis —
i.e., how often the signal swings from positive to negative or negative to positive
voltage. A zero crossing plot shows the rate of zero crossings (in Hz) over time.

The zero crossing function is computed on a frame-by-frame basis. The zero
crossings of the source wave are counted in each non-overlapping frame. The count
in each frame is divided by the length of the frame, specified in the Zero Crossing
Setup dialog. These frequency values are then linearly interpolated to yield the
result wave.

Note that the zero crossing rate grows fairly large during periods of silence. This
behavior arises from the fact that even an apparently “silent” signal hovers very
close to zero volts and randomly crosses the zero line fairly often. (Of course, a
perfectly silent signal — one which remains exactly at zero volts — has a zero
crossing rate of zero.)
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SOUND STATISTICS

In the explanation of each statistic below, the wave or segment on which the statistics
are calculated is referred to as the source wave. Many of the values are highly
dependent on avalid F,, and the acceptable F, range in the options dialog.

BREATHINESS
This parameter measures the high-frequency content of the source wave. The
formula for breathiness (in dB) is given by:

energy (2nd Back Difference)
energy (Source)

breathiness =10 log, ,

Source is the source wave, the energy of awave is the sum of the square of each
point in the wave, and the n" point of 2nd Back Difference is defined as:

2nd Back Difference, = Source, - 2 Source, ; + Source, .,

The 2nd Back Difference wave is the discrete version of the 2nd derivative of the
Source wave, which is equivalent to the Source wave transformed by a high-
frequency emphasis, applied at the rate of 12 dB per octave. Dividing the energies
of the 2nd Back Difference and the Source waves produces a number indicating how
much of the energy of the Source resides in the high-frequency range.

F,AVERAGE

The average F, of a speech wave is defined to be the arithmetic mean of the
fundamental frequency measured by the peak-picking algorithm.

F, KURTOSIS

This parameter measures the fourth moment of the pitch values found in a speech
wave and is defined by the formula:

1 < fi-faugy®
kurtosis = | + dTavgy L3
{N%( o )}

where f,, f,, ..., fy are the consecutive fundamental frequencies measured by the
peak-picking algorithm and f, 4 is the average frequency of the source wave. Sis
the standard deviation of the frequency. Kurtosis measures the peakedness or
flatness of the frequency distribution relative to a normal (gaussian) distribution; the
-3 term in the formula makes the kurtosis zero for a normal frequency distribution,
positive for a leptokurtic distribution, and negative for a platykurtic distribution.
For more information, see pp. 474-475 of Numerical Recipesin C.
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Fo PERTURBATION

The F, perturbation (also known as Jitter or relative average perturbation, “RAP”)
of the source wave is defined by the formula:

N .
iél |Pe”°dDifferencei |

See Jitter (which is discussed earlier in this chapter) for the definition of Period

bifferencer FOF More information, see Clinical Measurements of Speech and Voice,

p. 178.

F, Range
The F, range of a speech wave measures the difference between the highest and

lowest fundamental frequencies tracked by the peak-picking algorithm. This
difference, measured in semitones (ST), is calculated using the following formula:

log

fmin

log 2

fmax

fO range = 12

where f, and f ., are the highest and lowest frequencies, respectively, of the source
wave. Thevalueisaso displayed in Hz.

Fo SKEWNESS

This parameter measures the third moment of the pitch values found in a speech
wave and is defined by the formula:

L £ fagy
skewness = {1 > 5 }
NG ©

where f,, f,, ..., fy are the consecutive fundamental frequencies measured by the
peak-picking algorithm and f,,, is the average frequency of the source wave. Sis
the standard deviation of the frequency. Skewness measures the asymmetry of the
frequency distribution relative to its mean; a normal (gaussian) frequency
distribution has zero skewness, a distribution with an elongated “tail” extending out
to positive frequencies has positive skewness, and a distribution with atail going out
to negative frequencies has negative skewness. For more information, see pp. 474-
475 of Numerical Recipesin C.
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F, STANDARD DEVIATION
The F, standard deviation of a speech wave is defined by the formula:

N

i=1

wheref,, f,, ..., fy are the consecutive fundamental frequencies obtained by the peak-
picking algorithm and f,, is the average frequency of the source wave.

HARMONIC-TO-NOISE RATIO (HNR)

The HNR parameter in the Sound Statistics dialog equals the arithmetic average of
the HNR values computed over time. (See Harmonic-to-Noise Ratio (HNR),
discussed earlier in this appendix, for details.)

SHIMMER
The shimmer (also known as amplitude perturbation quotient, “APQ”) of the source
wave is defined by the formula

N
i iél A Difference; |

APQ N
2 Aj
=1

See Shimmer, discussed earlier in this appendix, for the definition of A 4 ence:
VOICED, UNVOICED AND SILENT

These three parameters measure what portion of the source wave is voiced, unvoiced
and silent. All sounds are assumed to fall into one of these three categories. These
statistics are computed with the algorithm described in Digital Processing of Speech
Signals, pp. 132-134.
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Appendix C
TIps

This appendix contains several Tips on a variety of issues.
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